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Cumulative changes from Server Express
to Visual COBOL for Eclipse (UNIX)

Welcome to Visual COBOL for Eclipse. This document combines information on Visual COBOL for Eclipse
releases from the first release, Visual COBOL 2010 R1, to the most recent release. This information is
taken from the various releases' Release Notes and other sources, and brought together here for your
convenience.

You can use this document:

« If your Visual COBOL installation is up to date, to see the changes made in the latest release.
< If you already use Visual COBOL but your installation is not entirely up to date, to see the changes
made over several updates, together in one place.

» If you are migrating from Server Express, to see everything that has changed in the life of Visual
COBOL for Eclipse.

About this Guide

We recommend that you read all the sections of this publication, looking for information on the release that
is most relevant to your needs. The main sections are as follows:

What was New This section describes new functionality that was introduced in each
successive release.

Significant Changes This section describes, for each successive release, the changes in
behavior or usage that could affect the behavior of existing applications or
impact the way the tools are used.

Unsupported or Deprecated This section describes any functionality that was discontinued or

Functionality deprecated at a given release.

Known Errors and This section describes known errors affecting the latest release, and
Restrictions restrictions in its use.

Upgrading from Server This section gives guidance on upgrading from earlier Micro Focus

Express to Visual COBOL products.

Within each section, we recommend reading in the reverse chronological order in which it is presented
here - that is, reading about the most recent release first, and then going back through the development of
the products. That way, you can more easily see if anything was added in an earlier release and
subsequently removed.

Changes to Compiler Directives, Run-Time Tunables,
Library Routines and Environment Variables

This section provides an index of items added, deprecated and changes since the first version of Visual
COBOL. The changes are presented in a number of tables according to the type of feature involved. The
first set of tables lists changes in alphabetical order. A second section lists changes in order of release.

Changes in Alphabetical Order

The changes are presented in the following tables:
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« Compiler Directives

e Run-Time Tunables

o Library Routines

e Environment Variables

For each change, the table lists:

« The name of feature that changed,

* The type of change,

e The version of Visual COBOL in which the change was introduced,
e Alink to more information.

Table 1: Changes to Compiler Directives

Base release

6 | Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)

Name Change At Product See
Version
01SHUFFLE Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
64KPARA Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
64KSPECT Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
ACU-UNDERSCORE New 2.2 What was new in 2.2
ANIM Changed 5.0 Significant changes in 5.0
default
AUXOPT Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
CHANGE-MESSAGE Changed 2.2 What was new in 2.2
scope
CHECKDIV New 4.0 What was new in 4.0
parameter
CHECKREFMOD New 6.0 What was new in 6.0
parameter
CHIP Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
COMMAND-LINE-LINKAGE New 2.3 Update 2 What was new at 2.3 Update 2
COMP1 New 2.1 What was new in 2.1
COMP2 New 2.1 What was new in 2.1
CONVERTRET Deprecated 3.0 Unsupported or Deprecated at 3.0
DIALECT"RM" Changed 2.2 What was new in 2.2
effect
DISPLAY New 2.1 What was new in 2.1
DISPLAY-AT New 6.0 What was new in 6.0
DISPSIGN New 4.0 What was new in 4.0
DATALIT Deprecated Visual COBOL  Unsupported or Deprecated at

2010




Name Change At Product See
Version
DATAMAP New 2.1 What was new in 2.1
parameter
DBSPACE New 2.3 What was new in 2.3
parameter
DPC-IN-DATA New 6.0 What was new in 6.0
EANIM Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
EBC-COL-SEQ New 2.3 Update 2 What was new at 2.3 Update 2
EDITOR Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
ENSUITE Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
EOF-1A New 2.3 What was new in 2.3
EXECSQL-FLAG New 7.0 What's new in 7.0
EXITPROGRAM New 2.2 What was new in 2.2
EXPANDDATA Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
FIXING Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
FLAG-CHIP Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
GNTLITLINKSTD New 4.0 What was new in 4.0
HIDE-MESSAGE Changed 2.2 What was new in 2.2
scope
HOSTSIGNS Unsupported 3.0 Unsupported or Deprecated at 3.0
IDXFORMAT8 New option Visual COBOL
Base release
IDXFORMAT12 New option 2.3 Update 1
ILCONDITIONPARAM New 6.0 What was new in 6.0
ILEXPONENTIATION New 2.2 What was new in 2.2
IDYSRCPATH Deprecated 3.0 Unsupported or Deprecated at 3.0
ILCLR"2" Deprecated 7.0 What's new in 7.0
ILMAIN New 2.3 Update 1 What was new in 2.3 Update 1
ILNORMALIZENAMES New 5.0 What was new in 5.0
ILOBJECTIFY Deprecated 3.0 Unsupported or Deprecated at 3.0
ILPARAMS New 2.2 Update 1 What was new in 2.2 Update 1
ILSHOWPERFORMOVERLAP New 2.2 What was new in 2.2
ILSMARTRESTRICT New 2.1 What was new in 2.1
ILSMARTTRIM New 4.0 What was new in 4.0

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX) | 7
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Name Change At Product See
Version
INIT-BY-TYPE New 2.2 Update 1 What was new in 2.2 Update 1
JVMDECIMAL New 2.3 What was new in 2.3
JVMTARGET New 5.0 What was new in 5.0
MAINFRAME-FLOATING-POINT New 4.0 What was new in 4.0
MASM Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
MODEL Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
NATIONAL New 2.3 Update 2 What was new at 2.3 Update 2
NLS-CURRENCY-LENGTH New 2.3 What was new in 2.3
NULL-ESCAPE New 2.3 What was new in 2.3
NUMPROC New 4.0 What was new in 4.0
parameter
OOCTRL New 2.3 Update 1 What was new in 2.3 Update 1
OOCTRL New 4.0 What was new in 4.0
parameter
OPTIMIZECURSORS New 3.0 Significant changes in 3.0
OPTION Deprecated 3.0 Unsupported or Deprecated at 3.0
OPTSIZE Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
OPTSPEED Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
PANVALET-INCLUDES-IN-COMMENTS New 7.0 What's new in 7.0
PARAS Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
PRESERVECASE Changed 2.2 What was new in 2.2
scope
PROTMODE Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
PROTOTYPE New 6.0 What was new in 6.0
parameter
REGPARM Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
RESTRICT-GOTO New 2.1 What was new in 2.1
RM-FILE-ERRORS New 7.0 What's new in 7.0
SEGCROSS Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
SEGSIZE Deprecated Visual COBOL  Unsupported or Deprecated at

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)
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putenv_interface

strict_file_locking

reduce_java_signals

subsystem_cancel_mode

New parameter
New

New

New

New

New parameter

2.3
2.2 Update 2

2.3
2.0

2.3

Name Change At Product See
Version
SIGNCOMPARE Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
SMALLDD Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
SPZERO Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
TABLESEGCROSS Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
TRICKLE Deprecated 3.0 Unsupported or Deprecated at 3.0
TRICKLECHECK Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
WB2 Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
WB3 Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
wB Deprecated Visual COBOL  Unsupported or Deprecated at
Base release 2010
Table 2: Changes to Run-time Tunables
Name Change At Product See
Version
command_line_linkage Deprecated 2.3 Update 2 Unsupported or Deprecated at 2.3
Update 2
default_cancel_mode New default 2.3 What was new in 2.3 - Tunables
value

What was new in 2.3 - Tunables

Significant changes in 2.2 Update
2

What was new in 2.3 - Tunables

What was new in 2.0 - Run-time
Tunables

What was new in 2.3 - Tunables

Table 3: Changes to Library Routines
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Name Change At Product See

Version
CBL_CREATE_CORE New 5.0 What was new in 5.0
CBL_CTF_COMP_PROPERTY_GET New 2.0 What was new in 2.0
CBL_CTF_TRACE New 2.0 What was new in 2.0




Name Change At Product See
Version

CBL_CTF_TRACER_LEVEL_GET New 2.0 What was new in 2.0
CBL_CTF_TRACER_GET New 2.0 What was new in 2.0
CBL_CTF_LEVEL New 2.0 What was new in 2.0
CBL_CODESET_SET_MAPPING New 2.3 Update 1 What was new in 2.3 Update 1
CBL_GET_DEBUG_START New 4.0 What was new in 4,0
CBL_GET_DEBUG_STOP New 4.0 What was new in 4,0
CBL_GET_ERROR_INFO New 7.0 What's new in 7.0
CBL_GET_EXIT_INFO Enhanced 6.0 What was new in 6.0
CBL_GET_OS_INFO New 4.0 What was new in 4,0
CBL_LOCATE_FILE New parameter 2.3 What was new in 2.3
CBL_MANAGED_SESSION_GET_USERD New 2.3 What was new in 2.3

ATA

CBL_MANAGED_SESSION_SET_USERDA New 2.3 What was new in 2.3

TA

CBL_RUNTIME_ERROR New 2.3 Update 1 What was new in 2.3 Update 1
CBL_SEMAPHORE_ACQUIRE New parameter 2.0 What was new in 2.0
CBL_CREATE_CORE New 5.0 What was new in 5.0
MFU_GET_FILE New 6.0 What was new in 6.0
MFUGETF New 6.0 What was new in 6.0
Table 4: Changes to Environment Variables

Name Change At Product See

Version

COB_LIVE_RECORD_SIZE New 5.0 What was new in 5.0
ES_CAT_RETRY_COUNT New 4.0 Configuring Multiple Catalogs
ES_CAT_RETRY_WAIT New 4.0 Configuring Multiple Catalogs
ES_RDO_MAX_RESOURCES New 7.0 What's new in 7.0

FSWRKDIR New 3.0 What was new in 3.0
FSCHKLFH New 3.0 What was new in 3.0

HCOBND Deprecated 3.0 Unsupported or Deprecated at 3.0
MFALLOC_PCFILE Default value changes 2.2 Update 2 Significant changes in 2.2 Update 2
strictvsam New 2.2 Update 1 What was new in 2.2 Update 1

Changes in Order of Release

The changes are presented in the following tables:

e Compiler Directives
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¢ Run-Time Tunables
e Library Routines
* Environment Variables

For each change, the table lists:

« The version of Visual COBOL in which the change was introduced, starting with the earliest,

« The name of feature that changed,

* The type of change,
* Alink to more information.

Table 5: Changes to Compiler Directives

Base release
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At Product Name Change See

Version

Visual COBOL 01SHUFFLE Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL 64KPARA Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL 64KSPECT Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL  AUXOPT Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL CHIP Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL DATALIT Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL EANIM Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL EDITOR Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL ENSUITE Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL EXPANDDATA Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL FIXING Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL FLAG-CHIP Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL IDXFORMATS8 New option

Base release

Visual COBOL MASM Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL MODEL Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL OPTSIZE Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL OPTSPEED Deprecated Unsupported or Deprecated at
Base release 2010

Visual COBOL PARAS Deprecated Unsupported or Deprecated at

2010
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At Product Name Change See
Version
Visual COBOL PROTMODE Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL REGPARM Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL SEGCROSS Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL SEGSIZE Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL SIGNCOMPARE Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL SMALLDD Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL SPZERO Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL  TABLESEGCROSS Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL  TRICKLECHECK Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL  WB2 Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL  WB3 Deprecated Unsupported or Deprecated at
Base release 2010
Visual COBOL WB Deprecated Unsupported or Deprecated at
Base release 2010
21 COMP1 New What was new in 2.1
21 COMP2 New What was new in 2.1
21 DISPLAY New What was new in 2.1
2.1 DATAMAP New What was new in 2.1
parameter
21 ILSMARTRESTRICT New What was new in 2.1
21 RESTRICT-GOTO New What was new in 2.1
2.2 ACU-UNDERSCORE New What was new in 2.2
2.2 CHANGE-MESSAGE Changed What was new in 2.2
scope
2.2 DIALECT"RM" Changed What was new in 2.2
effect
2.2 EXITPROGRAM New What was new in 2.2
2.2 HIDE-MESSAGE Changed What was new in 2.2
scope
2.2 ILEXPONENTIATION New What was new in 2.2
2.2 ILSHOWPERFORMOVERLAP New What was new in 2.2
2.2 PRESERVECASE Changed What was new in 2.2
scope
2.2 Update 1 ILPARAMS New What was new in 2.2 Update 1




At Product Name Change See
Version
2.2 Update 1 INIT-BY-TYPE New What was new in 2.2 Update 1
2.3 DBSPACE New What was new in 2.3

parameter
23 EOF-1A New What was new in 2.3
23 JVMDECIMAL New What was new in 2.3
23 NLS-CURRENCY-LENGTH New What was new in 2.3
23 NULL-ESCAPE New What was new in 2.3
2.3 Update 1 IDXFORMAT12 New option
2.3 Update 1 ILMAIN New What was new in 2.3 Update 1
2.3 Update 1 OOCTRL New What was new in 2.3 Update 1
2.3 Update 2 EBC-COL-SEQ New What was new at 2.3 Update 2
2.3 Update 2 COMMAND-LINE-LINKAGE New What was new at 2.3 Update 2
2.3 Update 2 NATIONAL New What was new at 2.3 Update 2
3.0 CONVERTRET Deprecated Unsupported or Deprecated at 3.0
3.0 HOSTSIGNS Unsupported  Unsupported or Deprecated at 3.0
3.0 IDYSRCPATH Deprecated Unsupported or Deprecated at 3.0
3.0 ILOBJECTIFY Deprecated Unsupported or Deprecated at 3.0
3.0 OPTIMIZECURSORS New Significant changes in 3.0
3.0 OPTION Deprecated Unsupported or Deprecated at 3.0
3.0 TRICKLE Deprecated Unsupported or Deprecated at 3.0
4.0 CHECKDIV New What was new in 4.0

parameter
4.0 DISPSIGN New What was new in 4.0
4.0 GNTLITLINKSTD New What was new in 4.0
4.0 ILSMARTTRIM New What was new in 4.0
4.0 MAINFRAME-FLOATING-POINT New What was new in 4.0
4.0 NUMPROC New What was new in 4.0

parameter
4.0 OOCTRL New What was new in 4.0

parameter
5.0 ILNORMALIZENAMES New What was new in 5.0
5.0 JVMTARGET New What was new in 5.0
5.0 ANIM Changed Significant changes in 5.0

default
6.0 DISPLAY-AT New What was new in 6.0
6.0 DPC-IN-DATA New What was new in 6.0
6.0 ILCONDITIONPARAM New What was new in 6.0
6.0 CHECKREFMOD New What was new in 6.0

parameter
6.0 PROTOTYPE New What was new in 6.0

parameter

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX) | 13
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At Product Name Change See
Version
7.0 EXECSQL-FLAG New What's new in 7.0
7.0 ILCLR"2" Deprecated What's new in 7.0
7.0 PANVALET-INCLUDES-IN-COMMENTS New What's new in 7.0
7.0 RM-FILE-ERRORS New What's new in 7.0
Table 6: Changes to Run-time Tunables
At Product Name Change See
Version
2.0 subsystem_cancel_mode New What was new in 2.0 - Run-time
Tunables
2.2 Update 2 reduce_java_signals New Significant changes in 2.2 Update
2
2.3 default_cancel_mode New default What was new in 2.3 - Tunables
value
New parameter
2.3 putenv_interface New What was new in 2.3 - Tunables
2.3 strict_file_locking New What was new in 2.3 - Tunables
23 subsystem_cancel_mode New parameter What was new in 2.3 - Tunables
2.3 Update 2 command_line_linkage Deprecated Unsupported or Deprecated at 2.3
Update 2
Table 7: Changes to Library Routines
At Product Name Change See
Version
2.0 CBL_CTF_COMP_PROPERTY_GET New What was new in 2.0
2.0 CBL_CTF_TRACE New What was new in 2.0
2.0 CBL_CTF_TRACER_LEVEL_GET New What was new in 2.0
2.0 CBL_CTF_TRACER_GET New What was new in 2.0
2.0 CBL_CTF_LEVEL New What was new in 2.0
2.0 CBL_SEMAPHORE_ACQUIRE New parameter What was new in 2.0
23 CBL_LOCATE_FILE New parameter What was new in 2.3
23 CBL_MANAGED_SESSION_GET_USERDA New What was new in 2.3
TA
23 CBL_MANAGED_SESSION_SET_USERDA New What was new in 2.3
TA
2.3 Update 1 CBL_CODESET_SET_MAPPING New What was new in 2.3 Update 1
2.3 Update 1 CBL_RUNTIME_ERROR New What was new in 2.3 Update 1
4.0 CBL_GET_DEBUG_START New What was new in 4,0
4.0 CBL_GET_DEBUG_STOP New What was new in 4,0
4.0 CBL_GET_OS_INFO New What was new in 4,0
5.0 CBL_CREATE_CORE New What was new in 5.0




At Product Name Change See

Version

6.0 CBL_GET_EXIT_INFO Enhanced What was new in 6.0
6.0 MFU_GET_FILE New What was new in 6.0
6.0 MFUGETF New What was new in 6.0
7.0 CBL_GET_ERROR_INFO New What's new in 7.0

Table 8: Changes to Environment Variables

At Product Name Change See

Version

2.2 Update 1 strictvsam New What was new in 2.2 Update 1
2.2 Update 2 MFALLOC_PCFILE Default value changes  Significant changes in 2.2 Update 2
3.0 FSWRKDIR New What was new in 3.0

3.0 FSCHKLFH New What was new in 3.0

3.0 HCOBND Deprecated Unsupported or Deprecated at 3.0
4.0 ES_CAT_RETRY_COUNT New Configuring Multiple Catalogs

4.0 ES_CAT_RETRY_WAIT New Configuring Multiple Catalogs

5.0 COB_LIVE_RECORD_SIZE New What was new in 5.0

7.0 ES_RDO_MAX_RESOURCES New What's new in 7.0

What was New

This section describes the new features that were introduced in each successive release of Visual COBOL.

What was New in Visual COBOL 7.0

New Features in Visual COBOL 7.0

Enhancements are available in the following areas:

« Micro Focus COBOL Extension for Visual Studio Code on page 16
e Application Workflow Manager

e COBOL Language Enhancements

» Code Analysis

e Code Set Support

e Compiler Directives

« Database Access - OpenESQL

» Data File Tools

» Eclipse Integration

« Enterprise Server

* Enterprise Server Common Web Administration
» Enterprise Server Security

» Library Routines

« Licensing Technologies

* Micro Focus Unit Testing Framework

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX) | 15
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Micro Focus COBOL Extension for Visual Studio Code
Back to Top

The new Micro Focus COBOL extension for Visual Studio Code is available on the Microsoft Visual Studio
Marketplace. This provides edit, compile and debug support for Visual COBOL and Enterprise Developer
users in Visual Studio Code.

i Note: The new Micro Focus COBOL extension is not included with the Visual COBOL installer.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:

« Modelling support for tool process logic under an action:

* You can now model loops and conditional execution of tools under an action, making the modeling of
complex tool logic under an action easier and more transparent. See Action Descriptor for more
information.

¢ Icon support:

« lcons can be specified to consist of several layers which, for example, enables you to model icons
with decorators. The decorators can be displayed depending on conditions. See Relationship
Element Has Icon, Relationship Action Has Icon, and Relationship Filter Has Icon for more
information.

« Additional icons have been added to AWM. See Icons for the AWM Function Package for more
information.

* You can now specify and use your own icons.
* You can now specify icons for filter definitions. See Relationship Filter Has Icon for more information.
* Filter definitions view:

* You can now export and import filter definitions to and from another workspace.

< The filter definition view's structure has been changed to a tree design enabling you to group
corresponding filters.

< "Micro Focus z/Server" connection type:

* Now supports drag & drop of a data set from the connection to an enterprise server instance's
catalog entry.
e You can now compress a z/OS PDS data set.
* New Micro Focus DevHub connection type function package:

< Provides a tool to send commands to a Micro Focus DevHub connection and receive the output
returned by the command so that it can be processed by other tools. See Micro Focus DevHub
Connection Type Function Package for more information.

COBOL Language
Back to Top
The following enhancements have been made to the Micro Focus COBOL language:

* JVM COBOL data type to hold strings of utf-8 characters - support is how available in JVM COBOL
for the PIC U data type. This was already available for native COBOL, to support its introduction by IBM
in Enterprise COBOL version 6.3.

« The DYNAMIC LENGTH clause, which enables a data item to vary in length at run time, is supported.
Again, this is in response to its introduction by IBM in Enterprise COBOL version 6.3.

« The following date-format-checking intrinsic functions have been added: TEST-DATE-YYYYMMDD and
TEST-DAY-YYYYDDD.
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Code Analysis
Back to Top
This release includes the following enhancements:

* Get Direct References command - you can use this command to see if changing a file will affect the
other files in your project as well as the files in the whole application. In Eclipse, you can access this
from the context menu or from the Analysis Server Explorer.

* Import points of interest - the Code Analysis view now includes a button, Import points of interest.

Code Set Support

Back to Top

The following enhancements have been made to the integrated code set translation support:
» Arabic support for Enterprise Server applications is available.

If you are building Arabic support into Enterprise Server applications, your terminal emulator must
support the Arabic EBCDIC 420 code page.

Support is added by building your applications and configuring your enterprise server regions with the
MFCODESET variable set to the supported country code (0420). Your product's in-built code set
translation utility performs translations between the ASCII 1256 Arabic code page on your enterprise
server region, and a terminal emulator that supports the Arabic EBCDIC 420 code page (for example,
IBM's Personal Communications emulator).

There are some considerations when working with a bi-directional language such as Arabic; these are
discussed in Arabic support considerations.

Compiler Directives
Back to Top
The following Compiler directives are new in this release:

* PANVALET-INCLUDES-IN-COMMENTS - This directive controls whether ++INCLUDE statements in
comments are actioned or not.

« EXECSQL-FLAG - This directive defines whether syntax reporting should emulate that of the DB2
preprocessor, the DB2 coprocessor, or to allow all syntax variations of both.

* RM-FILE-ERRORS - This directive generates run-time system errors for certain file conditions, even
when a FILE STATUS clause is present; this is to emulate RM/COBOL behavior.

The following Compiler directive option has been deprecated:

« ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Visual COBOL.

Database Access - OpenESQL
Back to Top
This release provides the following enhancement:

* New OpenESQL TRACELEVEL=5 option - native OpenESQL applications can now trace ODBC calls to
the database vendor's ODBC driver, recording the start and stop times of each call’'s execution.
OpenESQL tracing can now provide more detail on where an SQL application is spending execution
time, in the OpenESQL layer or the underlying ODBC driver layer.

Data File Tools

Back to Top

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX) | 17



18

This release includes the following enhancements in the Data File Editor:

New Data Explorer for working with data sets - a new Data Explorer enables you to connect to either
an ESCWA service or directly to an enterprise server region to access a catalog when working with
data sets in the editor.

Multiple record selection- you can select multiple records and, where appropriate, can perform certain
actions on more than one record at once.

Cut, copy, and paste functionality - traditional cut, copy, and paste functionality (including the
standard Ctrl+X, Ctrl+C, and Ctrl+V shortcuts) is now available throughout the editor.

New filter creation - a new process for creating filters has been introduced. A filter consists of one or
more sets of conditions, and the resulting filter can include or exclude those records selected. The
previous filter process is still available, but has been marked as deprecated.

Remote filtering - functionality has gone into Fileshare Server which allows filtering to occur server
side when opening data sets on remote enterprise server regions. The filter process results in only
those filtered records being downloaded to the data file editor client.

Find/replace functionality - you can search records in a data file to identify specific strings, and then if
required, replace them.

Eclipse Integration

Back to Top

This release includes enhancements in the following areas:

Supported Eclipse versions - this release supports Eclipse 4.16 (2020-06), which is shipped and
installed with Visual COBOL.

Versions of Eclipse prior to this one are not supported.

Micro Focus Search - the search has been enhanced to filter results on the build action: in the Limit
To section, select Files configured for compilation to only include files in the search results that have
a build action set to Compile. The search results also include a new column, Build Action, that shows
the current action for each file.

Formatting profiles - the formatting preferences for your COBOL code are now stored in profiles. You
can have many profiles per workspace, allowing you to easily switch between different sets of formatting
for different projects. The profiles can also be shared between local workspaces and to other users,
allowing developers to format code consistently throughout their team.

The following new preferences have been added:

* Force native line endings when pasting with Ctrl + Shift + V, available from Micro Focus >
COBOL > Editor: this option produces line endings native to the local operating system.

* Show Compiler directive summary in editor, available from Micro Focus > COBOL > Editor >
Compiler Directives summary: this option shows a summary of the Compiler directives in effect, in
the editor.

Enterprise Server

Back to Top

This release includes the following enhancements:

Multiple Network Interface support - there is improved support for multiple network interfaces in some
components, including better awareness of network interfaces and control over networking. This is a
partial implementation and will be enhanced in future releases.

Extended IPv6 support - support is available in Micro Focus Directory Server (MFDS) and in the Micro
Focus Communications Server (MFCS) listener for multiple IPv6 addresses.

In release 6.0, you could only configure MFDS and MFCS listeners to listen on a single IPv6 address. In
release 7.0, by default, MFDS and MFCS now listen on all configured IPv4 and IPv6 addresses, and
can also be configured to listen on a combination of specific addresses.
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e HTTP improvements:

» Additional security measures for HTTP, such as security-related headers.
e Chunking support for large HTTP messages makes it possible to retrieve very large files from
Enterprise Server regions.

« Application Diagnostic Reporting for Enterprise Server - Application diagnostic reporting collects and
packages a number of reports, trace, and log files into a single report file. See Application Diagnostic
Reporting for Enterprise Server for more information.

« Enterprise Server now supports automatic reconnection to the standby Queue manager in an Multi-
Instance Queue Manager. See Reconnecting to an MQ Server in a Multi-instance Queue Manager and
Enterprise Server XA Reconnect for more information.

« The casmgr process has been optimized to improve the use of initiators when dispatching jobs across a
PAC. In addition, improvements have been made to the way it manages the queue of jobs waiting to be
dispatched.

« Information has been added describing the best practice and the recommended approach you should
adopt when performing a Patch Update to your PAC environment. See Performing a Patch Update to a
PAC Environment for more information.

Enterprise Server Common Web Administration (ESCWA)
Back to Top
This release offers the following improvements:

* MFDS User Interface functionality replacement - ESCWA now replaces the MFDS inside the IDE as the
engine that provides access to and management of regions. ESCWA provides all the functionality that
was previously available from MFDS. This release includes the following enhancements:

« Delete all regions.
» Session list.
* Renew listening addresses.
* ESMAC User Interface functionality replacement - the following ESMAC features have been
implemented in ESCWA:

* Resource Filtering. See CICS Resources for more information.

» Millisecond support. See Threshold, Monitor, and Active PCT for more information.

< Control the scope for all changes to timeouts, trace flags, and memory strategy when applied to
regions in a PAC. See ES Control for more information.

« Enable Application Diagnostic reporting. See ES Control and Application Diagnostic Reporting for
Enterprise Server for more information.

« Submission of local jobs from the JES Control page when CASRDO44 NEWSUB=OFF has been
specified. See JES Control for more information.

* View and reply to pending ACCEPT FROM CONSOLE statements. See Pending Replies for more
information.

« The messages after a JCL job has been submitted are now correctly JSON formatted. This page
now works in ESCWA when MFJUXIT is enabled.

* Import, export, and copy regions - you can now use the Ul to export and import regions in various
formats, including use JSON. You can:

« Copy regions between Directory Servers
e Import and export regions in JISON, XML or in the . dat legacy format. The legacy format can be
converted to a modern format.
« Mainframe Access (MFA) administration - ESCWA provides a modern Web Ul and does not require you
to use a separate terminal application. Features include:

e Log in or off from MFA.
e Change your MFA password.
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* View MFA server tasks.

* Retrieve the XDBOUT log (Web Ul).

* Retrieve the JES spool files by DD Name (API).
e Set the MFA and JES tracing level.

* View the active MFA users.

« Invalidate active user sessions.

« View mainframe/MFA statistics.

See Mainframe in the Enterprise Server Common Web Administration chapter for more information.

The MFA API library has been exposed to enable you to test and use the requests that are provided.
See MFA Interactive API Library for more information.

e Scale-Out and PAC administration - you can now:

* Monitor Redis Sentinel and Cluster instances when used for Scale-Out Repositories.
« Specify that all changes to timeouts, trace flags, and memory strategy can be applied to one of three
options:

Only the local region.
All members of a PAC except the regions where local changes have been made.
All members of a PAC.

You can configure this in ESCWA with the Apply Scope field on the ES CONTROL page.
Alternatively, you can use the casutl utility with the /w option. See casutl for more information.

e Multi-Network Interface Card support - ESCWA now enables you to configure Communications Servers
and Listeners to listen on multiple IPv4 and IPv6 addresses. Previously, they were limited to listen on
either all IPv4 addresses, or a single IPv4 or IPv6 address. Now a combination of any of the following
can be used:

« One or more specific IPv4 addresses.
* One or more specific IPv6 addresses.
e All IPv4 addresses.
e All IPv6 addresses.

* A new filter field resFilter has been added to the following ESCWA and ESMAC resource listing
modules:

Every resource in By Type

Every resource in By Start L

Resource lists under Groups

Every active resource type except Locks

This parameter will filter the list of resources displayed by ESCWA and ESMAC. In addition, a new
environment variable ES_ RDO_MAX_RESOURCES has been added that enables you to specify a limit
to the number of records displayed. For JSON requests, the list being truncated is indicated by the
addition of the JSON property "truncated": true.

Enterprise Server Security
Back to Top
This release includes the following enhancements:

« MLDAP ESM caching - the MLDAP ESM Module now implements LDAP search-result caching. This is
controlled by the existing Security Manager cache settings, so that many installations will have this
activated automatically. See the product Help for details.

« Vault Hashicorp support - support is available for using a Hashicorp KV2 vault server as a local or
remote vault.

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)



Library Routines
Back to Top
The following library routines are new:

« CBL_GET_ERROR_INFO - enables error processing routines to establish the location of the error that
occurred to cause the error processing routine to execute. This is available on a restricted range of
platforms.

e« CBL_CREATE_STACKDUMP - generates a stackdump file.

Licensing

Back to Top

AutoPass licensing technology

In this release, Micro Focus brings in the power of the in-house Micro Focus AutoPass licensing technology
alongside Sentinel RMS. AutoPass has the following additional benefits compared to Sentinel RMS:

« Usage logging which enables you to monitor the product usage. You need to install the AutoPass
License Server in order to do this.
« Ongoing support for all platforms that this product is available for.

Features include:

» Installing this release installs both the AutoPass Daemon and the Sentinel RMS License Manager. Both
of them are available in the Micro Focus License Administration tool.

« You can have both AutoPass and Sentinel RMS licenses installed on the same machine. Optionally, you
can switch off the licensing technology you do not use.

< If you are an existing user of a Visual COBOL or an Enterprise Developer product, you only need an
AutoPass license if you want to utilize usage logging or if you want to use your product on a platform on
which Sentinel RMS is not supported.

« If you are a new user of the Micro Focus COBOL products, you will normally be issued an AutoPass
license.

» Micro Focus will continue to provide Sentinel RMS in future releases of this product.

Installing licenses at the command line
On Windows, Micro Focus License Administration is now also available as a command-line utility.

For more about AutoPass and usage logging, and about Micro Focus License Administration, see
Managing Licenses.

The Micro Focus Unit Testing Framework
Back to Top
The following enhancements have been made to the Micro Focus Unit Testing Framework:

« The MFUPP preprocessor has been introduced to provide a seam between your program and a unit
test. This seam lets you access the internals of a program under test, allowing you to create granular
unit tests from paragraphs or sections. The MFUPP preprocessor also provides the ability to mock
programs or stub programs out to create a unit test.

« In Eclipse, remote unit test projects for native COBOL can now be stored and run from Visual COBOL
Development Hub.

What was New in Visual COBOL 6.0
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Features Added in Visual COBOL 6.0

Enhancements are available in the following areas:

« Application Workflow Manager

* Building Applications

e COBOL Application Console Size
e COBOL Language Enhancements
« Code Analysis

» Code Analyzer Refactoring

e Compiler Directives

» Containers

« Database Access - DB2 ECM

» Data File Tools

» Debugging

« Deploying Applications

« Eclipse Integration

» Enterprise Server

» Enterprise Server Security

e Enterprise Server Common Web Administration
« File Handling

e Interface Mapping Toolkit

o Library Routines

e Micro Focus Unit Testing Framework
e Multi-Threaded Applications

* Problem Determination

* Product Documentation

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:

* REST modelling - the REST function package now supports the following:

HTML formatted text fields.

Copying and pasting of JSON format template into a JSON structured file descriptor in the AWM
model editor.

Specify a general status code handling, which is applicable for all tools from the REST function
package.

Handling loops when specifying a status code handler.

Uploading and downloading text files to and from a REST based application.

Automatic retrieving of valid values for a dialog input field without the need to click Retrieve.
Auto-completion in dialog input fields.

Specify clearing dependencies between dialog input fields.

« Local Java development - the following features supporting local projects for Java development have
been added:

A Java function package with the corresponding property, element types, and tools
A sample AWM model for local Java development

< The function package developer guide now provides more details.
AWM extension templates are now available
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AWM model editor improvements:

*  The AWM model properties now only display the relevant attributes in the Properties view.
« Auto-completion of fields which enable you to specify property references.
¢ The Used by dialog now displays property reference usage.

Building Applications
Back to Top
This release includes the following new functionality:

e Maven build support - you can use the Apache Maven support in Eclipse to build COBOL JVM projects
and COBOL JVM Unit Test projects.

COBOL Application Console Size
Back to Top

The maximum console size of a COBOL application has increased. It can now be 255 lines by 255
columns, configurable using the scr een_I| i nes and scr een_col s run-time tunables.

COBOL Language Enhancements
Back to Top
The following enhancements are available:

* Enterprise COBOL 6.2 Update - new syntax, library routines, and the respective analysis tooling are
available for compatibility with IBM's Enterprise COBOL 6.2 Update:

« New intrinsic functions are supported: BIT-OF, BIT-TO-CHAR, BYTE-LENGTH, HEX-OF, HEX-TO-
CHAR, NUMVAL-F, TEST-NUMVAL, TEST-NUMVAL-C, TEST-NUMVAL-F, and TRIM

« A number of intrinsic functions now support national data (especially surrogate pairs): REVERSE,
ULENGTH, UPOS, USUBSTR, USUPPLEMENTARY, UVALID, and UWIDTH.

* A LOC phrase has been added to the ALLOCATE statement to define whether memory is allocated
above or below the 16MB line.

* CONSTANT qualifier - it is now possible to define data items as constants. This improves the code
readability and usability, and helps detect programming errors. The ability to create constant items is
already in .NET COBOL and JVM COBOL, and many other languages.

* Local variable declarations in native COBOL - it is now possible to declare data items inline in the
code and not only in a separate DATA DIVISION. This provides better locality of data, making the
source code easier to reason about.

* Native data type to hold strings of utf-8 characters - in native COBOL, support is now available for
the PIC U data type as introduced by IBM in Enterprise COBOL version 6.3. Direct support is available
for utf-8 data.

« Performance improvements - this release provides various performance improvements, most
significantly on 32-bit Intel x86 platforms. When using the highest optimization level, opt(4), the
performance of native code generated by the COBOL Compiler has improved. A number of cases are
affected, most particularly those where it is beneficial to locate PERFORM ranges inline.

Code Analysis
Back to Top

Support is provided in Visual COBOL for accessing the Application Analysis Server which is part of the
Micro Focus Enterprise Analyzer and Micro Focus COBOL Analyzer products.

If you have one of these products installed, you can connect to the Application Analysis Server from Server
Explorer and access the Enterprise Analyzer web client. Enterprise Analyzer web client provides quick
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searches for repository objects, detailed code searches, diagrams, reports, and data item impact analysis
and other features such as viewing and editing of business rules (separate license required).

Code Analyzer Refactoring
Back to Top

Support is now available for extracting program logic from COBOL code and moving it to a new program.
The following commands are available from the editor context menu:

e Create program from Section
» Create program from Computation
« Create program from Condition

In Eclipse, you can now refactor your code using the Extract to Section command available from the
Refactor menu.

Compiler Directives
Back to Top
The following Compiler directives are new in this release:

» DISPLAY-AT - specifies a default foreground and background color for DISPLAY AT and ACCEPT AT
statements that do not specify any color attributes.

e DPC-IN-DATA - controls whether the DECIMAL-POINT IS COMMA clause (if specified) is applied to the
output from the XML GENERATE and JSON GENERATE statements.

« |LCONDITIONPARAM - switched on by default. Enables the support for conditional expressions as
method parameters.

/. Important: Applications that use the old COBOL syntax for specifying named parameters as

=" custom-attributes will not compile with the ILCONDITIONPARAM specified. This can result in any
older applications failing to compile in the current version of the product. See
ILCONDITIONPARAM in your product Help for details about how to work around this issue.

The following Compiler directives have new options:

e CHECKREFMOD - now takes an additional parameter (NOZEROLENGTH), which acts as
CHECKREFMOD, but does not permit reference modifier lengths of zero.

« PROTOTYPE - now supports options that specify whether prototypes are required, and the severity of
error messages issued for prototype mismatches.

Containers
Back to Top

Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.

Database Access - DB2 ECM
Back to Top
Support for the following has been added to this release:

e Multi-row fetch (MRF) and insert (MRI) statements with or without the FOR ROWS clause
» Array update and delete statements

f Notes:
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* These new features are supported for DB2 LUW version 11.1 Mod 4 Fix Pack or newer. Currently,
IBM does not support either of these features with DB2 LUW 11.5.

» For coding examples, see the IBM DB2 LUW documentation: Embedded SQL/COBOL Support for
MRI and MRF.

Database Access - XA Switch Modules
Back to Top

i Restriction: This feature applies only when the Enterprise Server feature is enabled.

Support for the following has been added to this release:

« XA switch modules have been enhanced to enable storage of sensitive information in the Micro Focus
Vault Facility. This new functionality includes a customizable program, ESXAEXTCFG.CBL, you can use
to obfuscate xa-open strings by storing them as secrets.

Data File Tools
Back to Top
The following enhancements have been made to the Data File Editor:

» Double-byte character sets are now supported within the editor.
« Insert mode is now available when editing a formatted record, except for numeric fields.

« When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are
automatically added when editing a formatted record and you are editing in Insert mode.

* You can now load and unload structure files for an open data file.
« Arruler at the top of the editing pane can be toggled on/off.

Debugging
Back to Top
This following enhancements are available:

« Breakpoints - in JVM COBOL, you can now access a breakpoint's properties from the breakpoint's
context menu in the editor.

» Expressions - you can now specify complex expressions in the Expressions view. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Views in the Debug Perspective in the product Help for details.

Deploying Applications
Back to Top

This release supports easier deployment of native COBOL applications from an Eclipse project. A new
page in the project's properties, Micro Focus > Build Configuration > Deploy, enables you to specify a
deploy folder and which files will be deployed. Building the project deploys certain executables and
supporting files to this folder. In addition, you can archive and deploy the files on application servers, cloud
storage such as AWS buckets and access the application files with AWS services, and so on.

Eclipse Integration
Back to Top
The following enhancements are available:

e COBOL compile settings summary - this pane, which is displayed when viewing the COBOL project
settings at the project, folder, and file level, now indicates the settings that are inherited and the ones
that are set at that level. Settings inherited from the level(s) above are shown in <>.
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Deploy folder - a new build configuration feature in the project's properties enables you to copy build
artifacts and supporting files essential for deployment, to a particular folder.

Context menu improvements - the editor context menu has been reorganized, where certain options
have been grouped together under a logical heading, and other redundant options removed.

Copybook tooltips - hovering COPY statements in the editor now displays the path to the referenced
copybook.

Collapsible statements - it is now possible to collapse IF, EVALUATE, and PERFORM statements in the
editor.

Dark theme with COBOL - you can enable the dark theme from Window > Preferences > General >
Appearance > Theme.

Enterprise Server

Back to Top

The following enhancements are available:

IPv6 support (EAP) - This feature is in Early Adopter Product (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.

Administrative Commands - the add command in cascert r eg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).

Enterprise Server Security

Back to Top

This release provides the following enhancements:

Micro Focus Secrets file storage permissions

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.

Certificate wildcard support

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, serverl.mycorp.com, and so on. These wildcard-
bearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.

Improved ACL wildcard support

In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.

PAM ESM module

On Linux platforms, Enterprise Server now includes an External Security Manager module which
integrates with the Pluggable Authentication Modules (PAM) operating system feature. The PAM ESM
module can be used to authenticate Enterprise Server users with the same mechanism used for Linux
users, or with any other mechanism available through PAM.

PKIX compliance for TLS certificate validation

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
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RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.

e Security improvements for XML parsing

In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration (ESCWA)
Back to Top
This release offers the following new features and improvements:

* MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/l, MQ,
and XA options, and security, is now available.

« ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.

* Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, and security menu
items.

* Usability improvements

» Starting and stopping regions from the navigation tree.
< The native menu items are not displayed if the region features are not configured correctly.
« Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.

e Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORSs)
association with its PAC and member regions.

* Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:

« Redis cluster support

< A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.
You can also use the file to configure Lua scripts tracing on servers.

« Authentication support for the standalone Redis server.

* Kubernetes support - when ESCWA is run in a Kubernetes cluster, it is now possible to configure it to
automatically discover the pods hosting MFDS within the cluster, and display them in the ESCWA user
interface.

File Handling
Back to Top

Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
m cr of ocus/ f h, using the nf secr et sadmi n utility.

To ensure the Fileshare server uses the file stored in the vault, start the server with the / uv option.

Interface Mapping Toolkit
Back to Top
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Improvements are available in the following areas:

* Resource-based REST APIs - the following enhancements enable the creation of resource-based
REST APIs:

e Operations in JSON RESTful Web services can now have a customizable URI path that identifies a
resource. Operation paths have support for dynamic templating.

» APl resources can now be automatically identified from COBOL groups in a COBOL program, and a
set of operations can be generated for each API resource.

< Itis now possible to specify the location of interface fields in the service request or response. An
interface field can either be a parameter in the URI path, a query parameter, or be in the JISON
message body.

*  Summary support for OpenAPI - the IMTK now supports the OpenAPI| Specification (originally called
Swagger) which is the most widely-accepted format for REST API specifications. Features include:

< Consumption of OpenAPI 3.0 and Swagger 2.0 files for purposes of client and service generation.
e Generation of OpenAPI 3.0 files to describe the APIs of a JSON RESTful Web service.

* REST service output filtering and field selection - Enterprise Server JSON RESTful Web services
now include the following features:

« Automatic filtering of the JSON response body of a Web service by path and query parameters
received in the request URI.

» A special query parameter "$fields" that can be used to indicate that the JSON response body is to
contain only certain specified fields, and to exclude all other fields.

 REST API discovery - Enterprise Server API discovery is now supported. For a JSON RESTful Web

service, a list of all its available operations, and their URI paths, can be retrieved. This enables a client

to efficiently navigate an Enterprise Server REST Web service without having information about the

service’s operations ahead of time.

Library Routines
Back to Top
The following library routines are new:

e MFU_GET_FILE and MFUGETF - both these routines are used with data-driven tests in the Micro
Focus Unit Testing Framework. If the . csv file under test references external data in one of its cells
(using the @file-name notation), use either of these routines to load that external file into memory
before such tests are run.

The following library routine contains new functionality:

« CBL_GET_EXIT_INFO - this library routine has been enhanced to better detect the circumstances in
which an exit procedure has been invoked.

The Micro Focus Unit Testing Framework
Back to Top
The following enhancements have been made to the Micro Focus Unit Testing Framework:

< You can now run unit tests against an executable file from both the IDE (new in Eclipse) and the
command line. Before you run such tests from the command line, you must initially rebuild the
executable in order to link it into the testing framework.

* The . csv source files used in data-driven tests can now reference external data: use the @i | e- nane
notation in a cell to use the contents of f i | e- namne in the tests. The external source files must be
loaded into memory, using the MFU_GET_FILE or MFUGETF library routines, before the tests are run.

« Two new elements are available for data-driven tests: a data-driven setup and a data-driven teardown.
Conventional setup and teardown entry points would run multiple times during a data-driven test; these
two entry points run only once per test run.

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)



Multi-Threaded Applications
Back to Top
This release includes the following improvements:

« Improved validation of detached threads on UNIX - the reliability for applications with many threads,
when using the CBL_THREAD_KILL routine and during abnormal process termination, such as when
an error occurs, has been improved.

e Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.

Problem Determination
Back to Top
The following enhancement is available:

* Consolidated Tracing Facility (CTF) on UNIX - CTF is now always present during process
termination, such as when an application, or a third-party code, calls exit() directly.

Product Documentation
Back to Top
The following functionality is new in this release:

< Online context help in Eclipse - online context Help is now the default setting for Visual COBOL.
Requesting F1 help from within Eclipse now opens the documentation available on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/. You can configure
Eclipse to show either local or online help. See Viewing the Product Help.

What was New in Visual COBOL 5.0

Visual COBOL 5.0 provided enhancements in the following areas:

* COBOL Formatting

¢ Code Analysis

« Enterprise Server Common Web Administration
* Application Workflow Manager

e« COBOL Language Enhancements

e Compiler Directives

« Data File Tools

» Debugging

» Eclipse Integration

« Enterprise Server Security

* Micro Focus Unit Testing Framework
* Platform Support

* Product Documentation

COBOL Formatting
Back to Top

You can now reformat your COBOL code in the editor according to your preference and standards.
Formatting sets the indentation based on the configuration options which you can set in Windows >
Preferences > Micro Focus > COBOL > Editor > Formatter (for Eclipse).

You can find the COBOL formatting features on the editor context menu (for Eclipse) menu.
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Code Analysis
Back to Top

You can now create the following views for your code:

Program Flow Graph - enables you to view the overall structure of the COBOL program with nodes
representing sections and paragraphs. PERFORM statements between them which affect the program
flow are represented by links joining the nodes. External calls to other programs are shown but cannot
be expanded in the Program Flow Graph view. Hovering over the nodes shows a tooltip containing the
code representing the respective sections or paragraph. Clicking a node or a link joining said nodes
positions the code editor to that point in the source, allowing quick and easy navigation of the program.
Data Flow Analysis Tree - enables you to select a data item and then either statically trace what might
change its value or what other data items it might affect.

Enterprise Server Common Web Administration
Back to Top
y Note: This feature is in Early Adopter Product (EAP) release status.

Visual COBOL now includes a new Enterprise Server Common Web Administration interface (ESCWA).
ESCWA is a web user interface and server for modern administration, monitoring and control of Enterprise
Server. It offers improved usability that consolidates the different Enterprise Server user interfaces so that
native and managed regions, and security stores can be managed in one place. Features include:

Administering directory servers across multiple hosts.

Monitoring and control of Enterprise Server instances.

Configuring and administering a security store, defined in an LDAP-compatible security manager such
as Microsoft Active Directory or OpenLDAP.

Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server
instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORS).

Administering, monitoring and control of Enterprise Server for .NET regions and listeners.

The use of current web frameworks that have a greater focus on security.

Application Workflow Manager
Back to Top

Improvements have been made in the following areas:

Tools from the AWM, Eclipse, and ISPF Function Packages have been restructured and improved:

< Tool parameters are now named so that the position of the parameter is not significant anymore.

* You can only specify parameters which are supported by the tool.

* Only the parameter types String and File are now supported.

« Mass Processing is now an attribute of a tool parameter and is no longer a special input/output
parameter type.

« The tool relationship "Resource Operation Value" replaces the parameter type
"ToolDefinedResourceOperation".

A new REST Function Package has been added. It provides support for the following functions -

DELETE, HEAD, GET, PATCH, POST, and PUT.

The new JSON File Descriptor has been provided to support REST payloads. This function package
enables you to integrate RESTful API with your AWM workflow. See REST Function Package.

New tools in the Eclipse Function Package enable you to store and retrieve information from the Eclipse
secure store:
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« Save To Secure Storage; Read From Secure Storage; Delete From Secure Storage
You can use these tools to securely store login credentials to a remote system and reuse the
information for subsequent access.

* A new attribute is now available to enable you to add comments to every model component in the AWM
model editor. See Comments in the AWM Model Editor.

COBOL Language Enhancements
Back to Top

The following enhancements have been made to the COBOL syntax:

* 1S02002 conditional compilation - an additional mechanism for conditional compilation, the 1ISO2002
Conditional Compilation method, is now available. This has been implemented as part of the support for
Enterprise COBOL 6.2.

The following compiler directing statements are supported:
>>DEFI NE

>>| F/ >>ELSE/ >>END- | F

>>EVALUATE/ >>WHEN >>WHEN OTHER/ >>END- EVALUATE

« The JSON PARSE statement enables you to convert JSON text into COBOL data formats. This has
been implemented as part of the support for Enterprise COBOL 6.2.

e INSPECT statement - the performance of INSPECT... CONVERTING has been improved, particularly
for cases where sour ce- al phabet is long.

e Support has been added for the portable syntax for SET - set[string].

Compiler Directives
Back to Top
The following Compiler directives are new in this release:

JVMTARGET Specifies the JVM version number targeted by the class files generated in this
compilation unit.

ILNORMALIZENAMES Determines the program elements that are normalized when a program is
compiled to .NET or JVM COBOL. Normalization in this context results in
replacing all $ and - (hyphen) characters with _ (underscore) characters in the
name of the generated class file.

Data File Tools
Back to Top

This release provides the following enhancements:

« The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.

e Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.

* When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.

* You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.

* You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Eclipse Integration
Back to Top
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This release includes enhancements in the following areas:

» Supported Eclipse versions - this release supports Eclipse 4.7 (Oxygen) and 4.8 (Photon). The setup
file installs Eclipse 4.8.

Eclipse 4.6 (Neon) is no longer supported.

« Java support - the 64-bit Java 8 is required to run the Eclipse IDE. The setup file installs Adopt
OpenJDK 8 (u202) with Hotspot. Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. For full
details on the supported Java versions, see Software Requirements.

» COBOL editor:

« Automatic insertion of END statements - Eclipse now automatically inserts the end clause for IF,
EVALUATE, PERFORM, EXEC and TRY statements.

« Automatic insertion of closing symbols - by default, Eclipse now automatically adds closing quotes
and brackets where required.

« Search text positioned between specified columns - the Micro Focus Find/Replace dialog box now
includes options to search between specified columns in the code.

» Directive sets - Compiler directives for your projects are now saved in language-specific . nf di r set
XML files stored within a . set t i ngs subfolder in the project's folder. You can create your own versions
of . nf di r set files and verify them against an XML schema that Micro Focus supplies.

Previously, all settings were stored in a single, proprietary IDE project file. Existing projects which
currently specify directives and other similar settings in the . cobol pr oj file will be upgraded to use the
new . nf di r set files when imported or loaded in Visual COBOL 5.0. If you are storing your source
code in a source control system, ensure that you add the . nf di r set files to source control as well.

* Remote connections - support is available for automatic SSH tunnelling of Visual COBOL Development
Hub network traffic. You can route most Visual COBOL Development Hub network traffic using SSH
port forwarding. This makes developing on a remote UNIX host running a firewall easier to configure. In
addition, the network traffic is encrypted as it is being sent within an SSH tunnel.

» User Interface:

* The COBOL Explorer view uses an icon overlaid with P to indicate COBOL programs that will not
be built because they are preceded by another of the same name on the build path.

« Improved settings Ul - the COBOL, and the Run-time Configuration settings pages now use a
property grid that also shows the definitions of the settings.

Debugging
Back to Top
This release includes the following enhancements:

« Animate - Eclipse now includes an additional menu option when debugging a COBOL program for
setting the speed and toggling Animate mode. When active, the program will automatically step through
each line of source code, updating the source code in the editor, the Debug Stack, Outline and
Variables Views. See Debugging Commands and Options.

< Conditional watchpoints - you can now specify conditions and hit counts for COBOL watchpoints. A
condition can be in the form of an expression or it can be a hit count (for the number of times memory
associated with a data item has been updated). The condition is evaluated each time the data item
being watched changes. If the condition evaluates to true, then program execution stops. This enables
more fine-tuning of the current watchpoint support and is useful when debugging large, complex
programs.

« Dynamic core dumps - you can now invoke a core dump programmatically and continue execution of
your program. A new library routine, CBL_CREATE_CORE, enables you to produce a core file for the
current process or a process owned by the same user that owns the current process.

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)



* Improved visibility of the PERFORM stack - the PERFORM stack and PERFORM range names are
visible in system debuggers such as gdb in many cases on 32-bit Linux with Intel architecture and
Solaris with Intel architecture. This was already the case on AlX, 64-bit Solaris-Intel, and all other Linux
platforms (including 64-bit Linux-Intel).

« Live Recording - a new environment variable, COB_LIVE_RECORD_SIZE, is now available to aid
performance during the creation of a live recording file. Use it to specify the amount of memory (in MB)
that is to be used to store events that are to be written to the live recording file. When the limit is
reached, the buffer is cycled so that the oldest events are removed to make space for the most recent
events.

« In order to include source line numbers in run-time error messages, which makes the diagnosis of
issues in your program easier, the COBOL compiler now produces . i dy files by default when building
from the command line, unless the NOANIM directive is specified. You can safely remove . i dy files
after compilation if you do not need them; they do not need to be distributed with your application unless
you want to debug your code. However, unless you specify the ANIM directive, generated executables
suchas . dl | and. gnt will not be debuggable, which is consistent with prior behavior.

y Note: Behavior has not changed if you are using an IDE or build scripts generated by an IDE.

« Stackdump files (Linux Intel 64-bit, Solaris Intel 64-bit, and Linux/390 platforms only) - you can produce
a stack trace for applications in a production environment that encounter a Run-Time system error. Use
the stackdump_on_error and stackdump_filename tunables to configure the production of a stackdump
file when an error occurs, from which you can locate the exact line of failing code in your program.

« A new configurable tool is now available that dumps to a file stack traces of all threads in process on
any Run-Time System error. [Linux Intel, Solaris Intel, zLinux only — requires ANIM on 32-bit Linux
Intel]. This is only supported for native COBOL.

* Line number information is now being output for optimized builds (on Linux Intel 64-bit, Solaris Intel 64-
bit, PowerLinux, zLinux, and Solaris SPARC platforms only). This is only supported for native COBOL.
Because of what optimization does, the information is imperfect, but it remains highly indicative. This
gives the following advantages:

« Enables the use of the stackdump utility (where available) for optimised builds.
« Provides location information should a signal occur when running in a system debugger such as gdb.
« Provides some limited ability to step through optimized code in system debuggers.

Enterprise Server Security
Back to Top
This release includes the following enhancements:

e Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File.

« Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.

e OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.
This is the stable Long Term Support version of OpenSSL.
« Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:

* Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.

e Using only the most secure ciphers and hash methods.

e TLS 1.3 will be negotiated in preference to the older TLS protocols.
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« Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.

» The default security level for previously configured endpoints has been moved from Security Level O
to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.

Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of

X509 certificates bearing the name of the Fileshare service as the Common Name element of the

certificate.

In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unigue certificate. While running on the same host and registered
with the same network endpoint.

Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.

Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.

Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:

e The client library vendor and version information is logged after the library is loaded

« The module has better heuristics for loading the correct library supplied by the OS vendor, so the
"provider" configuration option can generally be omitted

* For OpenLDAP, the module sets its proprietary "connect timeout" option

Enterprise Server for .NET
Back to Top

This release includes the following enhancements:

Improved CICS compatibility - CICS EIBRCODE handling in Enterprise Server for .NET now matches
the mainframe specification. CICS BMS support in Enterprise Server for .NET now matches the
behavior on the mainframe and in native Enterprise Server more closely.

MMC administration Ul support for ESF security - the MMC snap-in for Enterprise Server for .NET
administration now supports the External Security Facility. This means you can use LDAP-based or
custom security solutions to provide administrator authentication and access control.

TLS (SSL) support - the seelistener utility now supports TLS (also known as SSL) for its TCP
communications channels. These include all channel types except MQ. The Enterprise Server for .NET
client classes also have been enabled for TLS. For example, the seeout utility can now be used with a
TLS-enabled MFBINP channel.

Performance improvements - this release comes with an improved performance in WCF, system
database operations, and VSAM database operations.

Micro Focus Unit Testing Framework
Back to Top

This release provides support for the following functionality:

Data-driven unit tests - a new type of test suited to testing data where values read from a source are
passed through the same tests.
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» Test output colorization - test output can now include basic colorization for supported terminal
emulations. This feature must be run from the command line.

Platform Support
Back to Top
Support is now available for the following additional or updated operating systems:

e SUSE (Power) 11 SP3, 12
* Red Hat (Power) 7.2, 7.3
*  Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.

Product Documentation
Back to Top
The following is new in this release:

e The Comparison of COBOL with Other Managed Languages document has been updated to reflect the
recent enhancements in the .NET and JVM COBOL support.

What was New in Visual COBOL 4.0

This release provides enhancements in the following areas:

* Integration with Eclipse

e Application Server JCA Support for Enterprise Server
» Application Workflow Manager

e Code Coverage

e Codeset support

e Compiler directives

» Data File Tools

» Debugging

» Docker

« Documentation on working with large applications
» Enterprise Server

« File Handler

e Managed COBOL

e Library routines

e Micro Focus Unit Test Framework

* OpenESQL

e Platform support

Integration with Eclipse
Back to Top
This release provides the following general enhancements:

» Support for Eclipse 4.7 Oxygen (64-bit) and 64-bit project templates - the 64-bit Eclipse 4.7 is now
installed by default. Project templates are available for both 32-bit and 64-bit applications. You can set a
default project template (either 32-bit or 64-bit) to use so that all future new projects will use that as the
preference. On platforms only capable of building to 64-bit, the 64-bit templates are the default ones.
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The 32-bit Eclipse is still supported on 64-bit Windows platforms, however you need to manually install
it and a 32-bit Java.

Support for Eclipse 4.4 and 4.5 has been discontinued.

e Support for SUSE 12 - only the 64-bit SUSE 12 platform is supported and you can only use the 64-bit
Eclipse with 64-bit projects on it.

« (Native COBOL projects only) The Project Settings page in the project's properties now include a
search option. This enables you to find files and build configurations that have settings different from the
ones set at project level.

* Remove File Directives - a context menu command in the explorer view enables you to reset a file's
directives.

* |VP diagnostic tool enhancements - it is now possible to run the server-side IVP diagnostic tool for
diagnosing issues with a remote connection from within Eclipse installed at the client side. The IVP tool
now also performs a check for whether XTERM is installed on the remote machine.

« IMTK service mappings are now automatically regenerated if you make a change to the interface fields
in the underlying program.

The following enhancements are available for JVM COBOL projects and package handling:

« New wizards for creating ENUM, DELEGATE and VALUETYPE types.

« Additional code snippets for Method-Id and Property-Id.

» Showing and grouping packages in the COBOL Explorer view - use the COBOL JVM Project
Presentation command from the View menu in the explorer to either display COBOL categories or
packages.

» Refactoring by renaming the package name - available from the context menus in the COBOL Editor
and in COBOL Explorer.

« Refactoring by moving source folders, packages or compilation units - available from the explorer
context menu.

« Support for switching off the package name mapping using the Each part of the package name
corresponds to a subdirectory option in the Build Configuration page.

« Support for packaging .class files in a .jar file when building COBOL JVM projects.

* Open Type Hierarchy and Open Call Hierarchy context menu commands - available in the COBOL
editor, COBOL Explorer and in the outline views while seeing the packages presentation in the IDE.

The following editor improvements are available:

* A Properties context menu command - enables you to access a file's properties directly from the editor.

* A Show In context menu command - enables you to locate the file in the COBOL Explorer.

« Edit > Convert Tabs to Spaces command - enables you to convert any tabs in your COBOL source
files to a specified number of spaces.

Automatic relinking of applications created with Visual COBOL 3.0:

« Visual COBOL 4.0 can automatically relink existing projects created with Visual COBOL 3.0 that have
executable link artefacts. Eclipse displays a warning in the Problems view that the project requires
relinking. It then offers a Quick Fix action for you to execute that will link your project with the most
recent version of the run-time system.

For more information see Related Information at the end of this topic.

Application Server JCA Support for Enterprise Server
Back to Top
This release includes the following enhancements:

e COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.

« Tomcat 7.0 support for servlet generation with J2SEBeans.

« NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL
fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
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parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

For more information see Related Information at the end of this topic.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:
* Model editor - now includes:

* A new Edit action. Enables you to edit any model component instead of working with the Properties
view. The new action enables you to change the attribute values of several model components at a
time.

e An Outline and a Relationship Hierarchy view.

« Improved backwards and forwards navigation in the model.

« Automated sequence numbering in the model.

« The context menu of the model editor has been restructured for more clarity.

» Context help.

< Tool creation has been improved. Dependent components are generated from the function package
tool definition.

« Development of models:

« Newly created empty models now contain all categories. The new models also validate without any
errors or warnings.

* A new AWM system type, “Custom System”, is available. This system type supports the model
development process by facilitating the creation, change, load and reload of a model.

* New modelling features:

« The “Return Property Value” tool in the function package now supports several additional use cases.

« The “Transfer File” tool in the function package offers improved support for mass processing.

e Support for properties with an application-wide scope.

« A modelling capability to structure the local file cache for copybooks and include files downloaded by
the background parser in the editor. Additional tools are provided to check the existence of or clear
the file cache for copybooks and include files.

e The product help includes some tutorials showing how to create new models and extend the
functionality of existing models. See the Tutorials Guide.

« A number of template models are now available and can be used as a base to develop your own
models.

For more information see Related Information at the end of this topic.

Code coverage

Back to Top

This release provides the following enhancements:

e Support has been added in Eclipse for code coverage for procedural copybooks.

For more information see Related Information at the end of this topic.

Codeset support
Back to Top

Support has been added to enable codeset mapping to additionally be configured to use IBM's Conversion
Tables directly instead of the Micro Focus supplied tables. You need to download IBM's conversion tables
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from IBM's Web site. Then you can use the MFCODESET environment variable to convert between IBM's
CCSIDs.

For more information see Related Information at the end of this topic.

Compiler directives
Back to Top
The following Compiler directives are new in this release:

* DISPSIGN - determines the display output of numeric fields with included signs, under an IBM
mainframe dialect only.

e GNTLITLINKSTD - stops the suppression of call-convention 8 when both call-convention 2 and call-
convention 8 are in effect for a . gnt file in an Intel x86 32-bit environment.

* ILSMARTTRIM - trims any trailing spaces from a string item returned by the get property associated
with an alphanumeric item processed by ILSMARTLINKAGE.

* MAINFRAME-FLOATING-POINT - specifies the format of a program'’s floating point data items: either
IBM hexadecimal format or IEEE format. This directive is supported in managed code only.

The following Compiler directives contain new parameters in this release:

e« CHECKDIV - a new parameter '"ACOS' now emulates a divide by zero operation on an ACOS
mainframe system: the quotient and the remainder are set to the value of the dividend.

* OOCTRL - a new parameter, L, specifies whether to include directory location commentsin. cl s
and . i ns inheritance files.

« NUMPROC - a new parameter 'ACOS' provides partial compatibility with the behavior of NEC ACOS
COBOL processing of invalid data in USAGE DISPLAY data items and invalid sign information in
USAGE COMP-3 data items.

For more information see Related Information at the end of this topic.

Data File Tools
Back to Top

It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:

« Save the filtered records to a new file.

« Save the records that match the specified filter (such as customer information or orders).
» Download a subset of the data from a remote file.

« Save a small portion of the data for testing purposes.

For more information see Related Information at the end of this topic.

Debugging

Back to Top

This release includes the following enhancements:

The following enhancements have been made to reverse debugging and live recording:

« Reverse debugging and live recording have been enhanced significantly, and are now considered GA
features. You can now debug using watchpoints and conditional breakpoints, and reset execution points.
Debugging multi-threaded applications is now supported, and so are programs that contain OSVS
performs and nested programs.

« A command line utility, cobesl r, has been introduced to enable you to configure live recording for
particular services or application instances of an enterprise server region.
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* You can now use the CBL_DEBUG_START and CBL_DEBUG_STOP library routines to start and stop a
live recording session.

For more information see Related Information at the end of this topic.

Docker
Back to Top

This release provides support to enable you to run your COBOL applications in Docker containers, taking
advantage of the many benefits offered by the Docker platform such as portability, performance, agility,
isolation, and scalability.

For more information see Related Information at the end of this topic.

Documentation on working with large applications
Back to Top

The product help now includes a new section, Working with a Large Code Base, that includes
recommendations and best practices for working with large applications inside the IDE. It includes tips on
how to structure your projects, how to optimize the performance of the IDEs, and step-by-step workflow
showing how to move an existing legacy application into Visual COBOL.

For more information see Related Information at the end of this topic.

Enterprise Server
Back to Top
The following enhancements have been made to Enterprise Server:

« Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

» The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.

This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

« (Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.

It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

» XA-compliant Resources (XARS) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

< A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

« Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.
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* Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.

e Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

« The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a . csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.

* You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

For more information see Related Information at the end of this topic.

File Handler
Back to Top
This release provides the following enhancements:

e The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.

* The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

For more information see Related Information at the end of this topic.

Library routines
Back to Top
The following library routines contain new functionality:

« CBL_GET_OS_INFO - this library routine can now detect if the program is running within a Docker
container: cbl t e- osi -rts-capabi lities paraneter, bit7.

« CBL_DEBUG_START and CBL_DEBUG_STOP - these library routines have been enhanced to start
and stop a live recording session.

For more information see Related Information at the end of this topic.

Managed COBOL

Back to Top

Deploying JVM COBOL to an Application Server:

* Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

Micro Focus Unit Test Framework

Back to Top

This release provides support for the following functionality:

« Generation of unit test stubs for selected entry points within your program.

For more information see Related Information at the end of this topic.

OpenESQL
Back to Top
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This release provides the following new features:

e Support for SQL Server 2017.

e The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction
boundaries.

e A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that
do not do positioned updates or deletes with PostgreSQL or MySQL.

« Larger communication area (PID) that accommodates longer plan and program names.

* SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all
OpenESQL backends.

For more information see Related Information at the end of this topic.

Platform support

Back to Top

Note the following changes in platform support for this release:

* SUSE platforms - this release only supports SUSE Linux 12 SP2, 64-bit.

On this platform, you can only build COBOL programs to 64-bit executables. This applies when using
Eclipse on SUSE or with remote projects when Visual COBOL Development Hub is installed on SUSE.

For more information see Related Information at the end of this topic.

What was New in Visual COBOL 3.0

Visual COBOL 3.0 provided enhancements in the following areas:

* Integration with Eclipse

« Application Server JCA support for Enterprise Server
« Application Workflow Manager

» Building applications

» Character encoding

e COBOL language enhancements

« Code analysis

« Code coverage

e Compiler control

» Data File Tools

« Database access - DB2

« Database access - MySQL

« Database access - OpenESQL

» Debugging applications

¢ Deployment on multiple platforms

« Documentation

* Enterprise Server

e Micro Focus Unit Testing Framework
e XML processing

Integration with Eclipse

Visual COBOL 3.0 provided enhancements in the following areas:

e Support for Eclipse 4.6 - Visual COBOL now ships with the 64-bit Eclipse 4.6. By default, Eclipse is
configured to compile applications for 32-bit and the default target platform for new projects is 32-bit.
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Note: Applications that were created using Visual COBOL 2.3 Update 2 and earlier must be
recompiled in Visual COBOL 3.0 to ensure they will compile and execute properly.

The 32-bit Eclipse is still supported on 64-bit Windows platforms and you need to manually install the
32-bit IDE and a 32-bit Java

You can install the Visual COBOL plugin in other instances of Eclipse (32-bit or 64-bit). Support for
Eclipse 4.2 and 4.3 has been discontinued.

* Rename refactoring - enables you to rename COBOL elements such as variables and identifiers,
section and paragraph names, classes, and methods across a program or a workspace. Renaming
helps improve the readability of an item or make its purpose clearer. Two preferences for renaming are
supported in Eclipse - directly in the editor or using a Rename dialog box that offers a preview.

« Copybook paths - it is now possible to specify copybook paths to folders that are outside the project
folder.

* Standalone files:

« Itis now possible to specify the locations where the IDE will search for the program symbol files
(. i dy) for standalone files: Window > Preferences > Micro Focus > COBOL > Standalone Files
> Program Symbols (.IDY).

e Itis now possible to use the Eclipse debug configurations to debug standalone files, including core
dump files.

In previous versions of Visual COBOL, standalone files were known as "single files". References to
"single files" in the IDE and the product help have been changed to "standalone files".

« Error reporting - errors reported in the Console view now include a link for opening the source file at the
line where the error originates.

« Editor improvements - an option for removing trailing whitespaces has been added to the IDE
preferences for the COBOL editor.

Application Server JCA support for Enterprise Server

f Restriction: This feature applies only when the Enterprise Server feature is enabled.

In Visual COBOL 3.0, EJBGEN has been updated to generate an EAR file as a part of the COBOL
deployment process, which enables you to deploy EJBs to Java Application Server.

Application Workflow Manager

Visual COBOL for Eclipse now provides the Application Workflow Manager (AWM) feature. AWM enables
you to customize and extend the Eclipse Ul and workbench functionality to create application workflows
that meet your requirements.

The features comes with:

« A standard project model for local COBOL development that reflects the features available in COBOL
Explorer. You can modify this model by adding or removing project features.

* Application Explorer, Filter Definitions, Properties, and Table Results views in the COBOL
perspective.

Visual COBOL 3.0 includes improvements in the following areas:
« Application Workflow Manager model editor:

« The definition of linked element types and properties has been improved. Some required model
objects and relationships are now generated automatically.
* The editor now detects unused references in a model.
» Application Workflow Manager modeling:

< Basic resource processing has been extended to support mass processing where appropriate.
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The AWM function package now includes the following new tools:

< "Return Property Value" - enables you to map the values of input parameters to output
parameters.

» "Validate Value" - enables you to validate a filename against a specified naming convention.

You can now specify enabling conditions in a more granular way. An additional condition type has

been introduced to hide actions or properties. For example, hiding an action from the context menu

of an element.

The Eclipse linked element type now enables the label and label decorator to be automatically set to

mirror their representation in other Eclipse views if they are not explicitly modeled.

Table columns can be modeled as a combination of two or more properties - for example, to combine

a date and time property value.

Additional standard icons.

« Mainframe Access (MFA) integration and the MVS function package:

MVS resources are now available as linked element types.
The following tools have been added to the MVS function package:

» Delete MVS data set or member

« Rename MVS data set or member

« Copy MVS file to clipboard, Paste MVS file from clipboard

* Get data set or member attributes

Improvements have been made to copy and paste support in the MVS Explorer.

File mapping between z/OS and local files now supports additional local code pages.

The editor context menu contains a "Submit to Mainframe" action when a file is opened from the
MVS Explorer with an extension which is mapped to JCL in the File Mappings view.

Some of the new MVS function package tools replace existing ISPF function package tools resulting
in improved performance of the tools.

The sample model "MVS Projects Sample Application" has been improved by including some of the
new AWM MVS function package features.

« AWM is now available as a standalone feature which you can install into a separate instance of the
Eclipse IDE installed on your machine.

Building applications

Visual COBOL 3.0 provided the following improvements:

« Support for faster, parallel building on multi-CPU machines - support has been added for multi-
processor compilation of the sources in native COBOL projects on multi-CPU machines.

You can specify the maximum number of concurrent compilations from the IDE preferences - Window >
Preferences > Micro Focus > Builder.

Character Encoding

A new utility, cobutf8, is available. cobutf8 enables you to seamlessly run applications that require non-
UTF-8 character encodings in a UNIX environment that is using a UTF-8 locale.

COBOL language enhancements

Visual COBOL 3.0 includes the following enhancements to the COBOL syntax:

e The DISPLAY-OF and NATIONAL-OF intrinsic functions are now able to process conversions using any
IBM CCSID value. See To install a CCSID Table for details on installing the required CCSID table.

The following enhancements are available in managed COBOL.:
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« To avoid an exception being thrown if an explicit conversion fails, use the AS IF syntax, which results in
the target object being set to null and no exception thrown. See cast expressions in the Expressions
topic for more information.

Code analysis
Visual COBOL 3.0 provided the following improvements:

« A new group of predefined rule sets for 64-bit readiness is now included in Visual COBOL.
« Support for importing code analysis reports produced with one of Micro Focus's advanced tools for code
analysis, Enterprise Analyzer or COBOL Analyzer.

Code coverage
The following improvements are available within the IDE:

« Information about unexecuted programs - the code coverage reports in the Code Coverage window
now show the unexecuted programs.

« Code coverage support for standalone COBOL files - you can import existing code coverage reports in
the Code Coverage window and use it to supply code coverage information for standalone files.

¢ Remote code coverage files - in the Code Coverage window in Eclipse, it is now possible to import
code coverage report files that are stored in remote locations.

« Test coverage files - it is now possible to use a test coverage file to debug applications.

If you are using Test Coverage from the command line, you can now use the following features:

e A new Compiler directive, COLLECTION - the directive enables test coverage to gather information
about unexecuted programs. In the IDE, this directive is automatically set on a project when you enable
code coverage for it.

« A new command line utility, tcutil - the utility enables you to convert the test coverage binary results file
into XML format.

« Itis now possible to integrate test coverage in a Continuous Integration (Cl) system. You can use tcutil
and an XSLT processor to transform test coverage data into a format suitable for including in a CI.

Compiler control

The following Compiler directive are new in this release:

e« COLLECTION - provides a mechanism for code coverage to identify unexecuted programs.
The following Compiler directives have been updated:

e ALIGN - this directive has new parameters (FIXED and OPT) that can be used in conjunction with the
integer taken, which can aid performance. The default is ALIGN"8 OPT"; see the Comments section of
the ALIGN Compiler directive topic for details of its affect on memory boundaries.

* ARITH - this directive emulates the IBM mainframe option of the same name. Defines the maximum
number of digits for numeric data items.

e FASTINIT - this directive is now on by default when setting the MF dialect; it remains not set by default
for other dialects.

e SSRANGE - this directive now has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.

« XMLPARSE - includes a change in the way entities are processed when XMLPARSE"COMPAT" is set

Data File Tools

The Data File Tools editor previously provided (from Visual COBOL 2.3) as a Technology Preview item was
supported at GA level from Visual COBOL 3.0.

Visual COBOL 3.0 provided the following enhancements to Data File Tools:
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* Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.

« Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server
instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.

« Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.

This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.

« Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.

» Support for existing .pro files - enables you to use your existing editor profiles.

« Support for existing .str files - enables you to use your existing COBOL structure files.

« Automatic timeout - if no internal operations or external actions (such as a mouse click) have been
detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Database access - DB2

Visual COBOL 3.0 provided a new DB2"QUALIFY-CALL" Compiler directive that enables stored procedure
invocations to include a schema name.

Database access - MySQL
Visual COBOL 3.0 provided support for MySQL with ODBC.

Database access - OpenESQL
Visual COBOL 3.0 provided the following new features:

« Statement prefixes for the SQL"CHECK" Compiler directive that enable the creation of temporary tables
and other SQL objects at compile time, ensuring full SQL syntax checking during compilation.

e SQL"OPTIMIZECURSORS" Compiler directive that enhances processing for traditional embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses.

e SQL"CLOSE_ON_COMMIT" Compiler directive to leave cursors open for further result set processing
after a commit.

¢ SQL"GEN-SQLCA" Compiler directive that generates an SQLCA similar to the z/OS DB2 directive
STDSQL"YES".

Debugging applications

Visual COBOL 3.0 provided the following new features:

« Debugging core dump files without a project.

* Reverse debugging (Technology Preview) - it is now possible to step backwards through an application

to view a recording of the previous steps executed in the current debug session. Input is not accepted
while viewing recorded execution.

Restriction: This feature is supported on Red Hat Linux x86 platforms only. Additional restrictions
apply. For details, see the Reverse Debugging and Live Recording topic in the Known Issues and
Restrictions section of this documentation.
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e COBOL Live Recording debug configuration (Technology Preview) - it is now possible to record an
application execution and view its execution path in the debugger. This method of debugging enables
stepping both forwards and backwards, but does not accept input.

Restriction: This feature is supported on Red Hat Linux x86 platforms only. Additional restrictions
apply. For details, see the Reverse Debugging and Live Recording topic in the Known Issues and
Restrictions section of this documentation.

Deployment on multiple platforms

Visual COBOL 3.0 provided support for deploying JVM COBOL applications on multiple platforms. You can
compile an application on one platform (such as Windows) and then deploy its class files to a different
platform (such as Linux or UNIX).

Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications for details.

Documentation
The following new sections have been added to the product help:

« Where do | start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.

* Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.

Enterprise Server
Improvements are available in the following areas:
Integration with Eclipse

e Exporting an enterprise server definition from the IDE in XML format.
« Importing an enterprise server into the IDE using its definition file.

Long user IDs and passwords:

« Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

SHA-256 support in DemoCA:

« By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:

« Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

The Micro Focus Unit Testing Framework

The Micro Focus Unit Testing Framework is now available from within the IDE. It includes much of the
architecture you would expect of an xUnit framework to create, compile, run and debug unit tests, including
the following features:

< A unit test project template.
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» Atest creation wizard that enables you to generate tests from your source code.

« Code templates for each element of a test case.

e Support for running tests with Code Coverage enabled.

« The Micro Focus Unit Testing view, where you can manage your test runs and view test output.

There has been a number of enhancements to the command line version of the Micro Focus Unit Testing
Framework. Support has been added for:

* Running test fixture files using Apache Ant.

» Applying traits to your test cases, then performing a test run based on those traits.

< Applying a high, medium, or low priority to test cases, which affects the order in which they are run.
* Adding coded command line options directly into your test code.

» Using a test run-specific configuration file, in which you can set environment variables.

XML processing

XML PARSE now works in a purely managed COBOL environment. It is now supported in JVM COBOL
and, in both .NET and JVM COBOL, it has a fully managed implementation. XML PARSE working without
calling out to native code ensures it can be used in restricted rights environments.

What was New in Visual COBOL 2.3 Update 2

Visual COBOL 2.3 Update 2 provided enhancements in the following areas:

¢ Integration with the Eclipse IDE

« COBOL language enhancements
» Classic Data File Tools

e Compiler directives

« Editor writing assistance

» File handling

* Interface Mapping Toolkit

o Library routines

» Tutorials

Integration with the Eclipse IDE
Visual COBOL 2.3 update 2 provided enhancements in the following areas:

» Using the search facility, Search > Micro Focus, you can now limit the search to the copybooks used
by the current program rather than all copybooks in the project or the entire workspace.

e The editor provides a new context menu command, Extract COBOL code to copybook, that enables
you to move a selected segment of the code to a new copybook file in your project. The segment of
code moved to a copybook is replaced with a COPY statement in the original program.

« Support for Eclipse 4.5 - after installing Visual COBOL, you can add it as a plugin into a separate
instance of Eclipse 4.5. See your product's Installation notes.

COBOL language enhancements

Numeric, edited and external floating point items can now specify USAGE NATIONAL when the
NATIONAL"2" Compiler directive is in effect. Signed numeric items must be specified with the SIGN IS
SEPARATE clause.

Classic Data File Tools

A new command line utility is available which enables you to initiate the following actions: open data files,
create or open record layout files, create or open segment layout files, and open IMS databases using a
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DBD or PSB file. Note that although you can initiate these actions from the command line, you must
complete them from within the IDE.

Compiler directives
The following Compiler directives are new in this release:

e COMMAND-LINE-LINKAGE - enables you to call a program and pass the command line to the main
program as a parameter to be accessed via the Linkage Section. This offers equivalent functionality to
the command_line_linkage tunable, which has now been deprecated.

« EBC-COL-SEQ - controls the behavior of an EBCDIC collating sequence, specified in a
NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long-standing fixed
(platform-independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

* NATIONAL - enables you to specify numeric, edited and external floating point items as USAGE
NATIONAL.

Editor writing assistance
Visual COBOL 2.3 update 2 provided the following enhancements:

« Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.

+ S$REGION statement - support is provided for the SREGION Compiler-control statement. You can use
$REGION - $SEND-REGION to surround blocks of code that you want to fold or expand in the editor.

» AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

For more information see Related Information at the end of this topic.

File handling
MFJSORT ICETOOL now supports the USING parameter in the SELECT operator.

For more information see Related Information at the end of this topic.

Interface Mapping Toolkit

Visual COBOL 2.3 update 2 supports JSON schemas for the generation of REST Web service clients in
the Eclipse IDE.

For more information see Related Information at the end of this topic.

Library routines
The following library routine contains new functionality:

e CBL_GET_PROGRAM_INFO - a new function (function 10) has been added for native COBOL which
returns the path and program name, or the program name only of a particular program.

For more information see Related Information at the end of this topic.

Tutorials

The product help includes the following new tutorial:
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« Tutorial: SQL - Deploying an Enterprise JavaBean Containing JVM COBOL to a JBoss Application
Server - that walks you through the process of deploying an EJB that contains JVM COBOL code.

What was New in Visual COBOL 2.3 Update 1

Visual COBOL 2.3 Update 1 provided enhancements in the following areas:

» Integration with the Eclipse IDE
e Code Analysis

e Code Coverage

e Compiler directives

« Data File Tools

« Editor writing assistance

* Enterprise COBOL 5.2

* File Handling

» Library routines

« Managed COBOL Syntax

* Native COBOL Syntax

« RM/COBOL compatibility

* Rosetta Stone for COBOL, .NET and Java Developers
« UNIX and Linux platform support
* Zz/Server

Integration with the Eclipse IDE

Visual COBOL 2.3 Update 1 provides the following enhancements in the integration of Micro Focus
COBOL with the Eclipse IDE:

Editor:
« COBOL editor:

* You can now specify the increment for the COBOL and the standard line numbering from Window >
Preferences > Micro Focus > COBOL > Editor > Line numbering.

* You can now toggle single or multiple lines between commented and uncommented states.
Building applications:

« Environment variables - a new page, Build Environment, in the project's properties enables you to
specify environment variables for your applications. You can also specify environment variables that only
apply at run time on the run or debug configuration for the application.

Code Analysis

This release provides support for performing code analysis at the command line using Ant which enables
the integration of code analysis in Cl frameworks. Features include:

« Support for performing code analysis at the command line using the project's . cobol Bui | d Ant script
and specifying a target.

* New Ant targets for code analysis - anal yze and bui | d. and. anal yze. These enable you to only run
analysis and produce analysis data or to build and produce build artifacts as well as analysis data.

« New Micro Focus Ant task, anal ysi s, for the . cobol Bui | d file. A parameter for this task enables you
to specify whether the build fails or continues when code analysis results are received.

* New parameters for code analysis for the cobol Ant task - anal ysi sDat a, anal ysi sDat aDi r.

* New Ant type, r ul eLi st , for the . cobol Bui | d file - enables you to specify the rules to execute.

e Support for running analysis using a custom . cobol Bui | d file from outside of the project directory or
the workspace.
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See the Micro Focus Ant User Manual for more details on the new task, types and parameters.

Code coverage

The code coverage reports are now integrated with the IDE and with the editor. Features include:

A new Code Coverage view (Eclipse) showing the statistics of what percentage of the code has

executed.
Navigation from the Code Coverage view (Eclipse) to the missed and covered blocks in the editor.
Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).

Compiler directives

The following Compiler directives are new in this release:

ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.

This directive is now available for JVvM COBOL.

OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in
your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it

Data File Tools

This release provided improved security and increased support for more file types. Features include:

Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data

Editor writing assistance

Visual COBOL 2.3 Update 1 provides the following enhancements:

Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.

$REGION statement - support is provided for the $REGION Compiler-control statement. You can use
$REGION - $END-REGION to surround blocks of code that you want to fold or expand in the editor.
AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

Enterprise COBOL 5.2
With the introduction of Enterprise COBOL 5.2, the following features were supported:

The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.
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* Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.

* The SUPPRESS clause of the XML GENERATE statement has been enhanced.
e The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

File Handling

« A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMATS8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (. i dx file) containing the indexed key information.

You can use this type of file with the new r ebui | d / g option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape orrebui I d / p.

« Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

Library routines
The following library routine were new at this release:

e CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
e« CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.

Managed COBOL syntax
The following enhancements have been made to the managed COBOL syntax:

« A new command line utility, nf j ar pr ogrmap, is available to allow you to create the necessary Java
property file when calling COBOL programs that have been compiled as part of a package.

« You can now create generic iterators.

* You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed

COBOL applications.
Native COBOL Syntax

The following items are new features of the native COBOL syntax:

Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.

RM/COBOL compatibility

The RM/Panels syntax is now supported in Micro Focus COBOL applications.

Rosetta Stone for COBOL, .NET and Java Developers

The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.

UNIX and Linux platform support

This release is now supported on SUSE and Red Hat platforms that are running the little-endian
PowerLinux architecture.

i Note: These are 64-bit platforms only.

There are a few restrictions when running in this environment:
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« The cob flag -p, which enables profiling, is not supported on Red Hat platforms.
* The cobnode utility is not supported.

¢ SQL functionality is restricted to OpenESQL support (ODBC and JDBC) only.

* The RM File Manager (RMFM) is not supported.

z/Server

The z/Server Configuration Utility is now installed as part of COBOL Server and is not a Technology
Preview download. The user interface has been streamlined for the creation of a default working
configuration.

What was New in Visual COBOL 2.3

Visual COBOL 2.3 provided enhancements in the following areas:

» Integration with the Eclipse IDE

* General IDE enhancements

¢ Building JVM COBOL Projects Incrementally
e COBOL Editor in Eclipse

* Code analysis

e Code coverage

e Compiler directives

« Data File Structure command line utility
» Data File Tools (Technology Preview)
« Database access

« File locking

« File handling

» Library routines

* Managed COBOL syntax

e Micro Focus Unit Testing Framework
» Personal edition licensing

e Preprocessors

« Profiler

* Remote Connections

» REST service interfaces

« RM/COBOL Compatibility

» Single file support

e Tunables

e Updated run-time system

Integration with the Eclipse IDE
This release shipped with Eclipse version 4.4.2.

Support for Eclipse versions 3.7 and 3.8 has been deprecated. This affects any applications that were
created using an earlier version of Visual COBOL that have a JVM COBOL part. Such applications must be
rebuilt using Visual COBOL 2.3 to avoid receiving errors during compilation or execution.

In addition, when Visual COBOL is installed, you can optionally install the Visual COBOL plugin in other
instances of Eclipse installed on your machine (supported versions of Eclipse are 4.2, 4.3 and 4.4 for the
32-bit IDE).

General IDE enhancements

In Eclipse:
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* The Variables view now shows the file status of an internal file name.

* The Find All References and Go To Definition commands are now supported for JVM COBOL
applications.

e Support is provided for the SOCKS5 proxy server for debugger communication over SSL.

Building JVM COBOL Projects Incrementally

To minimize the number of modules to compile when building JVM COBOL projects, Visual COBOL now
enables you to configure your projects so that they are built incrementally - the IDE only rebuilds the files
that have changed.

To enable incremental builds for JVM COBOL applications that contain namespaces, check the Use
incremental build (Technical preview feature) option on the project build configuration tab in the
project's properties.

For JVM COBOL applications that do not contain namespaces, you can use the Use dynamic calls option
available on the build configuration tab in the project's properties. When the project is built with this setting,
calls to modules are resolved at run time rather than during compilation. This has the effect of not requiring
every module to be compiled when rebuilding the application.

COBOL Editor in Eclipse

Content Assist support for COBOL includes various enhancements and is now also available in JVM
COBOL:

« Context sensitive proposal - Content Assist only shows proposal that are relevant for the position of the
cursor in the code or for the type of project

« Enhanced proposal lists - lists include any relevant COBOL verbs, clauses and words, copybooks, code
templates, data items and section and paragraph names

« Intelligent assistance with completing statements - when you have entered a COBOL verb, Content
Assist shows proposals for the relevant clauses and identifiers that you can use to complete the
statement.

< Automatic completion for items - Content Assist automatically inserts single suggestions in the code.

< Qualifying non-unique names - Content Assist qualifies data items whose names are not unique.

« Configuration preferences for Content Assist - enable you to configure what suggestions appear in the
completion lists, whether suggestions are added in insert or overwrite mode, and the case of the
inserted words.

» Code templates - code templates are now included in the Content Assist proposals.

Code analysis

Visual COBOL now offers more advanced code analysis features and enables you to run various analysis
queries (rules and groups of rules called rule sets) against your code to ensure adherence to standards
such as standards for coding or performance.

You can run analysis rules against programs in a project in the IDE at user request or you can run analysis
rules at the end of a project's build.

Code coverage

Visual COBOL now provides support for code coverage of native COBOL applications directly from within
the IDE where code coverage uses the Test Coverage functionality. You can produce code coverage
reports for applications running in the COBOL run-time and for applications that run in Enterprise Server.

To produce reports, you need to enable code coverage in a project's, a build configuration's, or a file's
properties, compile your application and then run your application with code coverage to produce the
relevant reports. For applications that require an Enterprise Server instance, you start the enterprise server
with code coverage.
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Compiler directives

The following Compiler directives are new in this release:

EOF-1A Treats a Ox1a character in the source file as the end of file.

JVMDECIMAL Determines the type in which certain items are exposed. This directive affects
COBOL data items of type 'decimal’ and non-integral numeric items exposed as a
result of either ILSMARTLINKAGE usage or the PROPERTY keyword.

NLS-CURRENCY-  Specifies the number of bytes to allocate for the currency symbol in a PIC field.
LENGTH

NULL-ESCAPE Treats a 0x00 character in the source file as an escape character for other non-
printable characters in the source code.

The following Compiler directives contain new parameters in this release:

DBSPACE The new parameter 'MIXED' extends the DBSPACE directive to be able to evaluate data
items in programs that contain a mix of single-byte and double-byte strings.

Data File Structure command line utility

The Data File Structure Command Line (DFSTRCL) utility is a DOS-based command line utility that
enables you to create record layout (. st r) files from COBOL debug information (. i dy) files. You can use
the utility to process a single . i dy file or batch process up to 100 . i dy files.

Data File Tools (Technology Preview)

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will be
delivered at a GA level and if it is, then the functionality provided might differ considerably from this
technology preview.

The Data File Tools (Technology Preview) is a new standalone text editor in which you can create and edit
data files. By nature of it being a 'technology preview' product, it does not currently include all the
functionality that was available in the previous version of Data File Tools - now referred to as Classic Data
File Tools. If you require any of the functionality not provided in this version, you can still use the classic
version by accessing it in the usual way.

To run Data File Tools (Technology Preview), type nf dat at ool s2 from Visual COBOL's command prompt
or a terminal.

To use the new editor directly from the Eclipse IDE, use the Open with option on the shortcut menu when
selecting a data file or structure file, and select Data File Tools. Eclipse remembers the last tool used for a
particular file type, and so will use Data File Tools (Technology Preview) until you select a different editor.

Database Access

Visual COBOL version 2.3 provides the following enhancements to database access:
COBSQL Visual COBOL version 2.3 provides:

¢ Selection and configuration of the Oracle Pro*COBOL preprocessor for compiling
COBSQL applications in project properties on the SQL Preprocessor tab and in the
build configuration settings.

e Support for COBOL directives SOURCEFORMAT=TERMINAL and
SOURCEFORMAT=VARIABLE for Pro*COBOL applications.
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HCO for
DB2 LUW

OpenESQL

XA Switch
Modules

Visual COBOL version 2.3 provides:

Support for MFHCO mode across all platforms by default via the new HCO "NOHCO"
DB2 compiler directive option. See the HCO DB2 compiler directive option topic for
details.

A new DB2 compiler directive option, OPTPER "NOOPTPER", that enhances
performance for CHARSET EBCDIC processing. See the OPTPER DB2 compiler
directive option topic for details.

A new DB2 directive option, BINDDIR, which specifies an alternative directory in which
to write the DBRM file created during compilation. You can set BINDDIR from the
command line or specify it in your project properties. See the BINDDIR DB2 compiler
directive option topic, and the Binding topic for details.

Date/Time This release provides streamlined datetime processing for ODBC and
Processing JDBC.

Performance This release includes a new SQL compiler directive option, OPTPER
"NOOPTPER", that enhances performance for CHARSET EBCDIC
processing. See the OPTPER SQL compiler directive option topic for
details.

PL/I This version provides 64-bit support for PL/I on appropriate platforms.
See Additional Software Requirements for details.

PostgreSQL In this release, PostgreSQL 9.4 has been tested with OpenESQL and
OpenESQL Assistant with the following PostgreSQL software:

Server software PostgreSQL EnterpriseDB version 9.4.1-3

Client software . 1sql0DBC driver version 09.03.04.00

« JDBCA41 PostgreSQL driver version
9.4-1201

PostgreSQL 9.4 has been tested with OpenESQL on the following
UNIX platforms:

* X86-64 running Red Hat Linux, 32- and 64-bit
* X86-64 running SUSE Linux, 32- and 64-bit

Note: Micro Focus provides compatibility for PostgreSQL but
does not directly contribute to or support the PostgreSQL
open source project. Any issues relating to PostgreSQL
functionality should be addressed through an open source
support vendor.

SQL Server Visual COBOL version 2.3 provides support for the SQL Server
OUTPUT clause.

n this release, the XA interface has been redesigned to provide:

Consistent look and feel for SQL Server, DB2, and Oracle user personalization
Consistent look and feel for both RM dynamic and static registration (SQL Server, DB2,
Oracle, generic one-phase commit)

Additional support for two instances of the same switch module using Web Services
applications via the new XAID compiler directive

Using a specified XA resource only with batch applications executing under Enterprise
Server
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File handling

This release contains the following new configuration options:

ACUFH Enables or disables the use of the ACU file handler (ACUFH), which is required to handle
Vision and RM/COBOL indexed files.

ESACUFH Enables or disables the use of the ACU file handler (ACUFH) for file handling operations
running under Enterprise Server. ACUFH must also be enabled for this option to take effect.

File Locking

In versions prior to Visual COBOL 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX and
Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the tunable
strict_file_locking=true is set, which is the default setting.

Example of potential changes in behavior:

« Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

* Process-B then attempts to open the file with read-only access and a sharing mode that denies other
processes read access (SHARING WITH NO OTHER).

Withstrict_file_l ocki ng=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

Withstrict _file_l ocki ng=fal se, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result of
the new file locking behavior. In such circumstances, we recommend that you review the file locking and
sharing requirements of your application and refactor your source code to work with the default setting. The
original file locking and sharing behavior can be restored by setting stri ct _fil e_| ocki ng=f al se.

Library routines

The following library routines are new in this release:

CBL_MANAGED_SESSION_GET_USERDATA Retrieves user data saved in the current RunUnit.
CBL_MANAGED_SESSION_SET_USERDATA Sets user data in the current RunUnit.

The following library routines contain new parameters in this release:

CBL_LOCATE_FILE You can now specify a file name that is a null-terminating string, which has resulted
in three new values available for the user - rode parameter.

Managed COBOL syntax
The following enhancements have been made to the managed COBOL syntax:

e The TYPE OF type-name[ ANY. . .] syntax enables you to obtain the Syst em Type (.NET) or
j ava. |l ang. C ass (JVM) object for a generic class, interface, or delegate.
e Thesel f:: orsuper:: syntaxis no longer required to access inherited data within a subclass.

* The ATTRI BUTE- | D syntax enables you to define new attribute types, which can be used in various
contexts.

Micro Focus Unit Testing Framework

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability, but it is not intended for production use and is not supported

Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)



as such. Furthermore, Micro Focus does not guarantee that this feature will be delivered at a GA level
and if it is, then the functionality provided might differ considerably from this technology preview.
During the preview, you are encouraged to share your feedback and experiences via the Micro Focus
community forum - http://community.microfocus.com/microfocus/).

The Micro Focus Unit Testing Framework is an xUnit style testing framework, available from the command
line, for procedural COBOL applications.

It includes much of the architecture you would expect in an xUnit framework. The test runner is a 32- or 64-
bit executable that you run from a Visual COBOL shell prompt. A test fixture or suite is a COBOL program
compiled to . so that can include the setup, the test case code, and the teardown associated with the test
case.

Test results are available in a number of formats. By default, results are displayed to screen and to a . t xt
file, but you can use additional parameters on the command line to produce reports in JUnit format.

Personal edition licensing

This release includes a Personal Edition licensing option for Visual COBOL for Eclipse.

Preprocessors
Support has been added in the IDE for enabling and using multiple preprocessors with your projects.

A new page, Additional Preprocessors, has been added to the project's and the files' properties of native
COBOL applications to enable you to choose one or more preprocessors to use when building your
application and to specify their order of execution.

New reporting capability is now available for user preprocessors: resp-main code 18 indicates that a buffer
contains a data name to be marked as modified by the immediately preceding preprocessed line. The data
name may be qualified and resp-more contains the column information for the reference.

Profiler

Visual COBOL now provides support for Profiler for native COBOL applications directly from within the IDE.
To produce reports, you need to:

1. Enable Profiler in the COBOL property page for a project, a build configuration, or a file.
2. Compile your application to apply the changes.

3. Create a run configuration that has Profiler enabled.

4. Run your application with Profiler to produce the relevant reports.

Remote Connections
This release provided the following enhancements:

< An improved diagnostic tooling to help determine connection problems - enhancements are available for
both the client and the server installations.

e Itis now possible to specify the Remote System Explorer (RSE) type of connections to create remote
mainframe COBOL and PL/I projects. This is to cater for scenarios when it is not possible to use
SAMBA or NFS connections within your environment.

Note: The following features and utilities are not supported when remote projects use the RSE
connection type:

» The file layout editor and the file editor in the Classic Data File Tools and Data File Tools
(Technology Preview) utilities.

» Changing the type of a remote connection - it is now possible to change the type of the remote
connection from RSE to NFS and vice versa using the Remote Settings for remote projects.
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REST service interfaces

RESTful service interfaces utilizing JSON as the media type in request and response messages are now
supported using the Interface Mapping Toolkit. This enables you to extend COBOL applications using
modern transport payloads and protocols.

RM/COBOL Compatibility

This release includes improved support for RM dialect applications. Please consult with Micro Focus before
considering a transition from RM/COBOL to Visual COBOL.

Single file support

The recommended way to work with files within Visual COBOL is to include them in a project. For
situations where you might want to quickly open edit a single file, Visual COBOL now provides support for
native COBOL files in the IDE when the file is not opened as part of a project. There is limited support for
the IDE editing, compiling and debugging features as full support requires a project file.

Tunables

Visual COBOL version 2.3 contains the following new tunables:

putenv_interface Provides backward compatibility for UNIX systems in which the operating system's
putenv() function is required when setting environment variables.

strict_file_locking Enables a new, more reliable method of file locking for UNIX systems. See File
Locking for more information.

Visual COBOL version 2.3 contains the following updates to tunables:

default_cancel_mode A new parameter, and default, has been introduced for this tunable; see
default_cancel_mode for more information.

subsystem_cancel_mode A new parameter has been introduced for this tunable; see
subsystem_cancel_mode for more information.

Updated run-time system

COBOL Server has been updated to provide an execution environment capable of running applications that
were each built using different development products. A consequence of this is that If your application has
a main COBOL executable (. exe) that was built with a previous version of Visual COBOL, you should
ensure that the executable is rebuilt and packaged with the new run-time system. You can rebuild from the
IDE or the command line.

Other COBOL subprograms built with previous versions of Visual COBOL are not required to be rebuilt.

What was New in Visual COBOL 2.2 Update 2

Visual COBOL 2.2 Update 2 provided enhancements in the following areas:

e Eclipse

e Character Set Enhancements

* Code Analysis

« Database Access

¢ Micro Focus COBOL enhancements
» External Security Facility (ESF)

e Enterprise Server MQ-IMS Bridge

e Tunables
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Eclipse

Visual COBOL 2.2 Update 2 provides the following new functionality and improvements:

» Support for Eclipse 4.2 and 4.3 - Visual COBOL 2.2 Update 2 ships with Eclipse 3.8 but also supports
Eclipse 4.2 and 4.3 (the 32-bit IDE only). To use Visual COBOL with a newer version of Eclipse, you
need to install Visual COBOL first and then use the i nst al | ecl i psepl ugi ns scriptin/ opt/
ni cr of ocus/ Vi sual COBOL/ i nst al | er . See Installing into other instances of Eclipse for more
details.

« Remote JVM COBOL projects - this release provides enhanced support for remote JVM COBOL
projects.

* Remote project connections - the diagnosis tool for remote connection issues has been improved.
There is now a client-side diagnosis tool and a server-side diagnosis tool for diagnosing connection
problems to remote projects and connections to your Visual COBOL Development Hub. You should run
both tools for a complete diagnosis.

Character Set Enhancements

The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

e Thai Extended (0066) - new
« Korean (0082)

» Simplified Chinese (0086)

« Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and
double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Code Analysis

Visual COBOL version 2.2 Update 2 provides Dead Code analysis for COBOL programs that enables you
to find unreferenced items or any piece of code that can't be reached .

Database Access

The following new features are available in database access support:

COBSQL In Eclipse, the new KEEPCOMP directive resolves COMP/COMP-5 issues with Oracle
applications on little-endian platforms.

HCO for DB2 Visual COBOL version 2.2 Update 2 introduces GEN-HV-FROM-GROUP - a new DB2

LUW ECM compiler directive option, that generates host variables for all elementary data items
when a multiple-level group variable is used in a FETCH or singleton SELECT DB2
statement.

OpenESQL This version provides the following new OpenESQL features:

e Support for SQL Server 2014.
¢ New SQL Compiler directive options:

< DETECTDATE=SERVER - resolves host variables alignment with column data
types in an SQL table.
¢  GEN-HV-FROM-GROUP - generates host variables for all elementary data items
when a multiple-level group variable is used in a FETCH or singleton SELECT SQL
statement.
« Sample applications - the following native COBOL SQL sample applications are new
with this version:
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¢ Get Diagnostics - demonstrates how to use GET DIAGNOSTICS EXEC SQL calls
to get diagnostic information from various DBMSs.

e LOB Data Types - Demonstrates how to INSERT and SELECT LOB data in a
native application using various DBMSs.

XA switch Restriction: This feature applies only when the Enterprise Server feature is
modules enabled.

The following XA switch module updates are available in this version:
* Oracle switch module:

¢ Supports User Impersonation when statically registered.
« Enables you to specify which XA resource definitions use User Impersonation.
¢ Now compiled with one source file, rather than two.

Micro Focus COBOL enhancements
The following enhancements have been made to Micro Focus COBOL.:

e The following phrases have been added to the XML GENERATE statement:

« NAME
« TYPE
 SUPPRESS
« The following intrinsic functions have been added:
e« ULENGTH
 UPOS
+ USUBSTR
 USUPPLEMENTARY
e UVALID
« UWIDTH

External Security Facility (ESF)

The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.

Enterprise Server MQ-IMS Bridge
At Visual COBOL 2.2 Update 2 the Enterprise Server MQ-IMS Bridge was supported at GA level. It had
previously (from Visual COBOL 2.2 Update 1) been available as a Technology Preview item only.

Tunables

Visual COBOL 2.2 Update 2 includes the following new tunable:

« reduce_java_signals - specifies the options that are passed to a JVM when mixing Java and COBOL.
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What was New in Visual COBOL 2.2 Update 1

Visual COBOL 2.2 Update 1 provided enhancements in the following areas:

e Micro Focus Heartbleed Update

* ACUCOBOL-GT Compatibility

e Assembler Support

» COBOL Source Information

e Compare and Synchronization Monitor
e Compiler Directives

» Database Access

* Eclipse IDE

« Enterprise Server Integration in the IDE
» Enterprise Server MQ-IMS Bridge (Technology Preview)
* Environment Variables

* Fileshare Recovery

e Line Numbering for COBOL Programs
e IMTK

e Working with the Mainframe
 Managed COBOL

* Managed COBOL Syntax

* Project and Item Templates

* Remote Connection

¢ Rumba Integration with Eclipse

« Terminfo Files

Micro Focus Heartbleed Update

The OpenSSL library used in this product was updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

ACUCOBOL-GT Compatibility
The following ACUCOBOL-GT support has been added in this release:

-Di compiler option The -Di compiler option, which initializes Working-Storage data items based in their
type, is now supported.

Assembler Support
Visual COBOL 2.2 Update 1 provided Assembler support from within the IDE. Features include:

e Support for creating Assembler programs (. ml ¢ extension), macro files (. mac or . cpy extenstions) or
Assembler linker files (. | i n) from within the IDE.

« Support for building Assembler programs and for linking Assembler linker files from within the IDE. You
can choose to exclude certain files from the build.

* Assembler editors for Assembler and macro files - includes content assist for reserved words and
colorization.

« Support for using Ant for building .asm, .mlc and .cap files and for linking .lin files.

« IDE support for configuring the Assembler compiler and linker options on project, build configuration
and file levels.

« Configuring the macro paths.
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COBOL Source Information

The Quick Browse option is now available as a context menu command in the editor.

Compare and Synchronization Monitor

i Note: This feature is only available in a Windows environment.

With the release of Visual COBOL 2.2 Update 1, the Compare and Synchronization Monitor has been
updated to version 2.

Version 2 is greatly improved in terms of performance, especially during initial checkout of partitioned data
sets or when synchronizing a large number of members. Also, the user interface has been improved, and
some of the functions available in the old version have now changed or become obsolete.

Compiler Directives

The following Compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY- Initializes Working-Storage Section data items to a default value, according to their type.

TYPE i . : : . L C
Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized

to spaces.
« Numeric items are initialized to zero.
¢ Pointer items are initialized to null.
¢ Index items are initialized to the value 1.

Database Access

The following new features have been added as part of database access support:

DB2 ECM e Support added for DB2 LUW version 10.5.

» Enhanced RETURN-CODE processing.
OpenESQL  Enhanced internationalization support for UNICODE, DBCS and MBCS.

e Enhanced GET DIAGNOSTICS statement support.

» Enhanced LOB support for CLOB, BLOB and DBCLOB data types.

* Enhanced IDE support for OPTION directives.

» Now provides support for the creation of save points and rolling back to save points.
XA Switch Restriction: This feature applies only when the Enterprise Server feature is
Modules enabled.

* New two-phase commit module for SQL Server based on Microsoft's XA switch.

This provides support for xa_recover.

e Support for DB2 LUW version 10.5.

e Support for Oracle version 12.1.
Eclipse IDE
Assigning If the debugger steps on a line with an unassigned linkage item (for example, if you
memory to are debugging only a part of your application and no memory has been allocated to

that linkage item), debugging terminates. To assign linkage to that data item and
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Linkage Section continue debugging, you need to select the data item, right-click it and click Inspect

items COBOL. When prompted, confirm and assign a value to the data item. Alternatively,
to assign linkage, you can right-click the data item in the Variables view and click
Change Value.

Indicating thata In COBOL Explorer, you can now use two new file context menu commands to

fileis a indicate that a COBOL program is a copybook (Transform Program to Copybook)

copybook or a and that a copybook is a COBOL program (Transform Copybook to Program). You

COBOL program may need to use these in situations when you imported existing COBOL source code
in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

Enterprise Server Integration in the IDE

You can now use the context menu for the servers in Server Explorer to enable the display of the
Enterprise Server log information in the Console view.

Enterprise Server MQ-IMS Bridge (Technology Preview)

Note: At Visual COBOL 2.2 Update 1 this was provided as a technology preview feature only. It was
made available to allow you to test and provide feedback on this new capability; however, this feature
was not intended for production use and was not supported as such.

Visual COBOL version 2.2 Update 1 provided support that enables WebSphere MQ applications to
communicate with IMS applications in an Enterprise Server region.

Environment Variables
The following environment variable has been added in this release:

strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.

Fileshare Recovery
Recovery of Fileshare data files has been enhanced.
Rollback recovery is a faster process that aims to fix the files from their failed state.

This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Line Numbering for COBOL Programs

Visual COBOL version 2.2 Update 1 provided options for auto-inserting or removing line numbers in source
files open the editor. Features include:

« COBOL numbering - line numbers are inserted in the sequence area of the code (columns 1 - 6),
starting by default at 000100 at the first line, incrementing by 100 by default.

Micro Focus recommends that you use COBOL numbering only if your files are in fixed or variable
source format.

e Standard numbering - line numbers are inserted immediately to the right of area B, in columns 73 - 80,
starting by default at 00000100 at the first line, incrementing by 100 by default.
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Micro Focus recommends that you use Standard numbering only if your files are in fixed format.

* The Renumber and Unnumber commands available from the context menu in the editor.

IMTK

You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

Working with the Mainframe

Visual COBOL version 2.2 Update 1 includes the “Launch ISPF” functionality as a technical preview. This
feature is supported only under z/OS 1.13.

Managed COBOL

Visual COBOL now provides support for Java managed beans (MBean) in JVM COBOL code that enable
you to manage and monitor RunUnits, and to identify certain issues such as leaks and long-running
RunUnits.

* You can enable an MBean only for a particular RunUnit level or for all RunUnits you create.

* You can view and use MBeans from programs such as Oracle's Java Mission Control or JConsole.

* MBeans include the Logi cal RunUni t Count and Li veRunUni t Count attributes that enable a visual
indication of how many RunUnits are live. If the values of these two attributes are different, this might
indicate some issues.

Visual COBOL 2.2 Update 1 also includes the following tutorials for JVM COBOL:

Deploying JVM Using some ready-made sample projects, this tutorial guides you through

COBOL to an implementing your JVM COBOL code into an Enterprise JavaBean (EJB), then

Application Server deploying it to a JBoss application server. Instructions are also included on how
to deploy the application to WebSphere and WebLogic application servers.

Managed COBOL Syntax
Visual COBOL version 2.2 Update 1 includes the following enhancements to the managed COBOL syntax:
Specifying parameters in You can now specify passing parameters and returning items in the method

the method signature signature, instead of using a Procedure Division header. This applies to
methods, indexers, iterators, constructors and delegates.

CONSTANT keyword Use the CONSTANT keyword on a field to protect it from being altered.
Operations on string You can now use the STRING, UNSTRING and INSPECT statements on
fields fields of type string.

Project and Item Templates

Support is now available for using existing projects and files as custom templates to create new projects
and files. You create and configure projects that include the files and settings you would like to use as
templates.

Remote Connections

Visual COBOL now provides a new connection type, Micro Focus DevHub using SSH, that uses a
Secure Shell daemon process to launch a server on the remote host.

You can use this type of connection when the UNIX machine you are connecting to uses LDAP
authentication which is not supported by the DevHub daemon.
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Using this connection also means you do not need to run the DevHub daemon process with root privileges.
It also gives you greater flexibility in setting environment variables needed for building or debugging on the
remote server.

Rumba Integration with Eclipse

Visual COBOL 2.2 Update 1 provided enhanced integration with the Micro Focus Rumba application for
running and debugging Mainframe Subsystem applications that require a TN3270 emulator to run. You can
now configure Eclipse to launch a Rumba mainframe display embedded in the IDE or a mainframe session
of Rumba Desktop.

Terminfo Files
The following terminfo files have been added:

» ansi80x25 - this is based on the old ansi file. A newer version of ansi exists in this release that has no
function key support, which is consistent with ansi terminfo files on various other UNIX platforms. If you
currently use ansi and require function key support, you should instead set the TERM environment
variable to ansi80x25 to continue previous behavior.

« xterm-color and kterm-color - these are now available on all UNIX platforms - previously, they were only
available on Linux.

« aixterm-old (AIX systems only) - this has similar capabilities to the AIX OS terminfo file of the same
name. It differs from the existing aixterm file, because it has no line drawing capability. Line drawing is
only possible with aixterm if it is displayed on an appropriate display (X server).

e Vvt220-w - this is the wide (132-column) version of the vt220 file, and is based on the vt100-w file. For
more information, see Wide Terminal Mode in the documentation referenced at the bottom of this
section.

There have been a number of additions and fixes to existing terminfo files; refer to the Terminfo Database
and Terminal Devices section of the documentation for full details.

There have also been a number of terminfo files that have been removed; refer to the Backward
Compatibility section for a complete list.

What was New in Visual COBOL 2.2

Visual COBOL 2.2 provided enhancements in the following areas:

e« ACUCOBOL-GT Compatibility

« RM/COBOL Compatibility

« Application Configuration

e« COBOL Source Information (CSI)

e Compiler Directives

e Consolidated Tracing Facility

« Enhanced Accept and Display Statements

» Debugging

* Grouping Files in Virtual Folders in Solution Explorer
» File Handling

« Interface Mapping Toolkit

* Managed COBOL

e Problems View

» Upgrading from Net Express to Visual COBOL
« XML Extensions

ACUCOBOL-GT Compatibility

The following enhancements are applicable to Visual COBOL.:
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» Accessing data files through AcuServer - You can now access your ACUCOBOL-GT data files, both
sequential and Vision files, through AcuServer.

« Standard library routines - Support for the following library routines has been added:

* C$GETPID

* CS$JIUSTIFY

* CS$LIST-DIRECTORY
+ C$LOCKPID

* C$REGEXP

*+ C$RUN

* CS$SLEEP

* CS$SYSTEM

» C$TOLOWER
 C$TOUPPER
« 1310
» Using Vision files with Micro Focus Data File Tools - You can now use some of the Data File Tools
functionality with Vision files. You can:

e Convert Vision files to Micro Focus format using the Data File Converter and the DFCONV command
line utility.
- Edit Vision files using the Data File Editor.

y Note: For more information about the Data File Tools utility, see Data Tools.

RM/COBOL Compatibility
The following support has been added to Visual COBOL in this release:

e Subprograms - Support for the following subprograms (referred to as library routines in Visual COBOL)
has been added:

e C$0OSLockinfo
* C$SecureHash

e recoverl - The recoverl utility, RM/COBOL's indexed file recovery utility, is now distributed with Visual
COBOL. Refer to the RM/COBOL File Handling section of RM/COBOL Compatibility for details of its
use.

Application Configuration

You can now set environment variables for when you run native projects from within the IDE from the
project's properties - click Environment on the Application tab in the project properties.

COBOL Source Information (CSI)

COBOL Source Information (CSI) provides a quick and easy way of providing you with information about
your program when you are working on it. You enter a query in the Quick Browse dialog box and CSI
returns the results of the query in the Search view.

Compiler Directives
The following Compiler directives are new:
ACU-UNDERSCORE This directive treats underscores in COBOL words as hyphens.

ILSHOWPERFORMOVERLAP This managed COBOL-only directive generates a warning when an
overlapping PERFORM range is detected in the program.
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ILEXPONENTIATION This managed COBOL-only directive enables you to optimize exponential
arithmetic operations by specifying the calculation method used.

EXITPROGRAM This directive determines how the EXIT PROGRAM statement is
executed.

The following Compiler directives have changed

CHANGE-MESSAGE The scope of this directive has been widened to allow you to change the severity
of different types of error messages, not just syntax checking messages.

DIALECT"RM" DIALECT"RM" now sets PERFORM-TYPE"RM". If you recompile an application
that uses DIALECT"RM", the behavior may change for nested PERFORM
statements. If that is the case, explicitly set PERFORM-TYPE"MF" after
DIALECT"RM" to continue with the previous behavior.

HIDE-MESSAGE The scope of this directive has been widened to allow you to hide different types of
error messages, not just syntax checking messages.

PRESERVECASE This directive now defaults to PRESERVECASE when compiling native COBOL;
managed COBOL compilation already defaults to PRESERVECASE. This results
in externally visible identifiers preserving their case instead of being converted to
uppercase.

Consolidated Tracing Facility

The following changes have been made to the Consolidated Tracing Facility (CTF):

CTF for JVvM CTF tracing is now supported in JVM COBOL applications.

COBOL

application

New emitters A new emitter, JAVALOGGER, is available for JvM COBOL web applications. This

emitter passes details to the Java logging API that is available through your web
server. Use this emitter if you are unable to configure the TEXTFILE or BINFILE
emitters due to web server permission restrictions.

New properties The following support has been added to existing emitters.
and variables for
existing emitters

Properties The following property has been added to the BINFILE emitter:
Property Description
RunUnitID Controls whether the RunUnit information is
included in the trace.

Variables Four new pseudo-variables for the FILE property have been added to the BINFILE
and TEXTFILE emitters:
pseudo-variable Description
$(PLATFORM) A platform specific constant, useful when

two run-time systems are in the same
process, and you require separate trace files

$(RUNUNIT) A unique number that represents the
managed RunUnit ID

$(RUNUNIT_SESSIONNAME) The session name passed to the managed
RunUnit
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pseudo-variable Description

$(RUNUNIT_GUID) The globally unique identifier associated
with the managed RunUnit

Enhanced Accept and Display Statements

Two of the existing Enhanced ACCEPT and DISPLAY settings available through Adis have additional
values, which are aimed at RM/COBOL users migrating their source code to Visual COBOL. The new
values are:

« Emulation of RM/COBOL-85 style data entry for numeric data entry on ACCEPT statements.

« Emulation of an RM/COBOL backspace in free format fields when in replacement editing mode, in that
deleted characters are removed and characters to the right are shifted left, the same as when in
insertion editing mode.

For more information on how to set these values, refer to Configuring Enhanced ACCEPT and DISPLAY.

Debugging

Displaying debug You can set the DEBUG constant for managed COBOL projects on the COBOL
information for tab in the project properties. This enables you to use the

managed System.Diagnostics.Debug class in your applications to ensure they write
applications diagnostic information in the Output window for projects compiled for Debug but

not for projects compiled for Release.

Changing the It is now possible to change the display format for individual items in the Watch
display format for window in COBOL. To do this, click a row, press F2, and type: Vari abl e, h or
individual items in  Vari abl e, x to always display the values in hexadecimal format; Var i abl e, d to
the Watch window  always display the values of variables in decimal format, and of strings - as text.

Grouping Files in Virtual Folders in Solution Explorer

Visual COBOL now provides a Virtual View of a project within Solution Explorer. In the Virtual View you use
virtual folders to improve navigation by logically grouping the files that make up the project. You can also
create your own virtual folders to group files of your choice (a file can only belong to one virtual folder). The
files can be of different file types.

File Handling
New features include:

« Converting and editing Vision and RM/COBOL indexed data files using the Data File tools is now
supported.

« Access to data files (either sequential or indexed) through AcuServer is now supported.
» Access to Vision and RM/COBOL indexed data files through Enterprise Server is now supported.

Interface Mapping Toolkit

Visual COBOL now supports the creation and deployment of COBOL program-based services using the
Interface Mapping Toolkit (IMTK).

Managed COBOL

Documentation A guide that provides a basic introduction to Object-Oriented Programming (OOP) for
COBOL developers, An Introduction to Object-Oriented Programming for COBOL
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Developers, with examples is now available from the Product Documentation section on
the Micro Focus Customer Support Documentation Web site.

Named and Two new types of parameter have been introduced for use during method invocation:

optional
pzrameters Named As part of the invocation expression, you can define a value for a

parameters parameter named in the method definition. The named argument
must be specified after any positional arguments, and must not
correspond to any of those preceding arguments.

Optional Optional parameters are parameters defined with a default value in

parameters the procedure division header of the invoked method. If none of the
arguments passed in during invocation correspond to this parameter,
the default value is used in the method; if an argument does
correspond, the value that was passed in is used.

Delegates A number of new features have been added that relate to delegates and events:
and events ) ) i ) )
Note: Some of these features were also available in previous versions of Visual

COBOL.

The ATTACH and Use these statements to attach or detach a delegate, method
DETACH statements group or an anonymous method to or from an event.

The RUN statement  Use this statement to invoke a delegate once it has been

created.
Combining Use the '+' operator to add a method group, anonymous method
delegates or another delegate to a delegate, and use the '-' operator to
remove a method or another delegate from a delegate.
Method groups Use the METHOD keyword to specify a compatible method from
conversions a method group, and convert it to a delegate.

Problems View

The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. Click this column heading to sort the errors by program.

£ Problems 51 . ¥ Tasks| = Properties| 48 Remote Systems| & Console
262 errors, 0 wamnings, 0 others (Filter matched 200 of 262 items)
Descrption Resource Path
4 @3 Errors (200 of 262 items)

ZBMKELS.CBL i COBCHOD0RS Unknown copybook CABENDD spec... ZBNEEIS.CBL  /Mainfrz
SBAMNEDOIP.CBL E COBCHODOES Unknewn copybook CEANKDAT spe... SBANKDOP.CBL /Mainfrz
SBANKDDIP,CBL €4 COBCHOZ17S Preceding itemn at this level has zero ...  SBAMKDOP.CBL /Mainfs
SBANKDOP.CBL & COBCHOD0ES Unknown copybook CBAMKEXT spe... SBAMKDOP.CBL /Mainfra
SBAMNKDOP.CBL @ coBcHO2175 Preceding item at this level has zero ... SBANKDOP.CEL /Mainfrz
SBANKDOP,CEBL i COBCHOD08S Unknown copybook CABENDD spec... SBANKDOP.CBL /Mainfrz
SBAMNKDOP.CBL € COBCHO0125 Operand BANK-EMV-CICS is not dec... SBAMNKDOP.CBL /Mainfr
SBANKDOP.CBL €F COBCHOD125 Operand BANK-COLOUR-SETTIMG SBANKDOP.CBL /Main

If the column is not present in the view by default, you can add it through the Configure Columns dialog
box in the View Menu.

Support for SOA

[y Restriction: This topic applies only when the Enterprise Server feature is enabled.
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Visual COBOL now includes support for creating Web service and Enterprise Java Bean applications using
the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you are upgrading to this
release from an earlier version of Visual COBOL, you may need to apply for a new authorization code in
order to access the functionality - please contact Micro Focus Customer Care to receive an updated
authorization code. Note that the Visual COBOL Personal Edition license does not support the IMTK
functionality.

Upgrading from Net Express to Visual COBOL

A new section in the product help, Upgrading from Net Express to Visual COBOL for Eclipse, provides
guidance on how to move existing applications either developed or debugged in the Net Express IDE into
the Eclipse IDE.

XML Extensions
You can now use XML Extensions in your managed COBOL projects.

Use XML Extensions to import and export XML documents to and from COBOL working storage.
Specifically, XML Extensions allows data to be imported from an XML document by converting data
elements (as necessary) and storing the results into a matching COBOL data structure. Similarly, data is
exported from a COBOL data structure by converting the COBOL data elements (as necessary) and
storing the results in an XML document.

While importing or exporting data to or from XML documents, you can apply XSLT transforms to the data
by using XSLT stylesheets.

For more information, refer to the XML Extensions User's Guide.

What was New in Visual COBOL 2.1 Update 1

Visual COBOL 2.1 Update 1 provided enhancements in the following areas:

e Compiler Directives

« DB2 ECM

e Enterprise Server

¢ Mainframe Compatibility

* Debugging Enhancements

Compiler Directives

You can now set SQL Compiler directives and their values more easily, using a table of tick boxes in a
project’s Properties dialog box.

DB2 ECM

e Support for 64-bit compile and runtime
e Support for DB2 10.1
« New DB2 SQL compiler directive option, BGP, to enable background parsing

Enterprise Server

The following new features and enhancements are available:

Clustering COBOL Server Clustering allows the scaling-out of work units, so that an
increased number of operating system images can share the workload, resulting
in high-performance, multi-system data sharing across all platforms.
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Historical Statistics  The Historical Statistics Facility has been extended to include the generation of
Facility JCL file records, increasing the amount of information customers have available
to assist them in monitoring and tuning their COBOL Server installations.

Recovery of in-doubt Some events in XA environments can result in ‘in-doubt’ transactions, where all

XA transactions parts of a composite transaction are not committed through all participating
resource managers. The recovery of such in-doubt transactions is now
supported.

SSL Support for the  COBOL Server now allows clients and servers to identify themselves through X.
CICS Web Interface 509 certificates and participate in SSL-enabled conversations.

Mainframe Compatibility

is compatible with IBM System z9 mainframe hardware and later.

Debugging Enhancements

You can create a breakpoint for any program in the workspace that your application uses by clicking Run >

Add Program Breakpoint, or clicking the ( icon in the Breakpoints view, and entering the name of the
file.

What was New in Visual COBOL 2.1

Visual COBOL 2.1 provided enhancements in the following areas:

e ACUCOBOL-GT Data Types in Managed Code

* ACUCOBOL-GT Library Routines in Managed Code
e Compiler Directives

e .int, .gnt and .Ibr File Types Support

¢ Just-in-time Debugging

* Managed code enhancements

* OpenESQL

e UNIX Platforms Support

« Automatic Directives Detection and Setting

ACUCOBOL-GT Data Types in Managed Code

ACUCOBOL-GT data types and sign() variants that were previously only available in native code are now
supported in managed code. Use the Compiler directives COMP1 and COMP2 to set ACUCOBOL-GT
behavior for those particular data types.

ACUCOBOL-GT Library Routines in Managed Code

ACUCOBOL-GT library routines that were previously only available in native code are now supported in
managed code.

Compiler Directives

The following new Compiler directives are now available:

DISPLAY Defines the default behavior of standard DISPLAY statements.
COMP1 Specifies the behavior of a COMP-1 data item.
COMP2 Specifies the behavior of a COMP-2 data item.
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RESTRICT-GOTO Generates a syntax error for GO TO statements that transfer control to outside of
the current section.

ILSMARTRESTRICT Limits the generation of properties in ILSMARTLINKAGE classes to non-redefining
elementary items.

The following Compiler directive has changed:

+ DATAMAP - Two new parameters allow you to display either the address or offset values for data items
in your program.

.int, .gnt and .1br File Types Support

Support has been added within the IDE for compiling native COBOL applications to the Micro Focus legacy
formats . i nt and . gnt, and to package these files as a Micro Focus library file (. | br). Improvements
include:

« An option to compile all native COBOL projectsto . i nt and . gnt code. You can set this in your
project's properties.

< An option to package the . i nt and . gnt files produced by the project as a Micro Focus . | br library
files.

« Improvements to the Net Express Project Import wizard that enable you to convert existing Net Express
projects to Visual COBOL projects that compile to . i nt and . gnt code.

Just-in-time Debugging

Visual COBOL now supports "Just-in-time" debugging: when a run-time error occurs, or an application calls
CBL_DEBUGBREAK, the IDE can start automatically with the debugger attached to the failed process.

Managed code enhancements

Delegates Delegates and events are now implemented on the JVM platform.

and Events This release provides support for combining delegates, using the METHOD keyword to

specify method groups, and implicit conversion from a method group or an anonymous
method to the suitable delegate type.

Handling The handling of invalid numeric data is controlled by a number of Compiler directives:
Invalid HOSTNUMMOVE, HOSTNUMCOMPARE and SIGNFIXUP. These directives were
Numeric previously only available in native code but are now supported in managed code.

Data

Resolving In this release, the Compiler attempts to resolve types to those defined in the current
Types compilation unit wherever possible. The Compiler will attempt to resolve such types to an

external name only if no suitable type exists in the current compilation unit. For example:

$set il using" Systent

cl ass-id MyNanespace. Event Handl er .
01 o type Event Handl er.

end cl ass.

In this release, 01 o type Event Handl er. resolves to
MyNanespace. Event Handl er and not to Syst em Event Handl er.

Specifying  In previous versions of the products, properties declared using the PROPERTY keyword

Properties  on a data item were generated as final properties. Starting with this release, they are
generated as virtual properties by default. In order to make the properties final, you need
to specify the word FINAL following PROPERTY. This change may affect the generation of
Proxy classes, for example, if you are using WCF.
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OpenESQL
JDBC JDBC has been enhanced to support two new directives:

JNDI Enables you to specify a JNDI class that looks up connection strings.

JNDIENC Enables applications to use the JNDI Environment Naming Context
(ENC) when looking up JDBC data source names using JNDI.

ODBC Added support for a generic one-phase commit for ODBC XA switch module.

SQL Compiler OpenESQL has been enhanced to support the following new SQL compiler directive
Directive options:

Options
P DATE Controls the reformatting of date values in output parameters and in

input parameter character host variables when DETECTDATE is also
specified.

TIME Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
used.

DATEDELIM Specifies a single character as the delimiter between the year, month,
and day components to override the default delimiter determined by
the HCOSS DIALECT or DATE directive specification.

TIMEDELIM  Specifies a single character as the delimiter between the hour,
minute, and second components to override the default delimiter
determined by the HCOSS DIALECT or TIME directive specification.

TSTAMPSEP Specifies a single character as the separator between the date and
time parts of timestamp and date/time data.

OpenESQL OESQL Assistant now supports updateable cursors.
Assistant

SQL Server We now support Microsoft SQL Server 2012.

UNIX Platforms Support

Support for remote development and deployment of projects has been added for the Linux/390 platform.
Development Hub now supports Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2.

Automatic Directives Detection and Setting

The IDE automatically determines and sets the COBOL dialect, and the CICS and SQL directives on local
or remote native COBOL projects. You can also start a directives scan from within COBOL Explorer - select
Determine Directives from the context menu for the projects or the COBOL source files. This triggers a
scan to determine the COBOL dialect, the CICS and SQL settings, and sets them as Compiler directives
on a file or project level respectively. At the end of the scan, you view the results and choose to apply the
changes.

What was New in Visual COBOL 2.0

Visual COBOL 2.0 provided enhancements in the following areas:

« Automatic Directives Detection and Setting
e COBOL Explorer view

* COBOL File Search

e Compiler Directives

« Compiling Single Files
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« Enhancements to Developing Applications on a Remote Machine
e Copybook Context

» Debugging Enhancements

e Eclipse 3.7

* JVM COBOL File Handler

» Library Routines

« Managed COBOL Language Features

» Data Access

* Remote COBOL JVM Projects - Early Release
* Run-Time Tunables

e Samples

« Vision Data File Searching

Automatic Directives Detection and Setting

It is now possible to automatically determine and set the COBOL dialect and SQL directives on native
COBOL source code. In the COBOL Explorer, select Determine Directives from the context menu for the
projects or the COBOL source files. This triggers a scan to determine the COBOL dialect and SQL settings
and sets them as Compiler directives on a file or project level respectively. At the end of the scan, you view
the results and choose to apply the changes.

This feature works with local or remote native COBOL projects only.

COBOL Explorer View

Visual COBOL now includes the COBOL Explorer view in the Eclipse IDE. This allows you to navigate
around COBOL projects in a more useful and convenient way than Eclipse's own Navigator view.

The COBOL Explorer view includes the following features to help you manage your projects:

« For COBOL Project, Remote Project, and Mainframe Project types, COBOL Explorer adds category
folders that automatically group together your project's COBOL programs, copybooks, and output files.
(These folders are not physical folders on the disk, but effectively headings for certain file types.)

« To simplify navigation around your project, you can hide some files that are part of the project, such as
the . cobol Bui | d, . cobol Proj, and . proj ect files, and the . set ti ngs folder and its content in
JVM projects. You do this by opening the view menu, selecting Customize View and choosing from the
options.

Filters Choose types of content to hide in COBOL Explorer.

Option Description

*resources Any files of type . * such
as .cobolBuild, .cobolProj

Closed projects Resources in closed projects never display, but
you can choose to hide all closed project icons
T too

Empty folders inside COBOL categories Folders mapped to the COBOL Programs and

Copybooks that contain no COBOL program or
copybook files

Non-COBOL projects Projects of types other than those under Micro
Focus COBOL - for example AspectJ, Plug-in, or
Update-site projects

RSE Internal projects Projects generated by the RSE plug-in
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Content Choose types of content to show in COBOL Explorer.

Option Description

Working Sets Working sets are subsets of workspace
resources you can choose to show or perform
options on. To define a working set, click Project
> Build Working Set > Select Working Set >
New.

COBOL Elements Non-resource types that are COBOL-specific:

1. x

2. category folders, including those for COBOL
programs and copybooks

3. icons for the different types of COBOL files.

4. overlays for build errors and warnings

5. some context menu items

Resources COBOL projects, COBOL programs and
copybooks. Has effect only if the COBOL
Elements option is unchecked.

COBOL Explorer helps you fix problems by using icons to identify files and containers that cause build
errors and warnings.

< Afile that generates a warning, and any containing folders and categories, is marked with a yellow
warning sign. For example:

4 9 SmartEditing
a4 @ COBOL Programs
4 = folder
4 [ nested
(2] Programd.chl
' Programb5.chbl

« Afile that causes an error, and any containing folders and categories, is marked with a cross. In this
example the icons indicate the most severe problem is the error caused by Progr amt. cbl , and the
folders are marked with error icons despite Pr ogr anb. cbl generating a warning:

4 {39 SmartEditing
a4 E@ COBOL Programs
4 [z folder
4 = nested
- @ Programd.chl
- {1 Program5.chbl

* A project that suffers from a dependency error is marked with a red exclamation mark; its contents
remain unmarked. In this example the project depends on another project that is closed, causing a
build path problem:
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4 19 SmartEditing
4 (18 COBOL Programs
4 (= folder
4 = nested
- @ Programd.chl
- 1@ Programb5.chl

Also, the context menus are reorganized and include some additional tasks such as the Determine
Directives command.

You access COBOL Explorer in the same way as other Eclipse views, by selecting Window > Show View.

COBOL File Search
Visual COBOL now includes the COBOL File Search feature in the Eclipse IDE.
You can use the Micro Focus search feature to make it easier to find files within your projects:
» Select Search > Micro Focus, and type the file search pattern.
You can filter results based on:

« File type: choose from COBOL programs, copybooks.
* Only those files that cause build errors.
* Only those files that cause build warnings.

You can control the scope of your search:

*  Workspace - searches entire workspace.

« Selected resources - searches only the resource currently being edited or highlighted in the tree
view.

* Enclosing projects - if the editor is focussed on a resource or resources are highlighted in the tree
view, then the search is within the entire project containing the resources.

< Current program - searches the resource currently being edited, as well as within any copybooks
used by the resource.

« Working set - see Working Sets for more information.
* Select Search > Run Stored Micro Focus Search Query and choose to find either:

e Only those files that cause build errors.
* Only those files whose properties override the project's properties (for example Language dialect or
Compile for debugging settings).
Whichever way you use the Micro Focus search the results are shown in the Search view.

After you have performed a search you can edit the properties of any of the program files listed in the
search view. You can even simultaneously edit the properties of multiple program files which have
compilation settings available on them, that is program files rather than copybooks. Highlight the files you
want to change, right-click Properties, and then check Enable file specific settings. Change the file
properties as required and then click OK.

You can save your search criteria and give it a label which is added to the list of stored queries available
when you select Search > Run Stored Micro Focus Search Query:

1. In the Search tab, click =] save the Current Search.

This opens the Add Micro Focus Search dialog box.
2. In the Search label field, type a search label.

* You can assign a keyboard shortcut by typing the required keystrokes in the Binding field.
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« Optionally, you can modify the current search criteria.
3. Click OK.

The search label is added to the list under Search > Run Stored Micro Focus Search Query.
You can also add, edit, and remove your searches from Window > Preferences > Micro Focus > Search.

Note: Do not open the Keys preferences page (Window > Preferences > General > Keys) while
editing the binding in the Search preferences page. Opening the Keys preferences page will prevent
any changes you make to the search bindings from being saved.

Compiler Directives
The following new directives are now available:

« COPYSEARCH - enables you to specify how copybooks are located. You can choose between usual
Micro Focus COBOL behavior or usual RM/COBOL behavior.

e |ILSMARTNEST - enables you to nest ILSMARTLINKAGE classes inside the program class in which
they are defined. This makes it possible to have multiple programs in a single compilation unit that
include linkage records with the same name.

The following directives have been changed:

« DIALECT(RM) - now accepts a new parameter, RM, which enables the RM-compatible functionality that
the RM directive used to enable.

¢ ILREF - can only specify a .class as a parameter, and not a .jar file or other file types.

» ILUSING - when set on a single file using the SET statement, $set i | usi ng, the directive only affects
that file.

Compiling Single Files

It is now possible to compile individual COBOL source files without rebuilding your entire project. Build
Automatically on the Project menu must be turned off.

Enhancements to Developing Applications on a Remote Machine

Previously, this product depended on Samba or NFS to transfer and manage the project files on a remote
UNIX machine. Remote Server Explorer (RSE) was only used to build the applications on remote
machines.

"Remote file system (RSE)" is now the default option in the Create Remote COBOL project wizard for
managing the files of remote COBOL projects. RSE establishes a connection with the remote machine and
is used to transfer and manage the project files on it.
, Important:
* You must use SSH connection and not DStore for remote COBOL projects created with Remote
file system (RSE).
* You can still use Samba and NFS as file system providers. On system where SSH is not allowed,
you can use SAMBA and DStore connection to transfer and manage the files on the remote
system.

Copybook Context

When you view or edit a copybook, you need to see it in the context of the program that references it, as its
appearance and usage can change depending on the program. For example, data items that are not used
in the program are struck through, and horizontal lines indicating the start and end of code lines can show
depending on the source format of the program. The Program Outline view can differ between contexts too.
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A breadcrumb trail at the top of the Editor indicates which program and copybooks are the current context -

click Toggle Context Breadcrumbs Fin the Eclipse toolbar and use the drop-down list to view and open
the dependent copybooks.

L~ @ 5~ |§I33 1 - - =l
[T book-rec-jper.cpy | BookWrapper.chl E3

f BookWirapper.chl b
""I*F'-'l'B' .

A [El] book-error-codes.cpy

[El] book-rec-jerm.cpy

* ¥

Copyr

* _E

This sample code is supplied for demonst

Debugging Enhancements

Visual COBOL 2.0 provides the following enhancements to debugging:

Program Note: Program breakpoints are supported in native COBOL only, and are not
Breakpoints supported with nested programs.

You can now set program breakpoints, which break into a program whenever it or
one of its entry points is called.

To set or toggle a program breakpoint, double-click in the left margin, next to the
Procedure Division heading. The (&} icon appears when the program breakpoint is

set.
Step out of OSVS  You can now step out of a perform statement when PERFORM-TYPE(OSVS) or
perform DIALECT(OSVS) is set.
statements
Eclipse 3.7

Visual COBOL 2.0 uses Eclipse 3.7.1 Indigo.

JVM COBOL File Handler

Use the JVM COBOL File Handler, a File Handler written in purely JVM COBOL managed code, when you
are deploying to environments that do not allow the use of native code such as the default Micro Focus File
Handler.

Library Routines
The following CTF library routines are now available in COBOL for JVM:
CBL_CTF_COMP_PROPERTY_GET
CBL_CTF_TRACE
CBL_CTF_TRACER_LEVEL_GET
CBL_CTF_TRACER_GET
CBL_CTF_LEVEL
The following routine has been enhanced:

e« The CBL_SEMAPHORE_ACQUIRE routine now accepts ati neout parameter.
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Managed COBOL Language Features

The following new syntax elements are now available in managed COBOL:

Local In managed COBOL, Data items can now be declared in the procedure division, using

Variables the DECLARE statement. In addition, they can be declared inline as the iterator in a
PERFORM statement, or as an exception message in a TRY ... CATCH ... FINALLY
statement block.

Collections There are two new collection types in managed COBOL: LIST and DICTIONARY. For a
LIST, you can add elements to a list, retrieve the nth element of the list, replace the nth
element, iterate through the list and clear the list. For a DICTIONARY, you can add key
value pairs, retrieve a value corresponding to a key, to replace the value corresponding
to a key, iterate through the dictionary and clear the dictionary.

Properties In managed COBOL, a property can now be defined using PROPERTY-ID and GETTER
and SETTER phrases to access to the property. The previous technique of specifying
the keyword PROPERTY on a data declaration is still available.

Indexers In managed COBOL, an indexer can now be defined using INDEXER-ID and GETTER
and SETTER phrases to access the indexer value. Indexers are similar to properties,
except that their accessors take parameters. Indexers allow instances of a class or
valuetype to be indexed just like arrays.

Zero-based The managed COBOL syntax for arrays now uses zero-base indexing to access arrays
Indexing when square brackets are specified. For backward compatibility, one-base indexing is
used when round parentheses are specified.

The Help now contains code examples comparing managed COBOL and Java.

Data Access
Visual COBOL version 2.0 provides the following enhancements:

« Improved IDE integration with SQL directives - now supports handling of deprecated and removed
directives. Also supports filtering of the choices offered to the user by product type, project type, and
platform.

e OpenESQL has been enhanced and it now:

« defaults to optimal performance
e supports 64bit ODBC across all platforms
e OpenESQL now supports JDBC across all platforms

Remote COBOL JVM Projects - Early Release

You can use Eclipse to develop COBOL JVM projects on a remote UNIX/Linux machine. The source code
resides and is being compiled and debugged on the remote machine.

Run-Time Tunables
Visual COBOL 2.0 provides the following new tunable:

» subsystem_cancel_mode - use this to override the default cancel mode when you use the
CBL_SUBSYSTEM library routine to cancel a subsystem.

Samples
The following new samples are now available:

» Collections - demonstrates the managed COBOL collections syntax
« Local Variables - shows how to declare data items in the procedure division in the DECLARE,
PERFORM and TRY statements
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* The code in the Properties sample has been enhanced to use the new PROPERTY-ID syntax. The
sample also includes a sample program for Indexers which illustrates the new INDEXER-ID syntax.

Vision Data File Searching

Visual COBOL 2.0 provides the following new ACUCOBOL-GT compatible environment variables to help
search for Vision data files at run time:

APPLY_FILE_PATH
FILE_CASE
FILE_PREFIX
FILE_SUFFIX

What was New in Visual COBOL 2010

Visual COBOL 2010 provided enhancements as part of the following releases:

* New Features in Enterprise Developer 2010 R4 Update 2
* New Features in Enterprise Developer 2010 R4

New Features in Visual COBOL 2010 R4 Update 2

New Platforms Support
Support for Visual COBOL for Eclipse has been added for the following platforms:

e X86-64 running Red Hat Enterprise Linux 5.7/6.1
e X86-64 running SUSE SLES 11 SP1

Support for Visual COBOL Development Hub has been added for the following platforms:

* x86-64 running Red Hat Enterprise Linux 5.7/6.1
e SPARC running Solaris 10
* x86-64 running SUSE SLES 11 SP1

Support for COBOL for JVM has been added for the following platforms:

HP 1A 11.31 - 32/64-bit
x86-64 running Red Hat Linux 5.6/6.1 - 32/64-bit
SPARC running Solaris 10 - 32/64-bit

OO COBOL Class Library Reference

Help for the OO COBOL class libraries are available from the Micro Focus Customer Care Web site, as
follows:

1. Go to the Server Express documentation, at http://supportline.microfocus.com/documentation/books/
sx51ws02/sx51indx.htm.

2. Click Reference > OO COBOL.
3. Expand OO COBOL Class Library Reference.

Features Added in Visual COBOL 2010 R4

ACUCOBOL-GT Compatibility

The Compiler and run-time continue to provide support for ACUCOBOL-GT. The directive ACU is the main
switch for turning on ACUCOBOL-GT compatibility. The ACU directive enables various ACUCOBOL-GT
syntax extensions and other language elements. Additional ACUCOBOL-GT compatibility features include
the following:
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* When using a CALL statement, the USING and GIVING/RETURNING phrases can now appear in either
order.

* The following ACUCOBOL-GT standard library routines can now be used with Visual COBOL in native
code:

¢ C$CALLEDBY
+ C$CALLERR

+ C$CHDIR

+ C$MAKEDIR
« C$MEMCPY
+ C$SMYFILE

+ CS$PARAMSIZE
*+ C$RERR

* MS$ALLOC

* MS$FREE

* M$COPY

* MSFILL

« MS$GET

* MS$PUT

*  WINS$VERSION
e The following ACUCOBOL-GT 'cchl' compiler options can now be used with Visual COBOL:

e -E, -V

e -Cv

e -Da, -Db, -Dd31, -DL1/2/4/8, -Dq, -FpRounding
e -La, -Li, -Lc, -Lf, -LI, -Lo, -Ls, -Lw

Note: The output that these list options provide differs in Visual COBOL.
. _Qm
* -Rc, -Rn, -Rw
* -Sa, -St, -Sd, -Sp, -S1...-S9
¢ -noTRUNC, -truncANSI, -Dz
+ -Td,-Te
« -Vc
e -Za,-Zc, -4, -Zn, -Zs, -Zi, -Zr1, -Zy, -arithmeticVSC2

Full ACUCOBOL-GT compatibility is documented under the Programming section in the product help.

COBOL for Java Virtual Machine (JVM) Support

In this release you can compile COBOL applications to JVM byte code (. cl ass files) so that they can be
run on a JVM. There is support in the IDE to edit, compile and debug JVM COBOL applications. This
release includes Managed COBOL - COBOL with extensions to support the JVM framework plus OO
syntax support.

Features include support for
* New managed COBOL syntax:

« The SYNC statement, which marks a statement block as a critical section by obtaining the mutual-
exclusion lock for a given object, executing a block of statements, and then releasing the lock.

» Extension methods, enabling you to extend an existing class with new methods without the need to
recompile the existing class

< Java style inner classes, which define a nested class within another class. These follow all the
methods belonging to the containing class.

* The STATIC keyword, enabling you to mark methods and data as static.
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« Enumerators, which represent a list of constant values. You can declare an enum type that defines
the values and symbolic names for them, and refer to the values by name in your code.

e Seamless interoperation between COBOL compiled for JVM and COBOL compiled for Java code

e The ability to add Java projects to the classpath for COBOL JVM projects, and COBOL JVM projects to
the classpath for Java projects

« Red Hat, AlX and SUSE platforms

Embedded HTML

We now support the use of Embedded HTML (EHTML) in COBOL CGI programs, which enables you to
output HTML directly from your applications.

Improved Usability

The following improvements to COBOL development in Eclipse have been made:

Dialog box improvements The dialog boxes governing build configuration, debug configuration,
and launch configuration are redesigned to make them easier to use.

Autocompletion and Content The IDE now includes autocompletion and content assist editing
Assist features.

Language Improvements

The following improvements have been made to managed COBOL:

Extension methods Managed COBOL now supports extension methods. This feature enables you to

and extending add methods to existing types without the need to edit or recompile the code. You
operators can also extend operators.

The SYNC modifier The SYNC modifier locks the values of the arguments sent to the method, so that
for methods they do not change while the method is processing.

Nested classes In managed COBOL, a nested class can now be defined so that it can access the

instance fields, properties and methods in its containing class. To allow this, you
add the optional SHARING PARENT phrase to the nested class definition.

Renamed Color Preferences

The COBOL Editor syntax-coloring scheme called "Micro Focus Net Express" is now called "Micro Focus
Traditional".

The syntax-coloring element called "Identifiers" is now called "Identification Division Names".

Any existing settings for these options will not change.

Reporting of Linker Errors

Errors relating to linking, such as undefined entry points and libraries not being found, are now logged in
Eclipse's Problems view.

RM/COBOL Compatibility

The Compiler and run-time continue to provide support for RM/COBOL. Additional RM/COBOL
compatibility features include the following:

« The following RM/COBOL standard library routines can now be used with Visual COBOL in native code:

« C$Century
* C$ConvertAnsiToOem
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* C$ConvertOemToAnsi

+ C$DARG
* C$Delay
e C$GetEnv

+ C$GetNativeCharset

+ C$LogicalAnd

* CS$LogicalComplement
e C$LogicalOr

» C$LogicalShiftLeft

» C$LogicalShiftRight

+ CS$LogicalXor

« C3NARG
+ C$SetEnv
* C$RERR
e DELETE
« RENAME

* The RM/COBOL file handler can now be used with Visual COBOL, enabled by using the
CALLFH(ACUFH) Compiler directive, and then configuring an add-on to the Vision file handler.

Full RM/COBOL compatibility is documented under the Programming section in the product help.

XML Extensions
i Note: This functionality is supported in native COBOL only.

You can now use XML Extensions, the system that enables your COBOL applications to interact with XML
documents, with Visual COBOL.

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
RM/COBOL product documentation set, in the Customer Care section of the Micro Focus Web site.

Significant Changes

This section describes significant changes in behavior or usage in each successive release. These
changes could potentially affect the behavior of existing applications or impact the way the tools are used.

Significant Changes in Visual COBOL 7.0

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

* Application Workflow Manager

e« Common Communications Interface
e Compiler

« Data Tools
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Eclipse IDE

Enterprise Server

File Handling

Header-to-COPY Utility

Interface Mapping Toolkit

Licensing requirements

Reverse Debug and Live Recording
Run-time System

SQL: OpenESQL

Application Workflow Manager

Back to the list

The checkout tool has been extend with the new input parameter "Resource Depth" which indicates
how the checkout will be performed. Allowed values are:

5 Infinite (all files and folders are check out recursively).

4 Immediate (direct files and empty folders are check out).

3 File (only files are check out).

2 Empty (the selected resource is check out without content).

See Checkout in your product Help for more information.
00486821 (71096)

The ChangeMan attachment model now enables you to define job cards by a context menu action on
the application level. The action "Set Job Cards" is provided under the group "Quick ChangeMan
Access". If job cards are set, they are used in ChangeMan actions which submit a job, for example, the
build action.

(10698)

There are now new import/export functions available in the filter definitions view. The import/export
functions are available as context menu and tool bar actions.

00371941 (13136)

The Endevor attachment model now displays an error message when an attempt is made to open a
nonexistent element for editing.

3221338 (12418)

Common Communications Interface

Back to the list

The default TLS Security Level has been increased from 0 to 1. This change will not affect you if you
have specified your own security options.If you rely upon the default TLS security options you might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See Security Levels and Specifying a Server Protocol and Cipher Suite Preference in your product Help
for more information on the change to Security Level 1.

(8453)

Compiler
Back to the list

Programs with file records greater than the documented limit of 62KB will now generate an error that
they previously did not (COBCHO0649) - although being an E level message, the program can still be
executed and will work if it did so previously.
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3227892 (12447)

« Two of the available Ant parameters for compiling COBOL programs have been renamed as follows
(functionality remains the same):

» forceCompile becomes mf.forceCompile
» threadCount becomes mf.buildThreadCount

3230709 (12665)

Data Tools
Back to the list

« The editor now automatically selects the first record in comparison when first loaded. The Editor will
automatically select first record in comparison when first loaded

3212848 (11362)

« Data File Tools now provides the Data Explorer, which is a catalog view that can connect to either
ESMAC or ESCWA. When connecting to ESCWA, it enables you to open multiple data sets.

(70242)
» The scrolling speed for formatted records has been increased.

00366018 (11378)

Eclipse IDE
Back to the list

« In Server Explorer, the "associate with project” option is not longer available for remote servers. Remote
servers are defined as any belonging to a remote directory server or remote ESCWA.

(57093)
« The Format Program option is no longer available for projectless files. Instead, select the Format option
and the text you want to format.

(8743)

e Customers using Eclipse on Windows who connect to a Development Hub on UNIX can now create
remote unit test projects. Remote unit test projects are available for native COBOL when you use a
Samba or RSE connection to the DevHub.

3164533 (13318)
« Within a debug configuration for a remote project, you can now specify source files and debug symbol
files that reside on remote hosts other than the one containing the remote project.

00363627 (12609)

* When starting a server from Server Explorer, if that server is unsecured, you are not prompted to add
any credentials.

(62136)

Enterprise Server
Back to the list

* Previously, there was no security check performed when an ESMAC user tries to access the console,
traces, or dumps. This is no longer the case. If you use LDAP-based security you can now add the new
DIAGS resource under OPERCMDS class and provide access to ESMAC users accordingly.

3231918 (12556)

« The "Requested Licenses" field has been removed from the ESCWA General Properties page as it is
not used.

(3956)
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Added the option to delete the associated package when the service has an associated package and
that service is the only one with that associated package.

00370971 (22264)

When a new region is created in ESCWA, the Web listener's conversation type is now correctly set to
"Web" instead of "SOAP and J2EE (legacy)".

3244594 (21270)
The Group can now be specified when starting or stopping a region using ESCWA.

00371543 (12436)

In ESCWA, the Security Manager properties could be set too long, causing a crash. This has now been
fixed.

(61192)

This fixes an issue with the change to the behavior introduced with the passtoken changes in previous
patch updates. An issue might occur in a stacked environment with OS ESM and MLDAP_ESM. Job
dispatch would issue a deny when cassub was used.

3229601 (11524)

An issue when using a secured MFDS, with an LDAP ESM as first in the stack, and a PAM ESM as
second in the stack, and with federation enabled, has been resolved.Previously, if the security was
reinitialized through any means (such as clicking the apply button, or reordering the ESMs and
changing them back), the MLDAP ESM would not be able to correctly determine that the PAM ESM
user userl in groupl matched the LDAP resource rule which described groupl within the resource rule.
This should have worked because the group information is shared when federation is enabled.With this
fix, the resource rule in LDAP correctly identifies that the groupl rule applies to the PAM ESM user
userl, on both initialization and reinitialization.Behaviour Change:When SAFMGR was reinitialized,
PAM ESM was pointing to the old shared groups table, so MLDAP ESM and PAM ESM ended up
pointing to different shared groups tables. It should have been the same table as federation was
enabled.PAM ESM groups table is now cleared on initialization, so that the ESMs will now point to the
same groups table.

3221760 (11697)

ESMAC now includes cross-site request forgery protection. A 403 Forbidden page is how returned
whenever a user attempts to bypass the protection. If you want to access more than one region in
ESMAC at the same time, it can no longer be done in the same browser session. You can access the
regions in separate private browsing sessions.

3216052 (13208)

A new resource class, DCBINFO, enables you to control who can access the DCB information for
cataloged datasets in ESMAC for a LDAP secured region. DCBINFO must be created for existing users
to be able to access the DCB information in ESMAC.

3231918 (13300)

We now take note of VALUE clauses for fields and properties defined in a JVM attribute (annotation),
and output the default value to the class file. When using an attribute, any field that does NOT have a
default value must now be specified explicitly.

(30021)

MQ commands did not work because Windows installations of MQ are client, not server. This has been
ccorrected.

(46022)

MFDS now correctly uses the specified region user in the ESCWA Directory Server Scripts page or
Directory Server user in the ESCWA Directory Server Configuration page. Otherwise, it defaults to the
current user.

(8727)
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« If MFDS is set to "Restricted Access" and the MFDS "Anonymous access" option is off (the default),
then valid authorized credentials will be required to access information stored in the Directory Server
either via the legacy Ul, ESCWA, or utilities such as mdump.

(62100)

« When MFDS is TLS enabled and a client connects on the non-TLS port, it will now send a HTTP 302
Found response to the client to redirect it from the non-TLS port to the TLS-enabled port. This is
seamless to the Web browser.

(46024)

File Handling
Back to the list

« Within MFDBFH, enhancements have been made to optimized I/O to further improve
performance.Enterprise Developer 6.0 and Enterprise Developer 7.0 only: The dbfhconfig utility has
been enhanced with the addition of the -optiokeyreads and -optioseqreads command-line options.
These options are used to override the default number of records read ahead by MFDBFH when
optimized I/O is enabled.

00726932 (83019)
* The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (12477)

* A File Handler limit on the maximum record size (62KB) has resulted in the documented limits for data-
driven unit tests to be revised. See Restrictions in the Micro Focus Unit Testing Framework.

(25064)

Header-to-COPY Utility
Back to the list

* When h2cpy is used to convert C header files to COBOL copy files, function prototypes with const *,
which produce BY REFERENCE parameters in the ENTRY statement for the COBOL call prototype, will
now include the CONSTANT reserved word. In this context, it means the variable is read-only in the
callee, just like in C.

(10214)

Interface Mapping Toolkit
Back to the list

« Headers are no longer mapped in the output of WS2LS.

3235120 (12606)
« Top-down CWS generation from WSDL now properly marks hexBinary fields in the generated WSBIND.

3236069 (11690)

*  WS2LS now assigns usage COMP-3 to items mapped from decimal and integer types in the
WSDL.Behaviour Change:WS2LS will now assign usage COMP-3 to items mapped from decimal and
integer types in the WSDL. This will affect the generated copybooks and WSBIND. Previously-
generated files will still work, and users should be using the WSBIND and copybooks from a single
execution of WS2LS in their environment anyway, since changing one results in (or reflects) changes to
the other.

3235120 (13494)

« In copybooks generated by WS2LS, several data types now have mappings that are closer to those
generated by IBM's DFHWS2LS.Behaviour Change:In copybooks generated by ws2ls, several data
types will now have mappings closer to those generated by IBM's DFHWS2LS.
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Licensing requirements

Back to the list

« The following platforms - Solaris, Red Hat on IBM Z System, SUSE on IBM Z System, and Ubuntu - are
now licensed using a new licensing model called AutoPass. These platforms and licenses are not
available from the Software Licenses and Download portal (sld.microfocus.com) if you are using the
existing SafeNet license technology. To obtain AutoPass licenses for the aforementioned platforms,
contact your account manager to discuss your actual requirements, and also raise a support incident to
track the request.

Reverse Debug and Live Recording
Back to the list

* Reverse Debug and Live Recording functionality is licensed and installed separately from undo.io. From
this release forward, you can enable reverse debug functionality by downloading the extension from the
Micro Focus Marketplace.

Run-time System
Back to the list

* When defining the file name for CBL_CREATE_STACKDUMP, %f now expands to basename of the
program correctly when used cross-process.

(60049)

« When CTF trace level is set to info (for post-offset values only) or debug (for pre-offset, offset and post-
offset values) and component rts#process is set to true, the API will now dump the captured metrics to
the output CTF file.

(27040)

SQL: OpenESQL
Back to the list

* An issue with compiling native programs that use SQL TYPE IS XML AS CLOB has been resolved.
3240037 (12679)

Significant Changes in Visual COBOL 6.0

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

« Adis

» Application Workflow Manager

e Call prototyping in library routines

e Common Communications Interface
e Compiler

» Database Access - OpenESQL

» Data Tools

« DB2

« Documentation

» Early warning of compatibility issues with current operating systems
» Enterprise Server
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» Enterprise Server Common Web Administration

» Enterprise Server Security

» File Handling

* HCO for DB2 LUW

« IDE

* Interface Mapping Toolkit

« Micro Focus Directory Server

» National data items in JVM COBOL code

* Rebuild required for projects unable to locate the Windows Resource Compiler

* Run-Time System

e SQL Option for DB2

¢ VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Adis
Back to the list

* In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.

3138718 (1112690)

Application Workflow Manager
Back to the list

« REST Connection function package attribute has been added, and Status Handlers for REST tools. See
"REST Function Package" in your product Help for more information.

« If the Search button is used in the Endevor attachment application, duplicate values are no longer
displayed in the resulting list.

3201329 (1117831)

Call prototyping in library routines
Back to the list

The copybooks cbl t ypes. cpy and cbl pr ot o. cpy, provided by this system for call prototyping in library
routines, include features of the latest syntax, specifically the CONSTANT keyword. If these files are used
in conjunction with the MF directive, it should be set to the current level, 21; otherwise, you should remove
the directive, or do not use these copybooks.

Common Communications Interface
Back to the list

« The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.

Compiler
Back to the list
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» "file not found" error messages now provide more information about the key the user needs to press.
The new format of the messages is as follows: "File name.cpy not found - Press [S]top/[R]etry/
[Clontinue/[A]lter-path™.

Data Tools

Back to the list

* You are no longer able to modify data in a structured record that is identified as comp-2 floating point -
an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.

3213037 (1118867)

« Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see
'Working with Different Character Sets' in the documentation for more information.

3161243 (1114482)

Database Access - OpenESQL
Back to the list

Just like other DBMS SQL COBOL precompilers, OpenESQL now follows embedded SQL standards and
disallows the use of group host variables in WHERE <column> = :hostvar clauses. In the past, this was not
flagged at compile-time, and would lead to unpredictable results when executed.

DB2
Back to the list

* There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)

Documentation

Back to the list

« The information about the -flag and warn compiler options has been updated.
3190928 (1120000)

Early warning of compatibility issues with current operating systems
Back to the list

In order to better support modern operating systems, we are aligning closely with their operability
guidelines. We now detect previously-undefined behavior when interacting with OS level functions.

Error RTS096 alerts you to any calls to the operating system's fork() API, in a process that has directly or
indirectly called COBOL functionality, in your code.

The error gives you an early diagnosis of a situation which, if left unchecked on modern operating systems,
could lead to deadlocks, crashes or other failures at run time. These problems would often occur
intermittently and be very challenging to track down.

See the KB article https://community.microfocus.com/t5/Visual-COBOL-Knowledge-Base/fork-rts64-
Error-96-encountered-in-child-process/ta-p/1771191 for more details.

Enterprise Server

Back to the list

e |F an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
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until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_?7???_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.

3213379 (1118913)

« The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the
command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.

(642125)

» Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites” in the "Scale-Out
Performance and Availability Clusters” chapter in your product Help for more information.

«  When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.

3223257 (1119804)

Enterprise Server Common Web Administration
Back to the list

* By default, ESCWA now runs on port 10086.

« When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique
Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.

« PAC names are now limited to eight characters or fewer in ESCWA.
» The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server Security
Back to the list

« The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.

3206992 (1118359)

File Handling
Back to the list
e The supervisor password is no longer displayed when cobfsclose is executed from the command line.

3195772 (1117571)
< Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

3120656 (641976)

» Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting
Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.
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» File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.

IDE
Back to the list

« A bug that prevented adding multiple Program Breakpoints has been fixed.

3222576 (1119722)

« Environment variables with the format ${env.<name>} are now handled correctly during compilation and
background parse.

3215414 (1119077)

* A new option has been added to the Window> Preferences> Micro Focus> Debug dialog box: Ignore
breakpoints in resources within unrelated projects. When selected, this option guards against the
situation where you have identically-named programs within your workspace, and setting a breakpoint in
one could cause the other programs to break when they are debugged (if the corresponding lines are
debuggable). To continue current behavior, this option is not selected by default.

3211196 (1118694)
» Populated folders can now be used as output folders for JVM COBOL projects.

3210830 (1118646)

< A new option has been added to allow you to edit the location of a remote linked folder. It opens the
same wizard as when creating a new remote linked folder, but in edit mode.

3200758 (1117951)

« Itis now possible to access a breakpoint's properties from the breakpoint's context menu in JVM
COBOL code.

Interface Mapping Toolkit
Back to the list

« The COPYEXT directive on remote projects now works correctly.
3206621 (1118324)

Micro Focus Directory Server
Back to the list

« UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y".

National data items in JVM COBOL code
Back to the list

JVM COBOL code that uses IS NUMERIC tests on NATIONAL or NATIONAL NUMERIC data items, or
uses NATIONAL NUMERIC data items in programs compiled with the CHECKNUM Compiler directive
must be recompiled in this release. Compiled code from earlier products that uses such constructs will
generate a M ssi nghMet hodExcept i on error when run under this release.

Rebuild required for projects unable to locate the Windows Resource Compiler
Back to the list

Projects that were last built in a version prior to 6.0, and that rely on the Windows Resource Compiler
(RC. exe) need to be rebuilt in Eclipse, otherwise they may produce an error. This is due to the relocation
of RC. exe in this version of the product. Affected projects will be those that explicitly reference a manifest
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file (used to include such things as cursors, fonts, and icons), and that are built directly from the command
line.

The problem is fixed if you open and build the project within the Eclipse IDE (as . cobol Bui | d is rebuilt to
find the new location of RC. exe). Alternatively, you should ensure that PATH contains a reference to
RC. exe if you continue to run projects from the command line.

Run-Time System
Back to the list

« Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.

3138692 (1112552)

SQL Option for DB2
Back to the list

+ The XDB Service name has been shortened.
3195822 (1119897)

VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Back to the list

If your Working Storage contains a data item with the OCCURS DEPENDING ON phrase, and ODOSLIDE
is in effect, any subsequent data items at the same or higher level must not contain a VALUE clause. If they
do, an error (COBCH1962) is now generated.

If you cannot remove the VALUE clauses from your source code or remove ODOSLIDE, contact
SupportLine.

Significant Changes in Visual COBOL 5.0

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

e« Common Communications Interface
e Compiler

« Data Tools

« Documentation

» Eclipse IDE

e Enterprise Server

« Enterprise Server Auditing

» File Handling

e Interface Mapping Toolkit

e Micro Focus Directory Server
e MFCRYPTLIB

* Request Packet Interface API

Common Communications Interface

Back to the list
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» Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost" should now work as expected.

* The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.

e If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.

« By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCLINI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCLINI File” in your product Help for more information. When connecting to a non-CCl
protocol server, all clients perform strict certificate checking as the new default behavior

Compiler
Back to the list

e The Search order has been updated, to allow the Compiler to find Java.

Data Tools
Back to the list

« Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.

3170479 (1115346)

Documentation

Back to the list

e The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

* The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.

3192497 (1117068)

Eclipse IDE
Back to the list

« In the Expressions view, there has been a change to the way that the number of characters displayed is
controlled. The Hex part now always displays the same number of characters as the raw data part (note
that Eclipse enforces the character limit, so the number entered by the user will include those used to
display the hex values). A maximum length entry of 0 is now correctly interpreted as "no limit".

3161694 (1114658)

« Eclipse now colorizes files that it will not build because they are preceded by other files of the same
name on the build path. The icon of such files is overlaid by an | or P and Eclipse shows a tooltip with
an explanation. This is to clarify the difference between this scenario and build-action-ignored.

3161416 (1114607)
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* Micro Focus Find/Replace now provides a Column Scope group that enables you to limit searches
between columns. You can specify columns or alternatively you can search only in the main code area
for the file type open in the editor. By default, it searches in all columns.

3142899 (1112931)

e Compiler directives are now stored in .mfdirset files which can be specified for particular languages, at
project/config/folder/file level.
2853665 (1104556)

* By default, COBOL, COBOL JVM, and Mainframe COBOL Projects have the EXITPROGRAM"ANSI"
directive set in the Project Settings > COBOL Properties. This specifies that if the EXIT PROGRAM
statement is executed in a program that is not under the control of a calling program, it causes
execution of the program to continue with the next executable statement. See EXITPROGRAM in your
product Help for more information.

« The COBOL JVM method breakpoint can now be toggled on the heading of the method.

» The Eclipse IDE has an improved user interface for settings. The COBOL, IMS, and the Run-time
Configuration settings pages now use a property grid that also displays the definitions of the settings.
As part of these changes the Output path, Target type, and Bitism are now specified in the project's
Link properties, click Micro Focus > Build Configurations > Link.

Enterprise Server
Back to the list

* A number of audit events now contain some additional information.
3140310 (1112666)

* Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.

3180233 (1116108)

» casfhsf could hang when processing HSF files that contain records from tasks that ran in different
months.

3177385 (1115884)

* A new system transaction, CRCN, is now available to monitor the state of XA connections for each
resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.

3174272 (1115727)

Enterprise Server Auditing
Back to the list

* Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling
Back to the list
« RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

3164916 (1114803)
* The SORT-CONTROL special register is now supported during a SORT statement.

3159740 (1114389)
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« To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use
the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)

3157247 (1114149)

Interface Mapping Toolkit
Back to the list

« If you try to deploy a stateful EJB SVI from the Visual Studio IDE after unchecking the “Reuse container
after application termination” check box (in the Deployment Characteristics tab of the Runtime
Environment Configuration dialog box), you receive a warning message informing you that the “Reuse
container after application termination” setting will be set to true for the deployment in order to prevent
the crash. In the Eclipse IDE, the unchecking of this option will just be ignored, and the option re-
selected. A warning to not uncheck the option for stateful EJB SVIs is also displayed on the prior page
(to the dialog box).

2663812 (1090987)

« WSDL and JSON Schema files generated for bottom-up CICS Web services now include a
"maxLength" parameter for all string fields.

3175039 (1116241)

Micro Focus Directory Server
Back to the list

* The event codes for several MFDS audit points have changed.

MFCRYPTLIB

Back to the list

« Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.
3181743 (1116186)

Request Packet Interface API
Back to the list

e The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fully-
qualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.

To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart —
m command line parameter, set MFDS_DNS_RESOLVE=N.

3194613 (1117203)

Significant Changes in Visual COBOL 4.0

This section describes significant changes in behavior or usage in Visual COBOL 4.0. These changes
could potentially affect the behavior of existing applications or impact the way the tools are used.

96 | Cumulative changes from Server Express to Visual COBOL for Eclipse (UNIX)



Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

« Application Workflow Modeller
e Code Coverage

e Codeset Support

¢« Common Communications Interface
e Communications Server

e Compiler

» Data Tools

« Documentation

» Enterprise Server

» Enterprise Server Auditing

« File Handling

« IDE

* Interface Mapping Toolkit

e MF Server Administrator (GUI)
« Micro Focus Directory Server
¢ Run-Time System

Application Workflow Modeller
Back to the list

e Source or listing files are now opened in read-only mode when a browse action is executed in the
ChangeMan attachment model.

3138354 (1112546)

« A new function package, Micro Focus Background Parser, enables you to define the SYSLIB or
PROCLIB concatenation in which to search for COBOL copybooks, PL/I or JCL include files on the
mainframe or on network drives. The package also enables you to define any identifiers which
determine the structure of the local cache for COBOL copybooks, PL/I or JCL include files.

3132249 (1111922)

« The Endevor attachment application now validates the input of a CCID or a comment. They must not be
blank.

« Added the new "Modeled Edit Sessions Only" AWM model attribute to control whether modeled editor
actions should be available in non-modeled edit sessions.

Code Coverage
Back to the list

« Schema changes that affect the test coverage results generated from the t cut i | utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFi | eCover age> element, you need to alter your transformations to focus on
<sour ceFi | eCover age> instead. The element was renamed to more appropriately reflect its
contents, ast cut i | now gives global coverage for all source files (not just copybooks).

Codeset Support
Back to the list

e Code-set mappings between ASCIlI and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\"
character to “$".
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3124321 (1111464)

New single-byte character set tables for MFCODESET have been added in order to improve support for
DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.

3111843 (1109984)

Common Communications Interface

Back to the list

You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.

2866265 (1105526)

In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.

In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server

Back to the list

TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.

3144133 (1113024)

Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the region is secured using external security. Users will be required to provide a valid username
and password in order to view either log file. Web access to the logs can be controlled using the
standard ACL definitions under the new "Communications Server" Resource Class, with resources
"Enterprise Server Console Log" and "Communications Server Log". If these resources exist, users
require read access to be allowed to view the logs. If they do not exist, the default behavior is to allow
read access. The new resource class and resource definitions can be found in the
"es_default_Idap(_msuser/_unix).ldf" file in the bin or etc sub-directory of your product install directory.

3113539 (1110155)
MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.

2868627 (1105777)

MFCS no longer initializes the Security Facility if there are no External Security Managers defined for
the region.

Compiler

Back to the list

Programs containing EVALUATE statements of the form: EVALUATE true | false WHEN conditional-
expression where conditional-expression included inline method invokes would give an RTS 114 error
when run as .int code, and an "lllegal .int code" error when generated. This has been fixed. Also, short
circuit evaluation is now correctly observed, such that when evaluating condition-1 AND condition-2, if
condition-2 contains an inline method invoke and condition-1 is false, then the inline method invoke is
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not executed. Previously, despite being correctly evaluated, the inline method invoke in condition-2 was
being executed. Similar behavior relating to OR evaluations has also been corrected.

3138510 (1112492)

« During compilation, characters within literals that are unknown in the current locale are now less likely to
cause spurious errors. However, the correct (and safest) solution is to ensure that the locale has been
set correctly, to match the source encoding of these characters. On UNIX, this means setting LANG,
LC_CTYPE, or LC_ALL appropriately; each of these variables takes precedence over the former. On
Windows, this means setting the system locale in the 'Region and Language' section of Control Panel.

3123935 (1111148)

« The Compiler now produces an E level message - COBCH1888 Typedef is defined differently in another
external program - if different external programs have conflicting definitions of the same typedef name.
(To restore the previous behavior, where the earlier definition was ignored, use the directive
HIDEMESSAGE"1888".)

« An issue with the Compiler has been fixed so that in the RECORD VARYING clause, if the minimum
and maximum lengths are specified, the maximum length must be greater than the minimum length.

Data Tools
Back to the list

* Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.

2853226 (1103406)

Documentation
Back to the list

« You can use 'byte’' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.

3147576 (1113323)

« As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly
referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.

3121002 (1111373)

Enterprise Server
Back to the list

« The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.

3113639 (1110160)

e The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security ho
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.

« The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.
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* The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. '"MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT* or "XAT*'. The following is a sample export of the LDAP
repository:
kkkkkhkhkhkkhkkkkhkkhkhkikhkkhkkhkkkhkhkkhkikhkkhkkkk*k

# Sanpl e security definitions for ESMAC M) Li steners/ Witers pages

HEHH AR AR

#HH#HE MQL* ##

HHHHHH AR HH AR SRR

dn: CN=MQL*, CN=MFESMAC, CN=Ent er pri se Server Resources, CN=M cro
Focus, CN=Pr ogr am Dat a, DC=X

changet ype: add

cn: MQL*

obj ect d ass: i crof ocus- MFDS- Resour ce

ni cr of ocus- MFDS- Resour ce- Cl ass: MFESMAC

m cr of ocus- MFDS- Resour ce- ACE: al | ow. SYSADM gr oup: al ter

m cr of ocus- MFDS- Resour ce- ACE: deny: *: execut e

m cr of ocus- MFDS- Ul D: nfui d

#description: Allow full access any ESMAC MQ Li steners/Witers Screen

EE IR IR Sk S S R S I R O I O

3143258 (1112990)

* You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors
from Enterprise Server.

3142092 (1113248)

* Communication with the console daemon has been improved. Messages are displayed more quickly
and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.

3136867 (1112483)

< Administrators can now add, delete or modify XA resources in the Enterprise Server Administration
Web Ul while a region is running.

2589624 (1085625)

* In UNIX environments, DB2 and ODBC switch modules can now be enabled together in the same
region if the DB2 switch is built with the "-0" option.

3137455 (1112398)

Enterprise Server Auditing
Back to the list

« The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.

3150566 (1113592)

« Any extra information that was added to the syslog messages will now correctly appear in the structured
data items.

File Handling
Back to the list

* In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.

3124294 (1111259)
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e The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,
description, and ACL. Previously, you could only filter on Class name.

2871549 (1106119)

e Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

3113802 (1110183)
* The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

3109432 (1109745)
* OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.

2887724 (1108443)

IDE
Back to the list

* New functionality to support the debugging of CICS channels and containers has been added to this
release.

2810448 (1098047)

Interface Mapping Toolkit
Back to the list

« Refresh Resources functionality has been added to regenerate existing service interfaces for COBOL
programs whose linkage section has been updated after the service interface was initially created.

2849403 (1103036)

* Due to changes made to the Configure Runtime Environment dialog box in this release, after you
upgrade your system, you must reenter all previously set values on this dialog box before running a
service.

MF Server Administrator (GUI)
Back to the list

* The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server
Back to the list
« The mfds -g options D, O, and S have been added to the product Help.

2848627 (1102864)

e On UNIX, specifying an invalid user ID in the MFDS "General" options value for "Default process user
ID" no longer causes the child process (such as a region start or stop request launched from the Web
interface) to fail. The user ID under which the MFDS process was started will be used instead.

« MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

Run-Time System

Back to the list

* The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.

e scan64 is no longer available. This has been superseded by the COBOL Analysis functionality in the
IDE.
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Significant Changes in Visual COBOL 3.0

Visual COBOL version 3.0 includes significant changes in the following areas:

« Compatibility AddPack
» Compiler

» Documentation

« Enterprise Server

» File Handling

« IDE
« Micro Focus Directory Server
e OpenESQL

* Reserved words
e SQL Option for DB2

Compatibility AddPack for Visual COBOL

Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Visual COBOL for Visual Studio. The
run-time components are installed as part of COBOL Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

Compiler

« Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

Documentation

« There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server

« WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are O.

2989188 (1108602)

IDE

« You can now open data files in RSE configured remote projects using the mfdatatools2 on the remote
machine displaying back to an X display. You can configure the remote tools display by clicking Window
> Preferences > Micro Focus > X Display. In the X Display (DISPLAY) field, type the display details. In
addition, COBOL Explorer displays the Open With Remote Data File Editor context menu item for
remote data files.
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2852872 (1104085)

Enterprise Server sign on credentials which were created on Windows when using the 32-bit versions of
Enterprise Developer or Visual COBOL for Eclipse are not compatible with the 64-bit versions of those
products, and vice versa. Users are required to re-enter credentials which are not compatible with the
current version of the product. You only need to do this the first time they are used in the current
product.

(625819)

File Handling

Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.

2988222 (1108521)

A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.

2874622 (1106562)

Micro Focus Directory Server

In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.

3101625 (1109025)

Some additional CSRF security measures have been added to the Enterprise Server Administration
HTML GUIL.

3101205 (1108916)

OpenESQL

The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for ODBC
(DBMAN=0ODBC). This ensures that embedded SQL cursors that use WITH HOLD and FOR UPDATE
clauses have the same data integrity across all databases.

If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

Reserved words

There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:

ALLOCATE
FREE
JSON
END-JSON

SQL Option for DB2

Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) Uls have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.
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Significant Changes in Visual COBOL 2.3 Update 2

Visual COBOL version 2.3 update 2 includes significant changes in the following areas:
e Compiler

» Eclipse IDE

« Enterprise Server

e MF Directory Server

* Monitoring and Management

* Run-Time System

Compiler

* Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

* There is no longer a problem opening an RM/COBOL indexed file when the program has a RECORD
CONTAINS n CHARACTERS clause and there are record descriptions with lengths less than n. This
situation previously caused a 39 error on the OPEN (other than OPEN OUTPUT) because there was a
mismatch in the minimum record length.

Eclipse IDE

» This update modifies any existing connections defined in an Eclipse workspace. If the connections had
any non-default values, those values could revert to their original default setting. After installing this
release, before you use any remote connections for the first time, you need to check the settings and
amend them as necessary.

2852872 (1103699)

Enterprise Server

« Previously, it was possible to install groups that should not have been installed. If a group name, as
defined in the Startup List, did not exist in the list of Groups then the next Group in the alphabetical
order would be loaded instead. Now, if a Group is not defined in the list of Groups, a warning that the
Group could not be loaded is issued.

2869848 (619107)

« On UNIX, if the "File Path" setting was not specified in the configuration of an Enterprise Server, the
environment variable TXFILEP was defaulting to $COBDIR/etc/cas. This has been changed and
TXFILEP is not populated when the "File Path" is not specified.

(618668)

MF Directory Server

e The "-n" option for the mfds command now supports hostnames as the network addresses in addition to
IPv4 addresses.

2816871 (1099564)

Monitoring and Management

* Messages that are written to the console log by applications that perform "display upon console" now
contain a standard message ID (CASMGO00011).

2854207 (1103659)
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Run-Time System

« The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

2838118 (1101539)

Significant Changes in Visual COBOL 2.3 Update 1

Visual COBOL version 2.3 update 1 includes significant changes in the following areas:

* Application Workflow Modeller
» Data Tools

« Editor Writing Assistance

- IDE

* Run-Time System

¢ SQL: OpenESQL

e SQL Option for DB2

Application Workflow Modeller

e Tools used in the File_Descriptor_Has_Action relationship now support Resource Processing. This
means tools defined within a dialog table action can modify properties of the selected table rows.

2835290 (1101493)

« The standard ED project model now contains additional context menu actions under "Open With..." for
IMS DBD and PSP files to open either the DBD, the PSP or the IMS Database editors.

* You no longer receive a REXX error when recompiling a component from a baseline.

Data Tools

< When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.

« The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.

« The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.

« The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Editor Writing Assistance

« IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.

IDE

« When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.
2848855 (1102932)

* For afile added to a JVM COBOL project by adding the folder that stores the file (using the Source tab
on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a hew
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.

2699374 (1094326)
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Run-Time System

The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

nfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET' API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET' API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)

Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE
class condition tests:

. IS[NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through OxFE, and the second byte in the range 0x41 through OxFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

e IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through Ox7F, and the second byte in the range 0x41 through OxFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kaniji character, and returns true if valid.

e IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.

When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCHO0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Visual COBOL are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
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dbo.CONCATY(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

* Run a DSN bind against the customer database. Or:
« Execute the ¥%ALLUSERSPROFI LE% M cr o Focus\ Enterpri se Devel oper\hcoss
\Instal | Di gi tsFunction. sql script.

This is a one-time only change to the database.
2843818 (1102248)

SQL Option for DB2
* Spurious errors were sometimes returned while querying using an ALIAS.
2830383 (1100609)

Significant Changes in Visual COBOL 2.3

Visual COBOL version 2.3 includes significant changes in the following areas:

e CAS Security
e« CAS XA Switch modules

» Compiler

« File Handling - External File Handler
» File Locking

« IDE

* J2EE Connector
e MF Server Administrator (GUI)
e Updated Run-Time System

CAS Security

* The Enterprise Server External Security Facility now includes MLDAP ESM Module 2.0, with a new
algorithm for identifying the best-matching resource-access rule and ACE for resource-access security
checks. This algorithm is faster and matches most customers' expectations. The new algorithm also
provides an optional "username substitution" feature. It can be enabled by setting "rule substitutions" to
"yes" in the [Operation] section in the Security Manager configuration text area. When this is enabled,
the string "${user}" in a resource-rule name will be replaced with the name of the user that makes the
request. For example, a DATASET rule named "USERS.${user}.**" would apply to datasets with the
requesting user's name as the second qualifier. In rare cases, customers with complex, ambiguous
resource-access security rules might see experience changes in behavior as a result of the new
algorithm. The old algorithm is still supported and can be enabled by setting "version 1 authentication”
to "yes" in the [Operation] section of the Security Manager configuration.

2807531 (1097783)

CAS XA Switch modules
e The XA switch modules now support dynamic registration.

2682101 (1092325)

* The XA switch modules now support batch-only operations when multiple XA Resource Managers have
been defined.

2664675 (1091082)

e In Visual COBOL 2.2 update 2, Micro Focus identified undefined run-time behavior when the following
combination of directives was specified: SIGN"EBCDIC", CHARSET"ASCII", and one of the following:
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HOST-NUMMOVE, HOST-NUMCOMPARE or SIGN-FIXUP. Previously (Visual COBOL 2.2 update 1 and
earlier), if this combination was specified, the SIGN”"EBCDIC” directive should have been ignored, to
avoid a mixture of ASCII and EBCDIC characters; however, SIGN’"EBCDIC” was still being honored,
resulting in undefined run-time behavior. Therefore, this combination of directives is now invalid for
Visual COBOL 2.2 update 2 or later, and if specified, will be rejected at compile time.

2786397 (1095265)

Compiler
* For native COBOL, the size limit of the Data Division now stands at 2GB -1.

2796076 (1096384)

» Previously, it was not possible to specify sign(EBCDIC) with sign-fixup, host-num-move or with host-
num-compare. This combination is now supported in native COBOL but remains invalid for managed
COBOL code. This is applicable to version 2.2 U2 HotFix 10 onwards.

2824577 (1100823)

File Handling - External File Handler
« Custom file handlers (using DYNREDIR) are now called for each part of a concatenated file.

2795077 (1096322)

File Locking

« Inversions prior to Visual COBOL 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX
and Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the
tunable strict_fil e | ocki ng=true is set, which is the default setting.

Example of potential changes in behavior:

* Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

* Process-B then attempts to open the file with read-only access and a sharing mode that denies
other processes read access (SHARING WITH NO OTHER).

Withstrict_file_l ocki ng=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

Withstrict_fil e_|l ocki ng=f al se, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result
of the new file locking behavior. In such circumstances, we recommend that you review the file locking
and sharing requirements of your application and refactor your source code to work with the default
setting. The original file locking and sharing behavior can be restored by setting

strict_file_l ocking=fal se.

IDE

* Visual COBOL for Eclipse now ships with Eclipse 4.4.2 (Luna). If your applications contain JVM COBOL
code that was built with a previous version of the product, those parts of your application must be
rebuilt; otherwise you will experience errors at either compilation or run time.

(609469)

» A project can have one of two connection modes: NFS/Samba, where the target location is mounted as
a local drive, and RSE, which is a purely remote connection to the target location. For project types
such as Mainframe COBOL, NFS/Samba is required to use some tools which do not support RSE. For
most other projects, it is possible to switch between connection modes using the Remote Settings
context menu option. In the dialog box, there are radio buttons allowing for selection of connection
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modes. On changing mode, you must select an existing connection of the appropriate type, or create a
new one. If switching to NFS/Samba mode, you must specify the local path to the project.

2792882 (1096196)

» By setting "-Denable.projectrepair=true" in the eclipse.ini file, .cobolProj and .pliProj files will be repaired
to reflect the workspace on project refresh.

2696707 (1095994)

J2EE Connector

* Visual COBOL version 2.3 provided a new command-line argument to Java, mf.ssl.algorithm, which can
be set to an appropriate algorithm.

2799213 (1096684)

MF Server Administrator (GUI)

« Passwords that entered through either the MFDS or the ESMAC interface now use the same encoding.
2792382 (1096011)

Updated Run-Time System

» COBOL Server now provides an execution environment capable of running applications that were each
built using different development products. A consequence of this is that if your application has a main
COBOL executable (.exe) that was built with a version of Visual COBOL prior to version 2.3, you should
ensure that the executable is rebuilt and packaged with the new run-time system. You can rebuild from
the IDE or the command line.

Other COBOL subprograms built with previous versions of Visual COBOL are not required to be rebuilt.

Significant Changes in Visual COBOL 2.2 Update 2

Visual COBOL version 2.2 update 2 includes significant changes in the following areas:

» Compiler

e Compiler Front-end
« Documentation

¢ J2EE Connector

Compiler

* When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end

» Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

» The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.

2697571 (1094370)
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J2EE Connector

* The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)

Significant Changes in Visual COBOL 2.2 Update 1

Visual COBOL version 2.2 update 1 includes significant changes in the following areas:

« SQL: COBSQL

SQL: COBSQL

e COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)

Significant Changes in Visual COBOL 2.2

Visual COBOL version 2.2 included significant changes in the following areas:

e Compiler

» Eclipse IDE

« Interface Mapping Toolkit

e MF Directory Server

e MF Server Administrator (GUI)
e Request Handler

Compiler

* The default for the NSYMBOL directive under DIALECT(ENTCOBOL) has been changed to
NSYMBOL(NATIONAL) to emulate the equivalent IBM default.

2657471 (1090355)

* To improve RM/COBOL and ACUCOBOL compatibility, the SIGN clause at a group level is no longer
applied to non-DISPLAY usage signed numeric data items within the group, just as it is not applied to
unsigned numeric data items and non-numeric data items within the group.

2549904 (1082171)

« Previously, even though no code was generated, the Compiler allowed the ON EXCEPTION and NOT
ON EXCEPTION phrases in the DISPLAY statement in formats that do not allow these phrases. As a
result, if the DISPLAY statement was in the ON EXCEPTION phrase of another statement, the NOT ON
EXCEPTION phrase would bind incorrectly with the DISPLAY statement instead of with the intended
containing statement - for example, ACCEPT or CALL.

Eclipse IDE

e The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. If the column is not present in the view by default, it can be added through the
Configure Columns dialog box in the View Menu.

2608496 (1088530)

e The outline of the ruler in the COBOL editor now changes on modelChanged depending on the current

source format.

2488419 (1077143)
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Deleting a Web service or a Java interface mapping now deletes the files relating to it from the repos
directory and, if it is empty after the files have been deleted, will remove the repos directory itself.

The IDE now performs an automatic directive determination when files are added to a project. You can
also use a command to perform directive determination of the project manually.

Interface Mapping Toolkit

For program-based Service Interfaces, if the program-id name in the COBOL source is in lowercase and
is not surrounded by quotes, its corresponding entry-point name is now forced to uppercase when used
in a Service Interface Operation. Previously, the case was preserved. As a result of this change, existing
Service Interfaces will become invalidated if you refresh their program's annotations because of the new
spelling of the entry-point name. To avoid this, you need to surround the program-id name in the
COBOL source with quotes before you refresh the annotations.

MF Directory Server

The mfds command line option for exporting registered Enterprise Server definitions to an XML file now
supports the "*" option. This exports all registered servers rather than a specified server. Multiple server
definitions are now exported into the target directory and saved into a file with the default name
ALLSERVERS.xml. The import option now also supports the import of multiple server definitions from a
single XML file.

2641890 (1088838)

mdump now supports a new option, -e, to help you query the Security Manager configuration details.
The possible values of the option are: "1" - shows security configuration that applies to any returned
enterprise servers; "2" - shows security configuration for MFDS and the default Enterprise Server
security configuration. This requires MFDS version 1.15.00 or higher; "3" - returns the properties of all
configured external Security Managers.

2487164 (1081693)

MF Server Administrator (GUI)

When adding a user to an external security manager, you can now include a password expiry time in
the Advanced Configuration section of the Add New User wizard in Enterprise Server Administration.
The field value is specified using generalized time format (YYYYMMDDHHMMSS.0Z), and can be used
by the MLDAP ESM for calculating whether a user's password has expired and requires updating. This
value may only be specified using this page when adding a user. You need to use an external directory
services configuration tool to edit it.

2562118 (1083203)

Request Handler

A problem that caused BIS to create log files in a directory named C:\ProgramData\AcuCorp\BIS
\LogFiles was fixed. BIS no longer creates log files unless specified and the BIS logging service is now
disabled by default. To enable it, you need to use the following global environment variable:
BIS_LOG=[ OFF | ON | <directory>] Where the values are:

« OFF - disables logging (the same as if BIS_LOG is not specified or is left blank)
« ON - enables logging and directs the log files into the default location, which must not be read-only.

« <directory> - enables logging and directs the log files into the specified directory. The user must
ensure that the BIS request handler has write rights for this directory. The directory must be an
absolute path or network path. If the specified directory does not exist, BIS will attempt to create it.
The containing directory must exist.

The BIS_LOG variable is only examined when the BIS application pool is started or recycled. After
setting or changing BIS_LOG, IIS must be restarted in order for the variable to take effect.
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Significant Changes in Visual COBOL 2.1 Update 1

Visual COBOL version 2.1 update 1 includes significant changes in the following areas:

+ Documentation
« |IDE

Documentation

» To ensure no loss of functionality when accessing Vision and RM/COBOL data files, you should use the
appropriate IDXFORMAT Compiler directive setting or file handling option, and not use the
CALLFH(ACUFH) Compiler directive. See 'Configuring Access to Vision Files' and 'Configuring Access
to RM/COBOL Data Files' for more information.

IDE

* You can now set program breakpoints as follows - click "Add Program Breakpoint" in the Run menu or
on the Breakpoints view toolbar, and enter the program name in the dialog that is displayed.

* Local Enterprise Server regions without secure user credentials are now started with casstart and
stopped with casstop commands.

Significant Changes in Visual COBOL 2.1

Visual COBOL version 2.1 includes significant changes in the following areas:

- IDE
e Run-Time System
« Vision File System

IDE

* You can now specify in the IDE whether directories that you add to the project should be added to the
copypath. You configure this in the project's properties under Micro Focus COBOL > Build Paths, and
on the Copybook Paths tab.

(589096)

Run-Time System

* When running a full-screen application inside a terminal emulator on Linux, the actual size of the
terminal is read at startup and reread when the terminal is resized. This behaviour is also supported on
AIX, HP/UX, and Solaris. The Micro Focus vt220 terminfo entry now correctly describes a 24-line
display. A vt220-25 terminfo entry is included for compatibility with the previous behaviour.

2579335 (1084817)

Vision File System

< When you configure your application to return RM/COBOL file status codes, by setting
COBFSTATCONV=rmstat, the codes returned are ANSI'85 codes.

2553438 (1082469)

Significant Changes in Visual COBOL 2.0

Visual COBOL version 2.0 includes significant changes in the following areas:
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e Compiler
- DB2
» File Handling

Compiler

» The scope of the ILUSING Compiler directive when used in a $set command has changed. The scope
of the directive is now limited only to the source file it is set in, and not globally. This new behavior may
mean that your source files no longer compile. To resolve this, add the required ILUSING statements to
the required individual source files, or add the ILUSING directive on the command line. Alternatively,
use the IDE to achieve the required behavior: in Visual Studio, use the Namespaces tab; in Eclipse, set
the directive in the Additional Directives field.

DB2

« The DB2 ECM has been updated to resolve run-time errors returned when compiling against mainframe
databases in 64-bit mode.

2549058 (1082441)

File Handling

* When reading a file cataloged as DISP=SHR the file handler now buffers the read for better
performance.

2518330 (1079491)

IDE

« Typing in the sequence area moves text after the cursor to the right and doesn't delete the characters at
area end. To overwrite characters in the area, switch to insert mode by pressing the Insert key. Pressing
the Tab key in the sequence area indents the text if the option "Pressing Tab in the sequence number
area moves caret to area A" is not selected. Pressing the Tab key when there is a multiline selection
aligns the text to the area margins.

e Typing in the sequence area now works like typing in a regular text editor - it moves to the right all the
text after the cursor and doesn't delete the charaters at area end. If you want to overwrite characters in
the area, you can switch insert mode to overwrite by using "Insert" key.

Unsupported or Deprecated Functionality

The following topics describe functionality that was removed or deprecated at each product release.

Unsupported or Deprecated at Visual COBOL 7.0

The following Compiler directive option has been deprecated:

e |ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Visual COBOL.

Unsupported or Deprecated at Visual COBOL 6.0

No additional features were unsupported or deprecated at version 6.0.
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Unsupported or Deprecated at Visual COBOL 5.0

This section includes information about features or functionality that are no longer supported or are
deprecated at version 5.0.

 The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.

Unsupported or Deprecated at Visual COBOL 4.0

The following features or functionality are no longer supported or are deprecated at version 4.0:

e Support for Eclipse 4.4 and 4.5 has been discontinued.

Unsupported or Deprecated at Visual COBOL 3.0

The following features or functionality are no longer supported or are deprecated at version 3.0:

e The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.

« Compatibility AddPack for Visual COBOL - this is now deprecated and will not be available with release
3.0 and later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows
and UNIX) which were part of the AddPack are now installed as part of Visual COBOL for Visual Studio.
The run-time components are installed as part of COBOL Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

« Audit Manager is deprecated and provided for backward compatibility only. We recommend that you use
syslog events instead. See Enterprise Server Auditing for more information.

« The following DB2 environment variables are deprecated at version 3.0, and provided for backward
compatibility only.

* HCOBND - Micro Focus recommend you use either the BIND or the BINDDIR compiler directive
option.
« The following compiler directives are deprecated at version 3.0, and provided for backward compatibility
only.

» CONVERTRET
* |IDYSRCPATH

* ILOBJECTIFY
 OPTION

» SPZERO
 TRICKLE

» The following file handling options are deprecated at version 3.0, and provided for backward
compatibility only. Micro Focus recommend you use IDXFORMAT"8" instead:

* STRIPING

* MAXSTRIPEDIGITS
* MAXSTRIPEFILES
« MAXSTRIPESIZE

* STRIPE-X

» STRIPENAMETYPE
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Unsupported or Deprecated at Visual COBOL 2.3
Update 2

The following features or functionality are no longer supported or are deprecated at version 2.3 Update 2:

« The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

Unsupported or Deprecated at Visual COBOL 2.3
Update 1

The following features or functionality are no longer supported or are deprecated at version 2.3 update 1:

Unsupported or Deprecated at Visual COBOL 2010

The following Net Express features or functionality were not supported or were deprecated from the first
version of Visual COBOL:

These Net Express compiler directives are not supported by Visual COBOL :

01SHUFFLE EXPANDDATA REGPARM
64KPARA FIXING SEGCROSS
64KSECT FLAG-CHIP SEGSIZE
AUXOPT MASM SIGNCOMPARE
CHIP MODEL SMALLDD
DATALIT OPTSIZE TABLESEGCROSS
EANIM OPTSPEED TRICKLECHECK
EDITOR PARAS WB2
ENSUITE PROTMODE WB3

wB

Note: The directive SPZERO was already deprecated from Net Express 5.0 onwards, and is provided
for backward compatibility only. You should instead use SIGN-FIXUP.

and the pseudovariables of the following Net Express environment variables are obsolete and cannot be
used:

BASENAME
FILENAME
PATH
TARGETDIR

Known Errors and Restrictions

Refer also to the Known Issues and Restrictions topic in the Product Information section of your product
Help.

The following errors and restrictions are known to apply to Visual COBOL version 7.0:
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Eclipse IDE

On Linux, the marketplace client in the supplied version of Eclipse will not work correctly if the product is
installed in a spacey directory. Micro Focus recommends that you avoid installing the product in a
spacey directory on Linux, if you want to install any additional plugins from the Eclipse marketplace.

IS NUMERIC Test Returning Incorrect Results

In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in Visual COBOL 6.0.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

Oracle Database Access by .NET Core 3.x Client Applications on SUSE Enterprise Linux

Oracle does not support deployed .NET Core 3.x client applications on SUSE Enterprise Linux
accessing Oracle databases.

Upgrading from Server Express

You upgrade existing distributed applications created with Server Express to Visual COBOL for Eclipse.

The Visual COBOL suite includes the following two independent products that are designed to be used
together for maximizing the developers' productivity:

Visual COBOL Development Hub is the counterpart of Server Express and must be installed on the
machine that has your application sources.

Visual COBOL for Eclipse provides a rich and highly effective integrated development environment that
can be connected to Visual COBOL Development Hub to enable you to edit, build and debug the
applications' sources directly on the remote machine.

The following sections provide information on how to upgrade.

Advantages of Upgrading to Visual COBOL

Visual COBOL offers numerous enhancements and a modern IDE that offers advantages such as:

Improved This is achieved through:

productivity

Using the very latest technology of integrated development environments (IDEs) in a
powerful IDE.

* Fast and easy customization with major source control systems, simplifying
integration with existing development lifecycle leading to higher developer acceptance
and productivity gains.
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» Providing the tools to allow you to edit, compile, debug, execute and test COBOL
applications on all supported Micro Focus UNIX and Linux environments. One
development tool can now meet your development requirements today and in the
future.

« Enabling cross-language application development which results in better quality and
increased competitiveness.

e Achieving faster time to market.

Improved Improve efficiency when performing day-to-day development activities, enabling access
efficiency to Eclipse, smart editor, instantaneous compilations, advanced test and debugging
capabilities.

Addressing of the  Using COBOL from within a standard IDE helps reduce the gap between the

COBOL skills COBOL and Java or C# developers by providing a unifying, collaborative and

shortage dynamic development environment. Non-COBOL developers can quickly and
easily adapt to the COBOL language, and get up to speed in no time.

For a full list of the advantages of using Visual COBOL, see the Visual COBOL data sheet and white
papers on the Micro Focus Web site.

Upgrading Your COBOL Application

Note: Upgrading your existing applications might be a complex task, therefore we recommend you
contact Micro Focus Professional Services for assistance with this process.

If you've never used Eclipse before, Micro Focus recommends that you read the chapter Introduction
to Eclipse in this product help to get familiar with the IDE before you start upgrading your applications.

Prerequisites
In most situations when you are upgrading to Visual COBOL, you will;

» Keep your source code on the UNIX machine. You need to install Visual COBOL Development Hub on
this machine.

» Install Visual COBOL for Eclipse on the your local Windows machine. You need to create a connection
in Visual COBOL to the remote UNIX machine and then create remote projects for the application's
source files.

On single-user Linux machines you do not need to install Visual COBOL Development Hub. Instead, you
can install Visual COBOL for Eclipse on the same machine as the application files and maintain the
application directly on the Linux machine.

Upgrading your applications

The following outline shows an example approach to upgrading an application to Visual COBOL.:

1. Assess your existing processes for building and testing your applications.

Discover any similarities and differences between your existing applications and what programming
issues they resolve. Determine what project types and scenarios you need to handle in Visual COBOL
for Eclipse.

Review the Compiler directives that are used to build the applications. Review these to ensure they are
still valid.

Note: You can use Micro Focus COBOL Analyzer to check your existing applications and assess
what might need be to changed or what functionality is no longer supported.

2. Compile your existing sources at the command line:
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a. Ensure Visual COBOL Development Hub is installed on the machine that stores your sources.

b. From a terminal window, set the environment for Visual COBOL Development Hub and build the
existing application. Resolve any compilation issues and ensure that the application behaves as it
did previously.
3. Create a Visual COBOL project to handle your source code:

a. Install Visual COBOL for Eclipse on a local Windows machine.

b. In Eclipse, create a connection to the machine that includes your sources and create a remote
project.

c. Add the application sources to the new project and set the following Compiler directives on the
project:

SOURCETABSTOP"8"
COPYEXT",CBL,CPY"
d. Add the Compiler directives that were used to compile the original project and are still valid to the
new project.
e. Build and debug the application using Eclipse.

Ensure you get the same results using Eclipse as you did when you used Visual COBOL
Development Hub on the remote machine (see step 2b).

4. Add more projects, programs and copybooks as required.

Review the Best Practice in Development Using Eclipse information in this document to ensure you
achieve maximum productivity.

Experiment with various debugging options to find those that best meet your requirements.
Compile for debug and for release and ensure that the application performs as expected.

Create one or more template projects and distribute those across the entire development team.
Examine ways in which Eclipse can help to modernize your applications and processes.

o

© ® N>

For more details about these steps see the following sections and the Related Information.

Compile Your Existing Programs without a Project

Visual COBOL includes a lot of enhancements and changes and this is why applications that were
compiled using earlier Micro Focus products must be recompiled from the sources using Visual COBOL.

Micro Focus recommends you first compile without a project as you would have done in Server Express.
This will help you focus on resolving any compilation issues following the changes in the environment.
Then, you can look at creating a Visual COBOL project in order to take advantage of all the benefits offered
by the IDE.

To compile your existing programs from a terminal window directly on the UNIX machine:

1. Ensure that Visual COBOL Development Hub is installed on the remote machine where you store your
existing COBOL programs.

2. Log onto the remote machine and from a terminal window, configure the environment and compile your
programs using the cob command or the build scripts or makefiles used to build the application with
Server Express.

Remember to review and reuse all Compiler directives that were previously used when compiling the
application in Server Express.

Most programs created with Server Express should compile cleanly using your existing build scripts and
makefiles without any changes to your code, as Visual COBOL also provides the cob utility to
create . i nt,.gnt or. ofiles.

Fixing compilation issues

Because Micro Focus continues to enhance the COBOL language, you might encounter some problems
when compiling your existing Server Express applications in Visual COBOL.
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For example, the list of reserved COBOL words changes with each new level of the COBOL language, so
an application created with an older Micro Focus product might use data names that are now reserved
keywords in Visual COBOL. If this happens, a COBOL syntax error COBCH0666 ("Reserved word used as
data name or unknown data description qualifier") occurs. See Reserved Words Table in this product help
for a comprehensive list of reserved words and the levels at which they are supported.

Also, these Server Express Compiler directives are no longer supported:

01SHUFFLE EXPANDDATA REGPARM
64KPARA FIXING SEGCROSS
64KSECT FLAG-CHIP SEGSIZE
AUXOPT MASM SIGNCOMPARE
CHIP MODEL SMALLDD
DATALIT OPTSIZE TABLESEGCROSS
EANIM OPTSPEED TRICKLECHECK
EDITOR PARAS WB2
ENSUITE PROTMODE WB3

WB

and the pseudovariables of the following Server Express environment variables are obsolete and can't be
used.

BASENAME
FILENAME
PATH
TARGETDIR

You should consider using the following methods to solve such issues:

* Rewrite the source to avoid using these keywords in your code and directives files.

« Use the REMOVE Compiler directive to remove individual keywords from the reserved words list.

* Use the MF or MFLEVEL compiler directive to select an earlier version of Micro Focus COBOL that your
code is compatible with. For example, setting MFLEVEL" 12" ensures compatibility with Mainframe
Express 3.0 and 3.1, Net Express 4.0, 5.0, and 5.1, and Server Expresss 4.0, 5.0, and 5.1. Refer to
Reserved Words Table in this product help for the value to use to ensure support for your existing
reserved words.

Setting REMOVE and MFLEVEL Compiler directives at the command line

To use REMOVE from the terminal window (or later in the editor in Eclipse), type the following:
cobol nyprogram cbl renove(title) ;

The command above removes TITLE as a keyword from the language so you can use it as an identifier in a
COBOL program.

To use the set of reserved words that was used for Server Express v5.1 WrapPack 5, use this command
line:
cobol nyprogram cbl nflevel "15" ;

Setting REMOVE and MFLEVEL directives in the source code

To set either one of the directives in your source code, type the following starting with $ in the indication
area of your COBOL program:

$set renove "title"

Or:
$set nflevel " 15"
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Create a Project and Import Your Sources

Once you have ensured your programs compile cleanly in the Visual COBOL environment, you can create
a project for them so that you can take full advantage of all of the benefits offered by the Eclipse debugging
environment. You need Visual COBOL for Eclipse installed on your local Windows machine and you need
to create a connection in it to the remote UNIX machine.

Connect Visual COBOL to the remote machine

From your local installation of Visual COBOL create a hew remote connection to Visual COBOL
Development Hub on the UNIX machine which has your existing COBOL programs. See Creating
connections to remote hosts in this product help.

Create a remote project
You need to create a project that will store the source files on the remote machine:
1. Start Visual COBOL.

If this is the first time you have started Visual COBOL you see the Welcome page in the IDE. You can
also open the Welcome page by clicking Help > Welcome.

2. Click Open COBOL perspective in the Welcome page.

In this perspective, Eclipse offers you the views and commands that are best suited for COBOL
development.

3. Click File > New > Remote COBOL Project.

Choose the remote connection to use and follow the instructions to create a remote native COBOL
project in a directory on the remote machine.

Import the COBOL source files
Add the source files on the remote machine to your project as follows:

1. Right-click your project in the COBOL Explorer view and click Import > Import.
2. In the Import wizard, expand General, click File System, and then click Next.

3. Click Browse, navigate to the location of your source files on the remote machine, and click OK to
confirm the path.

4. In the Import wizard, enable the check boxes for the files you want to import in your project, and click
Finish.

This adds the files to your project and, if Eclipse uses the default settings, starts a build. You might need
to set some Compiler directives to resolve any compilation issues, similarly to when you resolved any
issues when compiling from a terminal window.

Configure your project
To configure your project and specify any Compiler directives:

1. Right-click your project in COBOL Explorer, and click Micro Focus > Project Settings > COBOL.

2. In the Additional directives field, specify any directives that you had to use to resolve any issues that
occurred when you compiled without a project. These could be the Compiler directives that were used
to compile the application in Server Express prior to the upgrade or new ones.

3. Also specify the following Compiler directives:

SOURCETABSTOP"8"
COPYEXT",CBL,CPY"

If your source code contains tab stops, compilation might fail, because although a COBOL tab is eight
characters long, the IDE's tab is four characters long, and lines of code might be starting in the
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sequence number and indicator areas section (columns one to seven) of the program instead of from
column eight.

You can fix this problem using the SOURCETABSTOP( n) Compiler directive, where n is the number of
space characters by which to expand tab characters during compilation.
4. Click OK.

Build the project

By default, Eclipse builds your source files each time you make a configuration change or add or edit the
files. If you have changed this preference, to build the project click Project > Build Project.

Add copybooks

To add existing copybooks to your project, right-click the project and use the Import > Import command.

Copybooks are not compiled at build time and the files' Build Action property is automatically set to None.
(You can also set this property for COBOL source files to keep a file in the project but not include a built
version in any output.)

By default, Visual COBOL identifies files as copybooks by their . cpy extension. You can specify other file
extensions as copybooks in the IDE preferences - click Window > Preferences > Content Types, click
COBOL Copybook and add any new file associations using this dialog box.

Best Practice in Development Using Eclipse

Here is a list of recommendations about how to make the most of using Eclipse in real-life scenarios.

Break down large projects

Projects that contain a large number of source files and build artefacts can be hard to navigate and slow to
build. If you find this is the case with your application, Micro Focus recommends that you review the
contents of large projects and split them into separate projects in which you group items that are logically
related.

For example:

« If you have different versions of a product for different customers, keep common source in one project
and have a separate project for each customer.

< If you have core code that is rarely changed or recompiled, keep that in one project and have separate
projects for those areas that change regularly.

Reference common sources

Use the COBOL Copybook project type to store all your copybooks and add this project as a dependency
to the projects that contain any source programs that reference the copybooks. Use this approach in
preference to using linked resources.

Use linked folders to reference resources where it is not possible to restructure your projects (to use the
COBOL Copybook project type) or use a remote project (to access any sources on remote machines).
Use existing Compiler directives files

To avoid repetition and reduce maintenance effort, consider keeping all your Compiler directive settings in a
directives file. To reference this file in each project, specify the USE"f i | enane" Compiler directive in the
Additional directives field in each project's properties.

Use relative paths

Keep your sources relative to a base path and avoid specifying full paths in you projects. This ensures your
code is portable and easy to use with source control systems.
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Access sources on remote machines

« For optimal performance, create a remote project from the available project types to access any sources
on remote machines.

« Use RSE or SSH in preference to Samba type remote connections. Only use the Samba type
connection when it is not possible to use the other types of connections. This is because the Samba
connection has the slowest performance.

« Avoid using network shares or drives to directly access any resources on remote machines from your
local projects.

If for some reason, it is not possible to use local versions of the sources, you can use network shares as
linked folders but the connection will be very slow. In such cases, you might be able to improve the
performance by splitting the remote shared folder into smaller chunks then set the COBCPY
environment variable before you start Visual COBOL for Eclipse on your local machine.

Eclipse workspace

« To avoid performance issues, your Eclipse workspace must not be on a shared drive.

< Do not commit the Eclipse workspaces into a source control system, as they contain metadata which is
updated frequently.

Configure Visual COBOL

To boost your productivity, enable some additional views in Eclipse that are suitable for the programming
tasks you're dealing with within the current active perspective. To do this click Window > Show View and
either select a view from the ones that are displayed, or click Other to choose from all available ones.

For example, in the Debug perspective, enable the Expressions view that lists any data items you want to
monitor. Or enable the Remote Systems view to see all remote systems that have a connection defined in
Eclipse and to launch terminal sessions from within the IDE.

Modernize Your Applications and Processes

Following industry-standard development practices
Many source code control systems and Agile tools can be integrated into the Eclipse IDE.

You should also consider using continuous integration, which involves the automatic building and testing of
an application after a change occurs to the source code. This method traps errors sooner in the
development life cycle and can greatly improve efficiency and reduce costs.

Multi-user applications

Visual COBOL includes a Run Unit API to enable multiple users to simultaneously use an application
based on COBOL code that was designed originally for a single user.

Developing Web-based applications

You can use Visual COBOL to migrate existing, core applications to a service-oriented architecture as Web
services, and deploy them using Micro Focus COBOL Server and Enterprise Server, so that you can
develop COBOL-based software components to be invoked across the Web.

Developing JVM applications
You can compile both new and existing COBOL as JVM COBOL managed code. This enables you to:

« Reuse existing COBOL business logic and data access in the Java Virtual Machine
* Access Java classes and features from COBOL applications
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» Create and extend composite applications consisting of COBOL and Java code
* Reuse and extend Open ESQL applications

Both procedural and Object-Oriented (OO) COBOL are supported within the JVM. OO COBOL classes can
inherit classes written in Java and vice versa.

The managed COBOL syntax includes many extensions to the COBOL language to support Java features;
for example, the TRY ... CATCH syntax to enable exception handling in COBOL.

There are also certain directives that help integrate your managed COBOL with Java. For example, you
can now expose the Linkage Section and entry points in your COBOL to other managed languages by
compiling with the ILSMARTLINKAGE directive.

Procedural COBOL Compared with JVM COBOL

Note: Visual COBOL for Eclipse supports JVM COBOL. To develop applications for .NET COBOL,
install one of our Visual COBOL for Visual Studio products.

Procedural COBOL is regular COBOL without any of the new syntax that has been added for .NET and
JVM. Procedural COBOL is still actively supported today and is being enhanced. Since the days of Net
Express, Server Express, and Mainframe Express, it now supports inline local declarations (as in
DECLARE). It also supports new syntax such as XML PARSE, JSON GENERATE, UTF-8, and more.

You can compile to native or (in most cases) JVM COBOL. The core COBOL syntax is supported in JVM
COBOL. However, there are some features that are not supported (for example Panels V2, Dialog System
and ACUCOBOL-GT). This means that you can take most existing COBOL applications and recompile to
create JVM COBOL applications.

JVM COBOL

JVM COBOL is COBOL with extensions to support the JVM. It offers OO syntax support and syntax to
allow access to the available class libraries.

When you compile JVM COBOL, the compiler generates code: . cl ass or . j ar for JVM that runs on the
Java Virtual Machine.

JVM COBOL and Native COBOL

You can compile your COBOL program to JVM COBOL code using the jvmgen compiler directive. From
within the IDE this happens automatically if you are using a JVM COBOL project.

The compiler has now created an intermediate language (JVM byte code . cl ass/. j ar).

COBOL and all other JVM languages (for example Java, JRuby and Jyphon) compile to this format, which
makes mixed language applications easy to write.

You can also create native code applications.In Eclipse, the default COBOL project compiles to native
code.

The compiler generates . exe/. dl | s as the result of a native compilation.

The native COBOL application has to call the appropriate management services available for the operating
system, whereas a managed application can take advantage of the management services provided by the
run time such as exception handling, garbage collection, and thread management.

Run Time

The JVM byte code (. cl ass/. j ar files) can be deployed to a Java Virtual Machine for execution.

The JVM's just-in-time (JIT) compiler compiles the byte code into code native to the operating system. The
JVM provides additional services including memory management, exception handling, garbage collection
and thread management.
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Developing Native and JVM COBOL Applications

You use the IDE to develop, compile and debug both native and JVM COBOL applications. You can write
new COBOL code or you can recompile existing COBOL applications to native or JVM COBOL code,

potentially without any code changes.
You can deploy and further debug the application under the run-time system provided by COBOL Server.

JVM COBOL applications are deployed to a Java Virtual Machine for execution.
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